
Outbound Option Guide for Unified Contact Center Enterprise, Release
11.5(1)
First Published: 2016-08-10

Last Modified: 2018-11-12

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 527-0883



THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS,
INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH
THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY,
CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of
the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHERWARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH ALL FAULTS.
CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network
topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional
and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com
go trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any
other company. (1721R)

© 2003–2016 Cisco Systems, Inc. All rights reserved.

www.cisco.com/go/trademarks
www.cisco.com/go/trademarks


C O N T E N T S

Preface xiP R E F A C E

Change History xi

About This Guide xi

Audience xii

Related Documents xii

Obtaining Documentation and Submitting a Service Request xiii

Field Alerts and Field Notices xiii

Documentation Feedback xiii

Conventions xiii

Outbound Option Business Concepts 1C H A P T E R 1

Overview 1

Automatic Dialers 1

Cisco Outbound Solution 1

Overview of Cisco Outbound Option 2

Outbound Option Features 2

Unified CCE Compatible Dialer 2

Campaign Management 2

Dedicated and Blended Dialing Modes 2

Call Progress Analysis (CPA) 3

Transfer to VRU 3

Sequential Dialing 3

Cisco Unified CCE Agent Re-Skilling 3

Abandoned and Retry Call Settings 4

Campaign Prefix Digits for Dialed Numbers 4

Outbound Option ECC Variables Support for Siebel 4

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
iii



Outbound API 4

Dialing Modes 5

Predictive Dialing 5

Preview Dialing 5

Direct Preview Dialing 6

Progressive Dialing 6

Callbacks 6

About Regular Callbacks 7

About Personal Callbacks 7

Relationships Between Outbound Option Components 9

Imports 10

Do Not Call List Imports 11

Contact List Imports 11

Import Rule Reports 11

Query Rules 12

Campaigns 12

Agent Campaigns 12

CallerID Masking by Campaign 13

Transfer to VRU Campaigns 13

Dialing Order 13

Sequential Dialing 14

Contact Priority for Callbacks, Retries, and Pending Contacts 14

Campaign Reports 14

Campaign Query Rule Reports 15

Transfer to VRU Reports 15

Call Type Reports 15

Campaign Skill Groups 15

Smaller Skill Groups 15

Blended Campaigns/Skill Groups 16

Agents Skilled for Multiple Active Campaigns 16

Campaign Skill Group Reports 16

Blended Campaign Skill Group Reports 17

Customer Time Versus System Time 17

Customer Time 17

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
iv

Contents



System Time 17

Call Progress Analysis (Answering Machine Detection) 17

Architectural Overview 19C H A P T E R 2

Unified CCE Software Overview 19

Outbound Option Software Components 20

Outbound Option Component Relationships 20

Outbound Option Campaign Manager Component 21

Outbound Option Import Component 22

Outbound Option Dialer Component 22

Dialer Port Allocation 24

Port Allocations for Campaign Modes 24

Transfer to Agent Call Flow: SIP Dialer with SIP Proxy 24

Transfer to VRU Call Flow: SIP Dialer with SIP Proxy 25

Transfer to Agent - SIP Dialer with No SIP Proxy 26

Peripheral Gateway (PG) 27

Agent PG 28

Media Routing PG 28

VRU 28

Administration and Data Server: Configuration 29

Cisco Unified Intelligence Center 29

Dialer Reports 29

Outbound Option Agent Desktops 29

Cisco Finesse 29

Outbound Option Extended Call Context Variables 30

Desktop Button Behavior 33

Scripts for Outbound Option 34

Fault Recovery 34

Campaign Manager Fault Recovery 34

Dialer Fault Recovery 35

Campaign Manager Congestion Control 35

Outbound Option Installation Preliminary Steps 37C H A P T E R 3

Before You Begin 37

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
v

Contents



System Requirements 37

Outbound Option Database 38

VRU Integration 38

Auto Answer Settings 38

Outbound Option Installation 39C H A P T E R 4

Unified CCE Configuration for Outbound Option 39

Unified CCE System Configuration for Outbound Option 39

Configure the PG 40

Configure Dialer Component 40

Configure Port Map 42

Create a Network VRU 42

Configure Media Routing PG (MR PG) 43

Configuration for Send to VRU Campaign 43

Configure Network VRU Type 2 43

Assign Type 2 Network VRU to MR-PG 44

Configure Network VRU Type 10 44

Assign Type 10 Network VRU to VRU-PG 45

Configure System Options 45

Enable Expanded Call Context Variables 46

Packet Capture for Troubleshooting 46

Unified Communications Manager and Gateway Configuration 47

Disable Ringback During Transfer to Agent for SIP 47

Configuration of Voice Gateways 50

Configure Cisco Unified Border Element 51

Configure Cisco UBE for G.711 A-Law 52

Configure SIP Trunks 53

Configure E1 R2 Signaling 54

Outbound Option Software Installation Steps 55

Software Installation and Database Creation 55

Create Outbound Option Private Database 55

Configure the Logger for Outbound Option 56

Upgrade Outbound Option from a Previous Release 57

Install Dialer Component on the PG Virtual Machine 57

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
vi

Contents



Modification of Local Static Route File 59

Auto Answer Configuration on Agent Phones 59

Install MR PG 59

Verification 60

Dialer Component Status 61

Verify Critical Configuration Steps 62

Verify Database Configuration 62

Verify Router Registry Key 63

Configuration of Campaigns and Imports 65C H A P T E R 5

Outbound Option Configuration Process Overview 65

Configuration Process Task Maps 66

Campaign Task List 66

Transfer to VRU Campaign Tasks 67

Configure Skill Group 68

Create a Call Type 68

Create Dialed Numbers 69

Create Dialed Number 70

Configure Dialed Numbers 70

Imports 70

Import Procedure 70

Create Do Not Call List 71

Create Contact Import File 72

Add Attributes to a Contact List 73

Create Import Rule 73

Create a Query Rule 74

Create a Campaign 75

Modification of Maximum Number of Attempts in a Campaign 76

Notes on Editing a Campaign in Progress 76

(Optional) Configure Personal Callbacks 76

Create an Enterprise Skill Group 79

Create an Enterprise Route 80

Configure Queue to Agent Node 80

Outbound Option Scripting 81

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
vii

Contents



Administrative Scripts for Outbound Option 81

Routing Scripts for Outbound Option 82

Set Up Reservation Script 82

Script for Agent Campaign 82

Send to VRU 84

Configure a Transfer to VRU Script 85

Set Up an Administrative Script 87

Sample Administrative Scripts 89

Administrative Script: TimeBasedControl 90

Map Scripts, Call Types, and Dialed Numbers 90

Configure Translation Route for Use with SIP Dialer 91

Multi-Tenant Customer Instances Configuration 91

SIP Dialer Recording Parameters Configuration 91

Verification of Dialed Number DN/Script Selector Configuration 92

Verify DN/Script Selector Configuration 92

Verify Campaign Configuration 92

Administrative and Supervisory Tasks 93C H A P T E R 6

Agent Management 93

Agent Addition 93

Agents Dedicated to Only Outbound Option Campaigns 94

Agent Re-skilling 94

Campaign Management 94

Single Campaign Versus Multiple Campaigns 94

Results from Individual Customers 94

Interpret Information from Dialer_Detail Table 95

Dialing List 95

Management of Campaign Manager Database Tables 95

Management of Predictive Campaigns 96

Initial Values for Lines per Agent 96

End-of-Day Calculation for Abandon Rate 96

Transfer of Answering Machine Detection Calls to Agents 97

Parameter Tuning 97

Management of Agent Idle Time 97

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
viii

Contents



Sources of Higher Idle Times in Reports 98

Dialer Saturation 98

Few Available Records 98

Retry Records in Append Campaigns 98

SIP Dialer Voice Gateway Over-capacity Errors 99

Update the North American Numbering Plan Data 100

Reports 101

Outbound Option Reports 101

Outbound Historical Reports Bundle 101

Outbound Realtime Reports Bundle 102

Agent Reports 103

Campaign and Dialer Reports 104

Skill Group Reports 106

Import Rule Reports 106

Registry Settings 107A P P E N D I X A

Campaign Manager Registry Settings 107

Dialer Registry Settings 111

Long Distance Digit Prefix Logic 119A P P E N D I X B

Transformation of Imported Numbers 119

Dialer Configuration Fields and Registry Settings 120

Dialer Detail Table 123A P P E N D I X C

About the Dialer_Detail Table 123

Advantages 123

Data Flow 123

Fault Tolerance 124

Dialer_Detail Table Database Fields and Descriptions 124

CallResult Codes and Values 124

CallStatusZone Values 125

DialingMode Values 126

CallResults Table 127

Outbound dialer call result for combinations of PSTN and status code 130

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
ix

Contents



Termination Call Detail Table 135A P P E N D I X D

Peripheral call types 135

Map Release 8.x to Release 6.0(0) and Earlier Peripheral Call Types 135

Call Disposition Values Used in Termination_Call_Detail Table 136

CED (Caller-Entered Digits) Column Values 136

TCD Column Descriptions 136

Reservation Calls 136

IPCC Reservation Call 137

MR PIM Reservation Entry Not a Real Call (TCD) 137

MR PIM Route Request (RCD - route_call_detail) 137

Customer Calls 138

Transfer to VRU TCD Records 139

Initial Customer Call on PIM Transferred to Route Point 139

Transferred Customer Call on Unified CM PIM Redirected to IVR 140

IVR Plays a Message on VRU PIM to a Customer 140

Dialing List Table 143A P P E N D I X E

Dialing_List Table Columns 143

Personal Callback List Table 145A P P E N D I X F

Personal_Callback_List Table 145

CTIOS OO ECC Variable Settings 147A P P E N D I X G

ECC Variables for Outbound Call Centers Example 147

ECC Variables in Mixed Inbound and Outbound Call Centers Example 148

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
x

Contents



Preface

• Change History, on page xi
• About This Guide, on page xi
• Audience, on page xii
• Related Documents, on page xii
• Obtaining Documentation and Submitting a Service Request, on page xiii
• Field Alerts and Field Notices, on page xiii
• Documentation Feedback, on page xiii
• Conventions, on page xiii

Change History
This table lists changes made to this guide. Most recent changes appear at the top.

DateSeeChange

November 30, 2016Call Progress Analysis (AnsweringMachine
Detection), on page 17

Added notes about virtual CUBE support
for CPA

August, 2016Initial Release of Document for Release 11.5(1)

Outbound API, on page 4Added information about the Outbound
API

About This Guide
This manual provides conceptual, installation, and configuration information about the Cisco Unified Contact
Center Enterprise (Unified CCE) Outbound Option application (formerly called “Blended Agent”). It also
provides verification checklists and troubleshooting information to ensure that the Outbound Option installation
and configuration setup is successful.

For detailed Outbound Option Components field descriptions, see the online help.
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Successfully completing the Outbound Option installation also requires use of the Staging Guide for Cisco
Unified ICM/Contact Center Enterprise. See https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/tsd-products-support-series-home.html for the complete set of Cisco Unified
ICM/Contact Center Enterprise and Hosted software manuals.

Note

Audience
This document is intended for contact center supervisors and contact center technology experts who perform
the following functions using Outbound Option:

• SystemAdministrators – The installer/partner who sets up the Unified CCE system to support Outbound
Option and installs and integrates the Outbound Option components.

• Administrator – The administrator responsible for configuration tasks, such as adding agents, skill
groups, campaigns, and scripts necessary for ongoing activity.

• Supervisors/Business users – These users might perform such tasks as modifying a query rule, adjusting
the lines per agent, or enabling or disabling a campaign. This group of users also read and interpret reports
to help them run their business.

• Sales – A secondary audience, interested primarily in conceptual information.

Related Documents
For documentation for these Cisco Unified Contact Center Products, go to
https://www.cisco.com/cisco/web/psa/default.html, selectVoice andUnifiedCommunications>CustomCisco
Unified Contact Center Productser Collaboration > Cisco Unified Contact Center Products or Cisco
Unified Voice Self-Service Products, and select the product/option in which you are interested.

Related documentation includes the documentation sets for:

• Cisco CTI Object Server (CTI OS)

• Cisco Unified Contact Center Management Portal

• Cisco Unified Customer Voice Portal (CVP)

• Cisco Unified IP IVR

• Cisco Unified Intelligence Center

• Cisco Finesse

• Documentation for Unified CM is also accessible through
https://www.cisco.com/cisco/web/psa/default.html.

• Technical Support documentation and tools are accessible from:
https://www.cisco.com/en/US/support/index.html.
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• The Product Alert tool is accessible from (sign in required):
https://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service
request, and gathering additional information, seeWhat's New in Cisco Product Documentation at
https://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html.

Subscribe toWhat's New in Cisco Product Documentation, which lists all new and revised Cisco technical
documentation as an RSS feed and delivers content directly to your desktop using a reader application. The
RSS feeds are a free service.

Field Alerts and Field Notices
Cisco can modify its products or determine key processes to be important. These changes are announced
through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and
Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive
announcements by selecting all products of interest.

Sign in www.cisco.com and then access the tool at https://www.cisco.com/cisco/support/notifications.html.

Documentation Feedback
To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com.

We appreciate your comments.

Conventions
This document uses the following conventions:

DescriptionConvention

Boldface font is used to indicate commands, such as user entries, keys, buttons,
and folder and submenu names. For example:

• Choose Edit > Find.

• Click Finish.

boldface font
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DescriptionConvention

Italic font is used to indicate the following:

• To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.

• A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)

• A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

italic font

Window font, such as Courier, is used for the following:

• Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>

window font

Angle brackets are used to indicate the following:

• For arguments where the context does not allow italic, such as ASCII output.

• A character string that the user enters but that does not appear on the window
such as a password.

< >
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C H A P T E R 1
Outbound Option Business Concepts

• Overview, on page 1
• Outbound API, on page 4
• Dialing Modes, on page 5
• Callbacks, on page 6
• Relationships Between Outbound Option Components, on page 9
• Imports, on page 10
• Query Rules, on page 12
• Campaigns, on page 12
• Campaign Skill Groups, on page 15
• Customer Time Versus System Time, on page 17
• Call Progress Analysis (Answering Machine Detection), on page 17

Overview
This section provides a high-level overview of automatic dialers and the Cisco Outbound Option solution.

Automatic Dialers
Automatic dialers increase contact center efficiency because they save time, eliminate misdialing numbers,
and make contact center agents more productive. By automatically dialing and screening for busy signals, no
answer, and answering machines, dialers ensure that agents do not waste time on the mechanical tasks of
placing a call. Only when the dialer reaches a live contact does the solution transfer the call to the next available
agent.

Cisco Outbound Solution
Cisco Unified Intelligent Contact Management Enterprise and Cisco Unified Contact Center Enterprise help
companies distribute inbound calls to various termination points:

• Automatic call distributors (ACDs)

• Voice response unit (VRU) systems

• Home agents

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
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TheCisco Outbound Option application, with its combination of outbound dialing modes, enables call centers
to manage outbound calls. The ability for agents to handle both inbound and outbound contacts enables contact
center resource optimization.

Overview of Cisco Outbound Option
The Cisco Outbound Option application provides outbound dialing functionality along with the existing
inbound capabilities of Cisco Unified Contact Center Enterprise (Unified CCE). This application enables the
contact center to dial customer contacts and directly contacted customers to agents or VRUs.

With the Cisco Outbound Option, configure a contact center for automated outbound activities.

Enable Outbound Option High Availability to deploy a redundant pair of routers, loggers, and Campaign
Managers. Combined with redundant SIP Dialers and bidirectional database replication, Outbound Option
High Availability provides uninterrupted services.

Outbound Option Features

Unified CCE Compatible Dialer
You can implement Unified CCE in a single-site environment or integrated into a multisite contact center
enterprise. Unified CCE includes intelligent call routing, ACD functionality, network-to-desktop computer
telephony integration (CTI), VRU integration, call queuing, and consolidated reporting.

With Unified CCE integration, you place customer calls through the Cisco Voice Gateway using Unified CM
for call control.

Outbound Option on Unified CCE provides a native multisite outbound dialing solution.

Campaign Management
Outbound Option supports advanced list management, which provides you with the following capabilities:

• You can assign customer records to multiple lists, which you can merge into a single campaign.

• You set up rules that decide when to call the various lists.

• You assign agents to campaigns using skill groups.

Dedicated and Blended Dialing Modes
You assign agents to one of the following types:

Dedicated mode

Used for agents who only make calls for Outbound Option campaigns.

Blended mode

Enables agents to receive inbound calls and Outbound Option calls without switching between Inbound
and Outbound skill groups. (In Blended mode, inbound calls receive precedence over Outbound Option
calls.)

Outbound Option maximizes performance in both pure outbound and blended modes.

The outbound mode is a skill group attribute. You can control the outbound mode using administrative scripts.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
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The skill group mode variable is only a setting and has no impact on how the Router routes calls. For skill
groups in Dedicated mode, create a corresponding routing script with an IF node to enforce the Dedicated
mode. The IF node must state that, if the Outbound Control skill group setting is set to Dedicated, do not route
inbound calls to that skill group.

Note

Call Progress Analysis (CPA)
Call Progress Analysis (CPA) uses a combination of call signaling and media stream analysis to differentiate
various types of calls.

You can enable CPA in theOutbound Option Campaign dialog box. On theCampaign Purpose tab, check
the Call Progress Analysis checkbox.

You can enable CPA for each campaign individually on the Dialer. To enable record CPA, check the Record
CPA checkbox.

You must enable the Record CPA option for debugging purposes only.Note

The Dialer can record a maximum of 100 simultaneous CPA streams. The streams are stored in .wav format.
By default, the system automatically purges old recording files when the total size of CPA files stored reaches
500 MB.

Related Topics
Call Progress Analysis (CPA), on page 3
Create a Campaign, on page 75

Transfer to VRU
The transfer to VRU feature provides Outbound Option with another outbound mode. In this mode, the Dialer
transfers every customer call for a specific skill group to a service control-based VRU, instead of an agent.
This feature enables a contact center to run unassisted outbound campaigns using prerecorded messages in
the Unified IP-IVR and Unified CVP products.

Related Topics
Transfer to VRU Campaigns, on page 13

Sequential Dialing
The sequential dialing feature enables you to associate up to ten phone numbers with a customer record.

Related Topics
Sequential Dialing, on page 14

Cisco Unified CCE Agent Re-Skilling
Cisco Unified CCE agent re-skilling is an optional feature that enables supervisors to change the skill groups
for their agents. Use the Unified CCEWeb Administration application to change the skill group designations
of agents on your team. You can also quickly view skill group members and details about individual agents

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
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in this tool. Changes that you make to an agent’s skill group membership take place immediately without
requiring the agent to re-logon to the system.

Related Topics
Agent Re-skilling, on page 94

Abandoned and Retry Call Settings
The Campaign component contains fields to support abandoned and retry calls.

For more information on the abandoned and retry call settings, see the Outbound Option online help.

Campaign Prefix Digits for Dialed Numbers
The Campaign prefix digits field on the Campaign General tab enables you to configure prefix digits for
dialed numbers by campaign. If you configure a prefix, the dialer inserts those digits before the Dial prefix
for all numbers dialed in a campaign. This prefix enables an administrator to create campaign-specific Unified
CM translation patterns. You can use the translation patterns to tailor the Automatic Number Identification
(ANI) seen by a customer. For example, customers for Campaign A see a caller ID of “1-800-333-4444,” and
customers for Campaign B see a caller ID of “1-800-555-1212.”

Related Topics
Create a Campaign, on page 75

Outbound Option ECC Variables Support for Siebel
The Cisco Unified CRM Connector for Siebel provides support for Outbound Option.

See Cisco Unified CRM Connector for Siebel for detailed information about the ECC variables support for
Outbound Option.

Outbound API
Outbound API allows you to use REST APIs to create, modify, and delete Outbound Option campaigns.

Outbound API provides a streamlined mechanism for creating campaigns with a single preconfigured query
rule and import rule. As such, if you use the API to create a campaign, that campaign is not available in the
Outbound Option Campaign Configuration tool. If a campaign was created with the API, you must use the
API to view, edit, or delete it. If a campaign was created with the Outbound Option Campaign Configuration
tool, you must use that tool to view, edit, or delete it.

Administrative scripts are not required for Outbound Option campaigns created with the Outbound API. If
an administrative script is provided, the information in the script overrides the information defined in the API.

Outbound API consists of the following APIs:

• Outbound Campaign API: Use this API to define new Outbound Option campaigns, and to view, edit,
or delete existing campaigns. You can also use this API to disable all campaigns at once (emergency
stop).

• Do Not Call API: Use this API to set the Do Not Call (DNC) import rule configuration for Outbound
Option. This prevents the Dialer from dialing the numbers on the DNC list.

• Import API: Use this API to import customer contact information for an Outbound Option campaign.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
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• Time Zone API: Use this API to list all available time zones and to get information for a specified time
zone. You also use this API with the Outbound Campaign API to set the default time zone for an Outbound
Option campaign.

• Campaign Status API: Use this API to get the real-time status of running Outbound Option campaigns.

• Personal Callback API: Use this API to configure your Outbound Option campaign to handle personal
callbacks. You can create personal callback records individually or in bulk. You can also use this API
to update or delete personal callback records.

For more information about Outbound API, see the Cisco Unified Contact Center Enterprise Developer
Reference Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-programming-reference-guides-list.html.

Dialing Modes
Outbound Option supports various dialing modes, described in the following sections.

All dialing modes reserve an agent at the beginning of every Outbound Option call cycle by sending a
reservation call to the agent.

Note

Predictive Dialing
In predictive dialing, the dialer determines the number of customers to dial per agent based on the number of
lines available per agent and the configured maximum abandon rate. The agent must take the call if that agent
is logged in to a campaign skill group.

A Predictive Dialer is designed to increase the resource utilization in a call center. It is designed to dial several
customers per agent. After reaching a live contact, the Predictive Dialer transfers the customer to a live agent
along with a screen pop to the agent’s desktop. The Predictive Dialer determines the number of lines to dial
per available agent based on the target abandoned percentage.

Outbound Option predictive dialing works by keeping outbound dialing at a level where the abandon rate is
below the maximum allowed abandon rate. Each campaign is configured with a maximum allowed abandon
rate. In Predictive mode, the dialer continuously increments the number of lines it dials per agent until the
abandon rate approaches the configured maximum abandon rate. The dialer lowers the lines per agent until
the abandon rate goes below the configured maximum. In this way, the dialer stays just below the configured
maximum abandon rate. Under ideal circumstances, the dialer internally targets an abandon rate of 85% of
the configured maximum abandon rate. Due to the random nature of outbound dialing, the actual attainable
abandon rate at any point in time may vary for your dialer.

Preview Dialing
Preview dialing reserves an agent before initiating an outbound call and presents the agent with a popup
window. The agent can then Accept, Skip, or Reject the call with the following results:

• Accept: The customer is dialed and transferred to the agent.

• Skip: The agent is presented with another customer call.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
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• Skips-Close: The customer will not be called again, and the agent is presented with another customer
call.

• Reject: The agent is released. The system then delivers another call to the agent, either another Preview
outbound call, or a new inbound call.

• Rejects-Close: The agent is released and the record is closed so it is not called again. The system then
delivers another call to the agent, either another Preview outbound call or a new inbound call.

Direct Preview Dialing
The Direct Preview mode is similar to the Preview mode, except that the dialer automatically places the call
from the agent's phone after the agent accepts. Because the call is initiated from the agent's phone, the agent
hears the ringing, and there is no delay when the customer answers. However, in this mode, the agent must
deal with answering machines and other results that the Dialer Call Progress Analysis (CPA) handles for other
campaign dialing modes.

• The CPA and the transfer to VRU features are not available while using Direct Preview Dialing mode.

• A zip tone is a tone that announces incoming calls. There is no zip tone in Direct Preview mode.

Note

Progressive Dialing
Progressive Dialing is similar to predictive dialing (see Predictive Dialing, on page 5). The only difference
is that in Progressive Dialing mode, Outbound Option does not calculate the number of lines to dial per agent,
but allows users to configure a fixed number of lines that will always be dialed per available agent.

In the Outbound dialer log, the Progressive dialing mode is also logged as Predictive.Note

Callbacks
When the system contacts a customer and transfers the call to an agent, the customer can request to be called
back later. The agent enters the date and time that the customer wants a callback in the agent application to
schedule the callback. There are two types of callbacks: regular callbacks and personal callbacks.

The callback number can be different from the number originally dialed.Note

Depending on the Outbound Option campaign settings, you can schedule a regular callback or a personal
callback.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
6

Outbound Option Business Concepts
Direct Preview Dialing



About Regular Callbacks
Any agent who is assigned to the campaign can handle regular callbacks.

Callbacks are handled in the samemode as the campaign type. If an agent schedules a callback for a predictive
campaign, the callback for that campaign is handled in Predictive mode.

The campaign dialing times do not constrain the callback time. CallbackTimeLimit determines the time range
when the callback can occur.

If the dialer cannot reach the customer, the callback time is rescheduled.

The CallbackTime limit might be exceeded if no agents are available. If the elapsed time exceeds the
CallbackTimeLimit and RescheduleCallback is enabled, the record returns to the Pending state at
TimeToResetDailyStats.

About Personal Callbacks
The Outbound Option personal callback feature schedules a specific agent to handle a customer callback.
The feature enables the customer to continue working with the same agent who spoke with them initially.

Callbacks on personal callbacks are handled in the associated campaign mode.

Only an agent who dealt with the original call can set a personal callback. The dialer offers the agent the
personal callback using a mode similar to the Preview dialing mode.

This feature is similar to Preview mode in that an agent reservation occurs first. When the agent is reserved,
they can either accept the customer call or reject it. (The Skip option is not available.) Clicking Close sets
the BAResponse variable to indicate a close operation. The record is not dialed again.

Personal callbacks are not dependent on a particular campaign, and do not require a running campaign when
the call is placed. This feature enables personal callbacks to occur with active campaigns containing either
predictive or preview skill groups. Agents can receive a personal callback request while logged in to any
inbound, outbound, or blended skill group. The callback is linked to the agent ID. If the agent logs in with a
different agent ID, they cannot receive the callback request. Only one dialer on a particular peripheral is
assigned personal callback records.

Note

The Personal_Callback_List table maintains a list of the customer records scheduled to be called back by a
specific agent. The Campaign Manager creates records in the Personal_Callback_List table when an agent
schedules a personal callback.

You can also use an external program or third-party application to insert customer records directly into the
Personal_Callback_List table to support scheduling customer calls for a specific time. For details on the table
columns, see Outbound Option Guide for Unified Contact Center Enterprise, Appendix F,
Personal_Callback_ListTable.
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When modifying the Personal_Callback_List table, be aware of the following restrictions:

• Applications that insert new records into this table must populate the InsertedIntoDBDateTime column
with the current date and time. However, do not modify SentToDialerDateTime. This date and time is
set by the Campaign Manager.

• Do not close or delete Records when the Status is 'A'. Records that are pending can be marked as closed
or deleted in a Campaign Dialing List if they are not in the Active state.

Note

Personal callback supports three callback modes:

• Use Campaign DN

• Reschedule the personal callback to the same time the next business day.

• Abandon the personal callback.

The following actions can take place during a personal callback:

• If the customer is unreachable during the callback time, the call is rescheduled up to the maximum
attempts or abandoned based on the configuration setup.

• If the dialer detects an answering machine response, the call is still transferred to the scheduled agent.
The agent can leave a message or reschedule the callback for another convenient time.

• When the callback mode is set to Reschedule or Abandon:

• If the agent is logged in at any point during the callback period, Outbound Option reserves the agent
and places the callback.

• If the agent is unavailable during the entire callback period, the personal callback fails. The call is
rescheduled or abandoned based on the configuration setup.

• When the callback mode is set to Campaign DN:

• If the agent is unavailable at the callback time, Outbound Option reserves another agent for the
callback using the dialed number of the associated campaign skill group.

• If an alternate agent is also unavailable from Campaign DN script, retry action is No Answer.

For more information, see Appendix F, "Personal_Callback_List Table".

The valid range for Callbacktime is from midnight, January 1, 1970 through December 31, 3000 Universal
Coordinated Time (UTC). If Callbacktime is specified out of range then it is defaulted to NULL.

Note

Related Topics
Personal Callback List Table, on page 145
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Relationships Between Outbound Option Components
The following figure shows the component relationships within Outbound Option.

The following figure and table only describe OutboundOption components and concepts; they do not describe
the Outbound Option process.

Note

Figure 1: Outbound Option Component Relationships

You configure the blue-outlined items in this figure.Note

Table 1: Outbound Option Component Concepts

DescriptionConcept

Defines when and how Outbound Option reads in user-generated lists of
customers to call and not to call.

Import

A set of criteria for selecting customer contacts from a customer list.Query Rule

Create the agent skill groups and associate them with one or more dialing lists
by assigning them to a campaign.

With Outbound Option, you can configure these types of campaigns:

• Agent-based campaign—In this campaign type, the Dialer transfers
customer calls to an agent.

• Transfer to VRU campaign—In this campaign type, the Dialer transfers
customer calls to a service control-based VRU, instead of an agent. This
feature enables a contact center to run unassisted outbound campaigns using
pre-recorded messages in the VRU.

Campaign
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DescriptionConcept

Defines a selection of agents for a campaign. Each skill group can only have one
campaign assignment, but a campaign can service multiple skill groups.

Their skill group associations tie the agents to the campaign. Agents might belong
to multiple skill groups and be part of multiple campaigns.

You cannot associate a specific dialing list to a specific skill group unless there
is only one dialing list and one skill group in the campaign.

Skill Group

A collection of agents and skill groups that are bound to a specific Unified CM.
The dialer is bound to serve the group of agents in a specific call center site.

Agent Peripheral Gateway
(PG)

The component that places Outbound Option calls. The dialer is associated with
the agent peripheral at a call center site. Outbound Option sends calls to a dialer
based on the campaign skill group relationship for the agent controller at that
site. The dialer monitors campaign skill groups and is mapped to an agent
peripheral.

Dialer

List of contact information that you provide during import. This is a
user-configured item.

Customer List

List of contact information that must not be included in the Dialing List. This is
a user-configured item.

Do Not Call List

An internal table, to which an import applies a query rule to determine which
records to insert in the dialing list. There is one Contact List for each import.

Contact List

The list of customer contacts to which Outbound Option makes calls. There is
one dialing list for each campaign query rule.

Each campaign query rule combination results in a unique dialing list.

Only one dialing list is active at a time for a particular campaign. Whenever a
dialing list is active, the list is distributed to all skill groups in the campaign.
You cannot map a specific dialing list to a specific skill group in a campaign.

Dialing List

Using some of the preceding terms, the following example demonstrates what happens during an Outbound
Option import:

1. Outbound Option imports your customer list into an internal table of customer contacts.

2. During the import process, a query rule filter selects and inserts data from the customer contacts into a
dialing list.

3. Outbound Option reads in records from the dialing list for the campaign. Outbound Option sends the
records to contact to dialers that are colocated on the peripherals for the associated skill groups.

Imports
You can import a list of customer contact information and a list of customers to not call. You can configure
Outbound Option to import both types of lists either by continuously polling or at scheduled intervals. Imported
lists can replace existing lists or be appended to them.
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Do Not Call List Imports
Many countries require phone solicitors to maintain do not call lists. A Do Not Call (DNC) list ensures that
your contact center does not call those customers who request that you do not contact them.

The Do Not Call list is a list of numbers that are identified as off-limits for outbound calling. This list can
include numbers from a national DNC list and numbers from customers who have directly requested that you
not contact them. Outbound Option does not dial entries in the Do Not Call list even if they are included in a
contact list. The DNC list is shared across all campaigns and contains only phone numbers.

The campaign validates that a number in the dialing list is not in the Do Not Call list before sending it to a
dialer. The solution checks the list at the last minute before placing the call. You can update a Do Not Call
list while a campaign is running. Your update immediately affects any records that have not been sent to a
dialer. If the Campaign Manager has already sent a record to the dialer, an update to the list does not stop
dialer from placing the call.

The import process validates Do Not Call imports for improper formatting and field lengths. The import
process flags invalid records and writes them to an error file.

Related Topics
Create Do Not Call List, on page 71

Contact List Imports
The contact list import reads in a user-generated text file of customer contacts and associated phone numbers
to an internal contact table. The import includes validation that flags improperly formatted records and writes
them to an error file. The error files are in the \la\logfiles directory directory on the Side A Logger
and lb\logfiles directory on the Side B Logger. The filenames are based on the Target Table Name,
the date, and time of the import. Phone numbers without prefix matches are not placed in a file.

You can add business-specific attributes to the contact list import file before the import occurs. You can use
these attributes to segment a campaign with a query rule. In this way, a single import can contain records for
multiple dialing lists for the same campaign. However, do not include the campaign customer contacts in
multiple dialing lists because you might dial the same customer twice.

The U.S. area code mappings are provided along with the product. International customers must add their
own data to the database.

The contact list import process assigns time zone and daylight saving time information to each contact by
matching phone numbers to region prefix strings. If a phone number for a contact does not match a configured
region prefix, the import uses the default time zone data for the campaign.

Import Rule Reports
The Do Not Call and Contact List imports use the same import rule reports. The reports display the following
historical data:

• When an import occurred

• The number of imported records

• The number of invalid records due to length constraints or improper formatting

For contact list imports, the reports also list:
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• The number of contacts that the import assigned to the default time zone

• The number of contacts that the import included in the dialing list after performing the query rule and
format validation

Related Topics
Administrative and Supervisory Tasks, on page 93

Query Rules
The query rule determines which customer contacts from the import to use for a campaign. You can associate
multiple query rules with a campaign. You can use the query rules to segment a campaign for prioritization
or other logical groupings. For example, if you want to dial certain customers between 9 AM and 11 AM, set
up a query rule to only dial during those times. You then configure the campaign to switch to another query
rule outside those times.

When dialing, only one query rule is active at any time for each campaign.

You can change query rules based on conditions such as configured time limit, several records attempted
(referred to as penetration), current time, or current hit rate. The query rule automatically switches to another
available query rule if the query rule runs out of numbers that can be dialed now.

Campaigns
A campaign is made up of one or more dialing lists and one or more campaign skill groups. Outbound Option
reads in contacts from the dialing list for the currently active query rule in the campaign. The Campaign
Manager then directs dialers to place customer calls. The dialer then directs contacted customers to agents or
a VRU in the campaign skill group.

In the Outbound Option Campaign component, you can:

• Create a campaign.

• Modify a campaign.

• Delete a campaign.

A campaign is either an agent-based campaign or a transfer to VRU campaign. A campaign cannot combine
both types of calls.

Related Topics
Agent Campaigns, on page 12
Create a Campaign, on page 75
Transfer to VRU Campaigns, on page 13

Agent Campaigns
In an agent campaign, Outbound Option dials customers and transfers them to agents in targeted skill groups.
The dialer monitors for available agents. When the dialer finds an available agent, the peripheral gateway
(PG) places a virtual reservation call to prevent the router from using that agent for other calls. The agent
phone does not actually ring, but the agent desktop updates to show a call in progress. After the agent is
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reserved, the dialer places a call using the dialing mode for the campaign skill group. After the dialer identifies
a customer, the call transfers to the agent. The agent should stay on the reservation call until a customer call
is reached to avoid abandoned calls. Once a customer call is reached, the dialer disconnects the reservation
call from the agent desktop.

An internal call can interrupt an agent on a reservation call. The dialer still sends the call to the agent. The
call is dropped unless call waiting is enabled on the agent extension. You can avoid this scenario by giving
the agent a second line for internal call use, and make sure the line is interruptible with call waiting enabled.

Note

The agent can still mark the call as a wrong number, wrong party, or schedule a callback for later which does
not close out the record. If more than one line is dialed for the agent, several customers might answer their
calls. The first call is assigned to the agent. The dialer then determines what to do with the extra answered
calls. If another agent is reserved in the campaign, the call transfers to that agent. Otherwise, the call may be
transferred to a VRU to handle the abandoned call. If no VRU is configured, then the call drops with no
treatment. Specify a VRU in the campaign's Abandon to IVR setting to avoid dialer abandons. The VRU can
play prompts, collect data, and redirect the customer to a properly skilled agent in the contact center.

CallerID Masking by Campaign
Outbound Option allows you to configure up to 15 prefix digits for dialed numbers in a campaign. If you
configure a prefix, the dialer inserts the prefix before the Dial prefix for all numbers dialed in a campaign.

In a SIP Dialer deployment, the SIP Dialer uses the SIP message to make outbound calls directly to the
gateway. The SIP interface allows the SIP Dialer to set the Automatic Number Identification (ANI) directly.

Transfer to VRU Campaigns
A transfer to VRU campaign, also known as an unattended or unassisted campaign, can send both live customer
and answering machine calls to VRUs for customer treatment. This customer treatment includes playing
prompts, collecting data from the customer, and redirecting the call to appropriate agents in the contact center.

The configuration allocates the maximum VRU ports to use for transfer to VRU campaigns. The campaign
attempts to keep them busy within the dialing constraints.

An unattended campaign can use either Progressive or Predictive modes. You can play a different prompt for
a live customer or for an answering machine.

You cannot use the transfer to VRU feature in the Direct Preview mode or the regular Preview modes.Note

Dialing Order
Outbound Option dials contacts for a campaign in the order on the imported contact list. This order is not
changed during the import.

A contact can have several numbers configured (on the Call Target tab in the Campaign configuration). The
campaign dials each number for the contact once, in the configured order. The campaign can then retry the
numbers.
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For more information, see Configuration of Campaigns and Imports chapter.

Sequential Dialing
The sequential dialing feature enables you to associate up to ten phone numbers with each customer record.
You can configure two time periods, called “zones,” to call the customers for each campaign. Each time period
(zone) lists which of the ten phone numbers to call during that time. You can call a phone number during
either zone or both zones.

Customers are dialed based on the time zone of the first phone that is configured on this tab. The time zone
is based on the prefix of the phone number and the region prefix configuration. If two phone numbers for the
same customer have different time zones, the time zone for the first phone number in the list sets the times
for calling both numbers.

Note

Contact Priority for Callbacks, Retries, and Pending Contacts
The contact priority order is as follows:

• Top priority is given to customers who requested callbacks. This priority ensures that the customers are
called at the requested time.

• Retries get second priority. After all the numbers for the contact are tried once, the system can retry a
contact if some of their numbers had an appropriate call result.

• Pending contacts get third priority. A customer record is pending until all of its eligible phone numbers
are tried once.

You can change the default priority order by changing the PendingOverRetryEnabled registry setting to 1 in
the Campaign Manager. This setting ensures that all numbers and records are tried once before retries are
attempted.

Note

Related Topics
Registry Settings, on page 107

Campaign Reports
The query rule call activity and pending record reports are available as campaign roll-ups for multiple query
rules in a campaign.

There are also consolidated reports, that blend campaign call activity reporting information with skill group
performance reports for a clear overview of the business activity. Because the consolidated reports mix data
from different reporting engines, the reports have a few caveats. The reports include descriptions of these
caveats. These reports provide a rough overview of agent activity, average time between calls, abandon rate,
and so on.

Related Topics
Administrative and Supervisory Tasks, on page 93
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Campaign Query Rule Reports
There are two general categories of campaign query rule reports:

• Reports that show the number of records closed, in Pending state, and the total records in the query rule’s
dialing list.

• Reports that provide different views into the call result activity.

Transfer to VRU Reports
The campaign and query rule call activity reports display call activity for calls that are not transferred to a
VRU. The campaign and query rule activity reports also count calls that are transferred to a VRU, but those
reports do not show what happens after the call is sent to the VRU. If calls are queued and transferred back
to an agent, the calls are treated as new inbound calls in the reports.

Call Type Reports
The call type is a Unified CCE concept that maps a route point dialed number to a routing script. The call
type is also a useful reporting object to describe all calls that traversed a specific routing script. The call type
applies primarily to inbound traffic in the call center. The dialer does not use the routing script when placing
outbound calls. However, the Outbound Option does use routing scripts to reserve agents and to transfer calls
to the VRU. So, the call type can provide some insight into how calls are routed.

Campaign Skill Groups
A campaign skill group describes the campaign resource pool and the information for managing the campaign.
In deployments with multiple sites that have different hours and different equipment, you have different skill
groups for each site. Dialing Mode is a skill group attribute that enables you to open and close skill groups at
different times for shared campaigns.

The dialer uses campaign skill groups to monitor resource availability. In agent campaigns, the dialer looks
at the number of available agents. In Transfer to VRU campaigns, the dialer monitors the number of calls in
queue for each campaign skill group. The dialer ensures that no skill group exceeds its quota of configured
VRU ports.

You associate each dialer with a peripheral (PG). The dialer monitors the skill groups on its own peripheral
for resource availability and requests records for the appropriate campaigns.

The dialer only places calls for agents or VRUs that are located on its PG.

Multiple dialers can serve one campaign if skill groups from each dialer's PG are assigned to the campaign.
This assignment enables campaigns to be site-specific or shared across the enterprise, depending on the
configuration.

Note

Smaller Skill Groups
Predictive mode campaigns are more efficient when there are more agents or VRU ports in a campaign skill
group. The dialer adjusts its dialing rate based on the abandon rate. The more frequently calls are placed, the
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more often the dialer can adjust the dialing rate. The dialer cannot make accurate adjustments frequently
enough when there are fewer than 10 agents in the campaign.

Blended Campaigns/Skill Groups
In blended campaigns, agents take inbound calls and outbound calls at the same time. The inbound program
can use the same or a different skill group as the outbound campaign skill group. You can set up the campaign
skill group to use a percentage of active agents and to reserve the rest for inbound calls. If an inbound customer
is in queue, blended agents are not reserved for the campaign. These mechanisms result in the inbound calls
generally receiving priority.

An agent on an outbound reservation call is not interrupted with a routed inbound call. An agent reservation
call lasts until one of the following conditions occurs:

• The agent closes the reservation call.

• The campaign closes out for that skill group.

• The reservation times out.

An internal call can interrupt an agent on a reservation call. This interruption normally causes the reservation
call to drop. Because the dialer is dialing customers for that agent during a reservation call, the interruption
can also result in abandoned calls if no agents are available.

Agents Skilled for Multiple Active Campaigns
You can skills agents for multiple active campaigns.Multiple campaigns cannot place simultaneous reservations
on the same available agent.

For example, assume that you have an agent in three active campaign skill groups. That agent becomes
available in all three skill groups at the same time. The dialer that monitors the skill groups for available agents
sends up three reservation requests, one for each campaign skill group. The first campaign skill group in the
dialer memory gets priority over the other requests. Over time, this situation results in an imbalance of agents
between skill groups.

To work around this issue, you can queue reservation calls in a similar way to personal callbacks. This
workaround services reservation requests in the second and third campaign skill groups first the next time an
agent becomes available. This method evenly distributes calls across the active campaigns when agents are
skilled in multiple campaigns.

Related Topics
Configuration of Campaigns and Imports, on page 65

Campaign Skill Group Reports
Skill Group reports provide information about agent activity for outbound and inbound agents.

Related Topics
Administrative and Supervisory Tasks, on page 93
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Blended Campaign Skill Group Reports
If you use the same skill group for both inbound and outbound, then the campaign consolidated reports can
provide a consolidated overview of business activity for both inbound and outbound calls.

Customer Time Versus System Time
This section describes when Outbound Option activities use the customer time zone rather than the system
time.

Customer Time

The Outbound Option uses area code prefixes to determine the time zone. With cell phones or VoIP phones,
the area code might not correspond to the actual time zone where the call is received.

Note

A campaign can include customers across multiple time zones, as long as the time zones follow the same rules
for when daylight saving time changes.

Unified CCE determines the time zone offset of each contact with a configurable region prefix database. The
database contains area code prefixes, assigned time zone offsets, and a daylight saving time flag. The Outbound
Option import uses this database to associate time zone offsets with customers. When the campaign searches
for records in the active query rule’s dialing list, the search considers the time zone offset when choosing
contacts. This approach does not account for daylight saving time changes from time zone to time zone. Those
changes are managed at the campaign level, so that campaigns take into account when each time zone changes
over to daylight saving time.

For example, North America has time zone regions that do not observe daylight saving time, or that switch
over on different days. A campaign that dials Houston, Texas and Mexico City, Mexico must account for
these locations changing over to daylight saving time on different days.

If a contact’s number does not match any of the configured region prefixes, then the campaign uses its default
time zone offset. If all the customers are in one time zone, then you do not need the region prefix information.

Outbound Option receives its list of daylight saving zones fromMicrosoftWindows. Ensure that all Outbound
Option components run on the same version of Windows as the Logger and AW VMs to keep the time zone
information in synch.

System Time
The system time is based on the Central Controller's time. System time is used in scheduled imports and in
the query rule time of day for switching contact lists.

Call Progress Analysis (Answering Machine Detection)
Call Progress Analysis (CPA) uses call signaling and media stream analysis to differentiate types of calls.
CPA can detect the following:
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• Fax or modem detection looks for specific tones in the media stream.

• Voice detection looks in the media stream for alternate voice and silence patterns after the call connects.

• Answering Machine Detection (AMD) uses media stream analysis to look for a longer voice stream with
minimal silence periods. AMD can also use terminating tone detection.

• Operator Intercept relies on call signaling network identification. This method does not analyze the media
stream looking for specific tri-tones.

CPA creates a delay before the call is transferred to an agent. Some countries require customer calls to be
transferred to an agent in a certain amount of time. In those cases, you may not be able to use CPA.

Because virtual CUBE does not have the Digital Signal Processors (DSP) that a physical CUBE has, it cannot
support CPA. Add a dedicated physical outbound gateway to support CPA.

Note

Answering Machine Detection

Enable Answering Machine Detection on a campaign-by-campaign basis, depending upon the requirements
of the campaign or the purpose of the call.

Enable IP AMD when using CPA. If you do not enable IP AMD, the SIP dialer instructs the gateway to
transfer the call to an agent without waiting for detection.

Note

AMD uses speech patterns and silence between voice patterns to differentiate a live voice from an answering
machine recording and background noise. There are parameters in the Outbound Option Campaign
Configuration component that modify the amount of silence or the expected time of greeting. Accuracy levels
depend on such factors as the campaign list quality and the phone number types.
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C H A P T E R 2
Architectural Overview

• Unified CCE Software Overview, on page 19
• Outbound Option Software Components, on page 20
• Scripts for Outbound Option, on page 34
• Fault Recovery, on page 34
• Campaign Manager Congestion Control, on page 35

Unified CCE Software Overview
This section provides a high-level overview of Unified CCE software, which must be installed and configured
before installing Outbound Option.

See Chapters 3-5 for detailed information about installing Unified CCE and Outbound Option software.Note

Before installing Unified CCE software, the virtual machine guests must have theMicrosoftWindows operating
system and, for some components, Microsoft SQL Server database management software installed. Also,
ensure that there is enough disk space available on each system to install the Unified CCE component.

See the CompatibilityMatrix for Unified CCE for information on operating system and software requirements.

Unified CCE software contains the following components:

• Router: The component of the Central Controller that makes routing decisions. It gathers and distributes
data to and from remote sites.

• Logger: The component of the Central Controller that controls the central database.

• Administration & Data Server: Known as the Admin Workstation in previous releases, the
Administration & Data Server is the user interface for Unified CCE software. The Administration &
Data Server can be located at any central or remote site. It allows users to monitor call handling within
the system and change configuration data or routing scripts.

• Peripheral Gateway: The interface between the Unified CCE platform and third-party hardware in each
call center, such as an ACD. A Peripheral Gateway (PG) is typically located at the call center.

Install the Peripheral Gateway from the PG Setup program; install the other components from the Web Setup
program.
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Together, the Router and Logger compose the Central Controller and are installed at a central site. At least
one Peripheral Gateway is typically installed in each call center. Administration&Data Servers can be installed
at a central site, a call center, or at a separate admin site.

Outbound Option Software Components
This section provides details about the server processes of the Outbound Option system:

• Campaign Manager: Manages lists.

• Outbound Option Import: Reads customer import files and generates database lists.

• Outbound Option Dialer: Maximizes the resources in a contact center by dialing several customers per
agent. This component resides on the PG server, where it performs the following actions:

• Dials customers

• Reserves agents

• Performs call classification

• Calculates agent availability

• Keeps outbound dialing at a level where the abandon rate is below the maximum allowed abandon
rate

The Outbound Option components provide a user interface where configuration data can be entered. The
Outbound Option server processes use this configuration data to configure campaigns.

Outbound Option Component Relationships
The following figure shows the component relationships within an Outbound Option deployment that uses
the SIP Dialer. These relationships include the Unified CCE software components that Outbound Option uses.
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Figure 2: Outbound Option Network Component Relationship (SIP Dialer)

Outbound Option Campaign Manager Component
The Campaign Manager component, which resides on the Logger, is responsible for:

• Managing when a campaign runs.

• Maintaining system and dialer configurations.

• Deciding which contact records to retrieve from a campaign based on configurable query rules and
delivering those contact records to dialers.

Records for callbacks are sent to the Dialer only when agents are logged in, and are controlled by registry
values as described in Chapter 5, "Configuration of Campaigns and Imports".

• Distributing configuration data to the import process and all available dialers in the system.

• Collecting real-time and historical data and sending it to the Router.

• Managing the Do Not Call list to ensure that no records on it are sent to the Dialers.

• Performing record queries based on the following order:

• Callback

• Retry Zone1

• Retry Zone2

• Pending Zone1

• Pending Zone1 DST

• Pending Zone2

• Pending Zone2 DST
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Based on this order, the priority for the Retry record is higher than for the Pending record. However, the
Pending record priority can be set above the Retry record by setting the “PendingOverRetryEnabled”
registry key to 1 (default is 0). If the value is set to 1, the record query order would be:

• Callback

• Pending Zone1

• Pending Zone1 DST

• Pending Zone2

• Pending Zone2 DST

• Retry Zone1

• Retry Zone2

For more information, see Appendix A, "Registry Settings".

Related Topics
Registry Settings, on page 107

Outbound Option Import Component
The Outbound Option Import component resides on the Unified CCE Logger. The Import component imports
a Contact list, which contains the phone numbers that OutboundOption dials. In addition, the Import component
uses the scheduling configured in the Outbound Option components to process imports that are scheduled for
a particular date and time.

When the Import component processes an import, the following steps occur:

1. Imports a Contact list into a table.

2. Builds a dialing list for a campaign.

3. Performs region prefix matching.

Outbound Option can continue to run a campaign while an import is in progress; however, some of the
campaign’s query rules might be disabled.

Note

Outbound Option Dialer Component
The Outbound Option SIP Dialer component, which resides on the PG server, performs the following actions:

• Dials customers using the voice gateways.

• Reserves agents through the Media Routing (MR) interface.

• Performs call classification.

• Calculates agent availability by monitoring campaign skill groups through the CTI Server interface to
the agent PG.
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• Transfers answered customer calls to reserved agents.

For Outbound campaigns, the Voice Gateway handles functions such as dialing, call control, and Call Progress
Analysis (CPA).

The following summarizes SIP Dialer features:

• Use the voice gateway or Cisco Unified Border Element (CUBE) dial peers and Unified SIP Proxy
routing policies for outbound call routing.

• No need to configure Unified CM translation pattern to support Campaign Automatic Number
Identification (ANI).

• Perform CPA at gateway DSP resource.

Unlike the physical CUBE, virtual CUBE does not have DSPs and cannot support
CPA. Add a dedicated physical gateway for your outbound traffic if you need
CPA.

Note

• The following summarizes CPA support:

• With Voice Gateway (T1/E1), CPA supports G.711 (both a-law and mu-law) and G.729 codecs.

• With CUBE (IP-IP) flows, CPA only supports G711 (both a-law and mu-law).

• With Outbound Option SIP dialer, CPA only supports G711 (both a-law and mu-law).

• No need to configure dialer port on Unified CM.

• The dialer does not need to be in proximity of the voice gateway.

• Supports warm standby architecture.

• Requires one MR PIM for MR PG.

• Only connected outbound calls, which are transferred to agents or VRU, go through Agent PG and Unified
CM.

• Call Throttling supports 60 CPS per dialer.

• Supports 1500 dialer ports.

These performance numbers can vary depending on the details of your deployment and your system
configuration. To accurately size your Outbound deployment, use the Cisco Unified Collaboration Sizing
Tool (Unified CST) available at https://tools.cisco.com/cucst/faces. For detailed instructions, see the online
Help system for this tool.

The Unified CST is available to Cisco internal employees and Cisco partners, and proper login authentication
is required.

Note
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Dialer Port Allocation
The dialer component reserves agents when it sees agents have become available. The Dialer requests skill
group statistics from the agent PG every two seconds and attempts to reserve agents based on the number of
available agents and the number of dialers active for this PG.

Each dialer checks agent availability to make reservation requests based on the skill group statistic refreshes
that occur every two seconds. When skill groups for multiple campaigns are active for one or more of the
same agents, then one campaign always reserves that agent or agents. You can avoid this situation by scripting
the reservation scripts to queue reservation calls using the same mechanism that is described for queuing
personal callback reservation requests. This resolution ensures a more even distribution of calls for active
campaigns that share a common agent pool.

For example, in the following scenario where two campaigns are in progress:

• Campaign 1 has four available agents and is dialing two lines per agent, which has a relative weight of
eight (two lines each for four agents).

• Campaign 2 has one available agent, but is dialing at four lines per agent, which has a relative weight of
four (four lines for one agent).

To dial customers for all available agents requires 12 ports, but only 9 ports are available.

The results:

• Campaign 1 gets 2/3 of the remaining ports, or six of the remaining ports.

• Campaign 2 gets 1/3 of the remaining ports, or three of the remaining ports.

• Each dialer begins dialing using the ports assigned to it, and assigns additional ports to the campaigns
when new ports become available.

Port Allocations for Campaign Modes
Preview, Predictive, and Progressive campaigns require at least two ports to place calls because they require
at least one port to reserve the agent and one port to dial the customer. Because campaigns are shared across
active dialers that service a PG, this maximum number of active campaigns applies to the PG.

Transfer to VRU and Direct Preview calls only require one port. Transfer to VRU calls do not reserve the
VRU port before dialing, and Direct Preview calls use the agent's phone to place the call.

Transfer to Agent Call Flow: SIP Dialer with SIP Proxy
The following figure illustrates a Transfer to Agent Call Flow in a deployment with a SIP Dialer that is
connected to a SIP Proxy.
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Figure 3: Transfer to Agent Call Flow - SIP Dialer with SIP Proxy

1. An agent campaign starts. Customer records are delivered to the Dialer.

2 to 5. An agent is reserved with a virtual placeholder call.

6 to 7.The dialer asks the gateway (via proxy) to place a call, and it does.

8. The Voice Gateway performs Call Progress Analysis and detects live voice. Media is terminated at the
VGW until the CPA completes.

9. The dialer is notified and asks the voice gateway (via proxy) to transfer the call to the agent.

10. The Voice Gateway sets up the customer call with the voice agent (via proxy) and the UC Manager.

Transfer to VRU Call Flow: SIP Dialer with SIP Proxy
The following figure illustrates a Transfer to VRU Call Flow in an Outbound Option deployment with a SIP
Dialer connected to a SIP Proxy.
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Figure 4: Transfer to VRU Call Flow - SIP Dialer with SIP Proxy

1. An unattended VRU campaign starts. Customer records are delivered to the Dialer.

2. The Dialer asks the SIP Proxy to forward an invitation to an available gateway to start a call.

3. The Gateway places the call.

4. Voice Gateway does Call Progress Analysis and detects an answering machine. The Dialer is notified.

5. The Dialer asks the MR PG where the VRU is.

6. MR PG forwards the request to the Router.

7. The routing script identifies the VRU and notifies the MR PG.

8. The MR PG forwards the route response to the Dialer.

9. The Dialer notifies the voice gateway to transfer the call to the VRU.

10. The Gateway starts the transfer to the SIP Proxy, and the SIP Proxy forwards the invitation to the Unified
CM. Unified CM forwards the call invitation to the VRU, and media is set up between the Gateway and
the VRU.

Transfer to Agent - SIP Dialer with No SIP Proxy
The following figure illustrates a transfer to agent call flow in an Outbound Option deployment with a SIP
Dialer without a SIP Proxy.
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Figure 5: Transfer to Agent - SIP Dialer with No SIP Proxy

1. Import is scheduled and campaign starts. Records are delivered to Dialer.

2. The Dialer looks for an available agent via the Media Routing Interface.

3. MR PG forwards the request to the Router.

4. The routing script identifies an agent and responds to the MR PG.

5. Media Routing PIM notifies the Dialer that the agent is available.

6. Dialer signals the gateway to place a call to the customer.

7. The Gateway places a call to the customer, and the Dialer is notified it is trying.

8. Call Progress Analysis is performed at the gateway. Voice is detected, and Dialer is notified.

9. The Dialer asks the voice gateway to transfer the call to the reserved agent by its agent extension.

10. The Gateway directs the call to the agent via Unified CM using dial peer configuration to locate the
Unified CM. Media is set up between the Gateway and the agent’s phone.

Peripheral Gateway (PG)
The peripheral gateways (PGs) are redundant in a SideA - SideB configuration; one side is active and the
other side runs in standby while waiting to be activated. The dialers are co-located with the agent PGs with
the dialers running in a peer model.
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Agent PG
The agent PG is a primary data collection point for agent and skill group statistics. The Dialer connects to the
agent PG through the CTI Server interface to monitor skill groups associated with campaigns. It uses the
number of working agents and available agents to determine when to reserve agents and when to dial for agent
campaigns. For 'Transfer to VRU' campaigns, the Dialer monitors the number of calls queued to determine
when the Dialer component has reached the limit of VRU ports for this campaign as specified in the campaign
skill group.

The agent PG also monitors all calls placed to the Dialer ports . The Dialer uses the PG representation of the
call to push customer call context to the agent. The Dialer also provides information about call results so that
the PG can report Outbound Option statistics for the campaign skill group.

Campaign statistics and skill group statistics both report the number of Outbound Option calls that reach
agents. The Campaign Manager collects and reports campaign statistics. The PG collects and reports skill
group statistics. The two reports can differ by a call or two for a given half hour, but they are reconciled at
the end of the campaign.

Media Routing PG
TheMedia Routing PG (MRPG) is the interface the Dialer uses to make route requests to the Central Controller
to find and reserve available agents. Each Dialer uses its own MR controller (MR PIM), and a separate dialed
number is configured to differentiate requests for different campaign skill groups for agent campaigns.

In a Dialer deployment, the VRU and agent controllers (PIMs) are included in the Agent PG using the Generic
PG or System PG deployment to allow theMR PG to be co-located. See the Design Guide for a quick reference
on configuration limits and scalability constraints. For more information about PG deployments, see these
documents:

• Virtualization for Unified Contact Center Enterprise at http://www.cisco.com/c/dam/en/us/td/docs/voice_
ip_comm/uc_system/virtualization/virtualization-unified-contact-center-enterprise.html

• Unified CCE Solution Compatibility Matrix at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html

VRU
The Dialer uses the VRU for unassisted treatment of customer calls depending on campaign configuration
for abandoned calls, answering machine treatment in an agent campaign, or for unassisted transfer to VRU
campaigns.

VRU scripting is flexible in playing prompts to the user and collecting other data. It can also be a queue point
to wait for the next available agent.

Partition the ports accordingly when using the same VRU for inbound and outbound campaigns. For inbound
calls, do not use ports allocated for the transfer to VRU feature. For VRU ports shared between inbound and
outbound applications, the Dialer might transfer customers to a VRU which does not have any available ports
left. In this case, the called party hears a fast busy signal or a 'ring no answer' message. To avoid this situation,
ensure that the VRU has enough ports for both inbound and outbound traffic.
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The transfer speed between the Dialer and the VRU is usually under two seconds, but can be longer depending
on the network design and configuration.

Note

Administration and Data Server: Configuration
Use the Administration & Data Server configuration tools to configure the Unified CCE system. Enable the
tools for configuring Outbound Option by editing the Administration & Data Server setup.

Cisco Unified Intelligence Center
Cisco Unified Intelligence Center (CUIC) is the standard Unified CCE reporting interface.

For details about Unified Intelligence Center, see the Cisco Unified Intelligence Center Documentation.

Dialer Reports
The Outbound Option Dialer reports provide information about the dialer platform. These predefined templates
include information about performance and resource usage. The templates also enable you to determine
whether you need more dialer ports to support more outbound calls.

For more information, see chapter 6, "Administrative and Supervisory Tasks".

Outbound Option Agent Desktops
Cisco Finesse supports Outbound Option-enabled agents.

Cisco Finesse
Cisco Finesse provides the following applications and tools:

• A web-based desktop application for agents and supervisors. Agents and supervisors access their desktops
by entering the following URL in their browsers: http://hostname, where hostname is the hostname or
IP address of the Finesse server.

• A web service that provides contact center agent desktop functionality through a REST-like interface.

• An administration console for configuring system settings, desktop layout, wrap-up reasons, and reason
codes. Administrators access this console by entering the following URL in their browsers:
http://hostname/cfadmin, where hostname is the hostname or IP address of the primary Finesse server.

Cisco Finesse supports Outbound Option as follows:

• Finesse supports Progressive mode, Predictive mode, Preview mode, and Direct Preview mode.

• You can schedule both regular callbacks and personal callbacks.

Note
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Agents who are on Progressive or Predictive Outbound Option calls do not appear in the Talking - Outbound
column of the Queue Statistics gadget on the supervisor desktop. This number only includes agents who are
talking on outbound calls placed by those agents.

Note

Outbound Option Extended Call Context Variables
The Outbound Option Dialer uses CTI Extended Call Context (ECC) variables to exchange information with
the Finesse desktop. The following table lists the ECC variables Outbound Option uses.

You can use a custom ECC payload to pass the Dialer ECC Variables to a VRU.Note

Table 2: ECC Variables for Outbound Option

DescriptionECC Variable

Indicates the name of the Outbound Option campaign to which the call belongs.BACampaign

Identifies a customer account number and can be used by the desktop
application to perform a database lookup to obtain more customer data. This
ECC variable is displayed only if the data was available in the customer import
file.

Themaximum character length of this ECC variable is 30 characters.Note

BAAccountNumber

Multipurpose placeholder that sends data from the Finesse desktop to the
Outbound Option Dialer. This variable responds to the reservation call to
schedule and cancel callbacks, and to changes to the callback phone number.
See the following rows for more information about BAResponse.

BAResponse
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DescriptionECC Variable

On the Finesse desktop, when an agent uses theAccept,Reject,Reject-Close,
Skip, Skip-Next, and Skip-Close buttons in Preview mode, BAResponse is
set to one of the following values:

• Accept: Accepts the current preview call.

• Reject: Rejects the current preview call. Sets record to “R” for retry.

• Reject-Close: Rejects the current preview call and closes the record so
it will not be called again.

• Skip: Skips the current preview call. Sets record to “R” for retry.

• Skip-Close: Skips the current preview call and closes the record so it will
not be called again.

On the Finesse desktop, an agent in Preview mode can respond with the
following options:

DescriptionBAResponse settingAgent Action

Accepts the current
preview call.

AcceptAccept

Rejects the current
preview call. Sets record
to “R” for retry.

RejectDecline > Reject

Rejects the current
preview call and closes
the record so it will not
be called again.

Reject-CloseDecline > Close

BAResponse for Preview
mode

When an agent uses the Callback button, BAResponse is set to one of the
following values:

Spaces are relevant and must be included in these commands.Note

• Callback mmddyyyy hh:mm: Schedules a callback for the indicated date
and time

• Callback Cancel: Cancels a previously scheduled callback for this call

• P#xxxxxxxxxxxxxxxxxxxx: Changes the callback phone number to the
number specified by xxxx

For Preview modes, cancel the reservation call by clicking Reject.

For Predictive mode, cancel the reservation call by clicking Not Ready and
then hang up the reservation call.

BAResponse for the
Callback button
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DescriptionECC Variable

For Direct Preview calls, any connected customer call is classified as VOICE
by the Dialer (default). To reclassify the call result, the agent can click the
following buttons:

• Voice: To reclassify a call as a voice call, set the BAResponse variable
to REX_VOICE. Enable the Voice button only after pressing one of the
other buttons first. Pressing one of the other buttons first enables an agent
to reclassify the call if needed.

• Answering Machine: To reclassify the call as an answering machine
call, set the BAResponse variable to REX_ANS_MACHINE.

• Fax/Modem: To reclassify the call as a fax/modem call, set the
BAResponse variable to REX_FAX.

• Invalid: To reclassify the call as an invalid call, set the BAResponse
variable to REX_INVALID.

BAResponse for Direct
Preview calls

For answering machine detection on a transfer to VRU campaign, the
BAResponse variable is evaluated to carry the CPA result of the customer call.
Two new IF node configurations are supported:

• Call.BAResponse=“CPA_AnswerMachine”

• Call.BAResponse=“CPA_Voice”

These IF nodes route to separate External Scripts to allow for different treatment
depending on whether a voice or an answering machine was detected.

BAResponse for answering
machine detection in a
transfer to VRU campaign

Contains two characters indicating the mode and direction of the Outbound
Option Dialer initiated call. The first character identifies the call mode:

• R: Reservation call, Predictive mode

• R: Reservation call, Predictive mode

• G: Reservation call, Progressive mode

• P: Reservation call, Preview mode

• D: Direct Preview reservation call

• C: Customer call

• A: Reservation call, personal callback.

During a reservation call, the first character is P, R, G, or A.

When a customer call is transferred to an agent, the first character is C.

The second character of BAStatus indicates the call direction:

• O: Outbound

• I: Inbound

• B: Blended

BAStatus

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
32

Architectural Overview
Outbound Option Extended Call Context Variables



DescriptionECC Variable

Unique key identifying a specific customer record within the Dialing List table
in the Outbound Option private database.

BADialedListID

Indicates the GMT offset, in minutes, for the customer’s time zone and obtains
the customer’s local time. The format of this ECC variable is +/-#####.

This field’s first character is either a positive or negative sign, followed by 5
digits. For example:

• This example indicates that the customer is one hour behind GMT:

BATimeZone = -00060

• This example indicates that the customer is two hours ahead of GMT:

BATimeZone = +00120

BATimeZone

Contains the customer’s last and first name separated by a comma, which is
compiled using the imported LastName, FirstName that was configured on
the Import Rule Definition tab page.

BABuddyName

Desktop Button Behavior
The following table explains the desktop button behavior when a call is placed using Outbound Option.

For more information about dialing modes, refer to Dialer Reports, on page 105.

Buttons EnabledCall DescriptionDialing Mode /
Other Conditions

Accept, Skip, Reject, Skip-Close, and
Reject-Close buttons are enabled if the reservation
call has not yet been accepted.

Reservation calls: Dialer places the
call and agent is available.

Preview

No buttons are enabled if the customer does not
answer the call.

Initial customer calls: Agent accepts
the call and Dialer calls the
customer.

Callback button is enabled.Transferred customer calls: Agent
is talking to a customer.

No buttons are enabled.Reservation calls: Dialer places the
call and agent is available.

Predictive and
Progressive

No buttons are enabled if the customer does not
answer the call.

Initial customer calls: Dialer calls
the customer.

Callback button is enabled.Transferred customer calls: Agent
is talking to a customer.
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Buttons EnabledCall DescriptionDialing Mode /
Other Conditions

Accept, Skip, Reject, Skip-Close, and
Reject-Close buttons are enabled if the reservation
call has not yet been accepted.

Reservation calls: Dialer places the
call and agent is available.

Direct Preview

No buttons are enabled if the customer does not
answer the call.

Initial customer calls: Agent accepts
the call and calls a customer.

Callback,AnsMach, Fax, and Invalid buttons are
enabled.

You can revert to voice if you make a
mistake.

Note

Transferred customer calls: Agent
is talking to a customer.

Accept and Reject buttons are enabled, if the
reservation call has not been accepted yet.

BAStatus is set to A and O or A and
B for a reservation call.

Personal
Callback

No buttons are enabled if the customer does not
answer the call.

Initial customer calls: Agent accepts
the call and calls a customer.

Callback button is enabled.Transferred customer calls: Agent
is talking to a customer.

Scripts for Outbound Option
Outbound Option uses Unified CCE scripting configured on the Administrative Workstation to manage
campaigns.

There are two types of scripts:

• Administrative scripts to enable, disable, or throttle campaign skill groups for outbound campaigns.

• Agent reservation routing scripts to reserve agents for specific outbound campaigns and personal callbacks.
These scripts can also transfer calls to VRU campaign or transfer calls to non-VRU campaigns for
answering machine or abandons.

Related Topics
Administrative Scripts for Outbound Option, on page 81
Routing Scripts for Outbound Option, on page 82

Fault Recovery
This section describes Outbound Option behavior when specific components fail and recover.

Campaign Manager Fault Recovery
The Campaign Manager resides on the Logger. Logger Side B has no Campaign Manager, so only one
Campaign Manager runs in the environment.
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If the Unified CCE Router and MR PG are still accessible when the Campaign Manager process shuts down,
the Dialer can still reserve agents for an agent campaign. In this case, the Dialer continues to dial contacts
and saves the results until it processes all the cached calls in memory.

After processing all its cached records, the Dialer cannot dial more calls until the Campaign Manager process
recovers and sends it more records.

When the Campaign Manager is back online, it updates call results based on the information it receives from
the Dialer. A few records can be lost when the Campaign Manager is not available.

Dialer Fault Recovery
You deploy the SIP Dialer in redundant pairs in warm-standby mode. You can have one redundant pair for
each Agent PG. To install multiple Dialers, install each on a separate PG VM, but assign them the same Dialer
Name.

When the CampaignManager detects that a Dialer state change from ready to not ready or that the connection
from the active Dialer is lost, the Campaign Manager activates the standby Dialer, if there is a standby Dialer
in ready state.

For regulatory compliance, the SIP Dialer does not automatically re-attempt calls that were in progress during
a failover. Instead, the Dialer sends all active and pending customer records to the Campaign Manager. If the
Campaign Manager is not available, the dialer closes them internally.

Active calls are handled as follows:

• Canceled if the call is not connected.

• Abandoned if the call is connected but not yet transferred to the agent or VRU.

• Continued if the call is already transferred and the PG/CG does not fail during that time.

If the standby Dialer does not respond during a set period, the Campaign Manager marks all outstanding
records with an Unknown status and returns them to Pending status.

Calls, that were already connected to an agent, continue during failover. However, the Dialer Detail table
changes the call from Closed to Dialed (D) state while the agent is still talking to the customer. When the call
ends, the Dialer Detail record for that call may show an earlier end time than the actual end of the call.

Note

Campaign Manager Congestion Control
The Campaign Manager depends on an internal dispatch thread to process messages between the Campaign
Manager and its registered Dialers. At times of high call rates, the Campaign Manager cannot process the
volume of inbound messages from the Dialers fast enough and the number of messages queued to the dispatch
thread, the queue depth, increases. Under these conditions, the Campaign Manager performance can be
decreased, and if the queue depth becomes too large, the Campaign Manager restarts.

To protect the CampaignManager from these overload conditions, the Congestion Control feature dynamically
reduces the dialing rate of the registered Dialers as the queue depth increases. Congestion control is triggered
when the Campaign Manager message queue depth reaches predefined thresholds, the Congestion Levels. As
each level is reached, the Campaign Manager instructs all the registered Dialers to reduce their dialing rate
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by a specified percentage of the configured Port Throttle value, reducing the number of records dialed. As
the congestion eases, the Campaign Manager updates the dialers to a lower Congestion Level and a reduced
throttle percentage until the system returns to normal and no additional throttling is applied.

The following table summarizes the Congestion Levels, the queue depth threshold for each level, and the
throttle percentage applied at each level.

Queue Depth Thresholds
to Decrease Level

Throttle PercentageQueue Depth Thresholds
to Increase Level

Congestion Level

N/ANo throttlingQueue depth is below
3,000 messages

0 - Normal operation

Level 1 decreases to Level
0 when queue depth
decreases to 1,500
messages

25%Queue depth increases to
3,000 messages

1 - Slightly congested

Level 2 decreases to Level
1 when queue depth
decreases to 2,500
messages

50%Queue depth increases to
5,000 messages

2 - Moderately congested

Level 3 decreases to Level
2 when queue depth
decreases to 4,500
messages

90%Queue depth increases to
7,500 messages

3 - Heavily congested
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C H A P T E R 3
Outbound Option Installation Preliminary Steps

• Before You Begin, on page 37

Before You Begin
ReviewCiscoOutboundOptionDescription in the Solution Design Guide for Cisco Unified Contact Center
Enterprise to learn about deployment options and other design considerations.

The following sections discuss considerations for Outbound Option installations.

System Requirements
System requirements for Outbound Option include the following:

• Choose a Region on Windows Server that includes a 12-hour time format. Outbound Option assumes
that times are in a 12-hour format. If you choose a Region that only has a 24-hour format, such as Spanish
(Spain), the Outbound Option configuration tools do not work properly.

• A working Unified CCE system that has the following:

• Router and Logger

• Administration & Data Server

• Agent PG, Unified CCE Generic PG, or System PG

• MR PG

• CTI Server

• Unified CM connectivity with agents and CTI Route Points

• If you plan to use the transfer to VRU feature, configure a VRU deployment that supports transfer to
VRU. See your Unified CVP, Unified CCX, or third-party VRU documentation for instructions.

• Your system must meet the hardware and software requirements as listed in the following documents:

• Virtualization for Unified Contact Center Enterprise at https://www.cisco.com/c/dam/en/us/td/docs/
voice_ip_comm/uc_system/virtualization/virtualization-unified-contact-center-enterprise.html
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• Unified CCE Solution Compatibility Matrix at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html

• Only T1 PRI and E1 PRI interfaces to the PSTN are supported for Outbound Option SIP dialers.

Outbound Option Database
Outbound Option uses a dedicated SQL database on the Logger. The installation includes creating this database.
The installer collects some business-related data to properly create the database.

Ensure that the Logger (side A) virtual machine datastore is large enough to accommodate both the Logger
database and the Outbound Option database.

VRU Integration
The Dialer uses the VRU for unassisted treatment of customer calls depending on campaign configuration
for abandoned calls, answering machine treatment in an agent campaign, or for unassisted transfer to
VRUcampaigns.

Unified CVP deployments might require Media Termination Point (MTP) resource allocations for calls that
are transferred to the VRU from the dialer.

Related Topics
Configure a Transfer to VRU Script, on page 85
Create a Network VRU, on page 42
Send to VRU, on page 84
Transfer to VRU, on page 3
Transfer to VRU Call Flow: SIP Dialer with SIP Proxy, on page 25
Transfer to VRU Campaigns, on page 13
Transfer to VRU Campaign Tasks, on page 67
VRU, on page 28

Auto Answer Settings
Outbound Option is flexible when configuring auto-answer, depending on the system requirements. The main
determining factor is whether the business requires the Outbound Option agent to hear a zip tone. Using an
agent zip tone increases the transfer time line by almost one second.

Related Topics
Auto Answer Configuration on Agent Phones, on page 59
Install Dialer Component on the PG Virtual Machine, on page 57
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C H A P T E R 4
Outbound Option Installation

• Unified CCE Configuration for Outbound Option, on page 39
• Unified Communications Manager and Gateway Configuration, on page 47
• Outbound Option Software Installation Steps, on page 55
• Verification, on page 60

Unified CCE Configuration for Outbound Option
This section provides procedures for configuring Unified CCE for Outbound Option.

Unified CCE System Configuration for Outbound Option
The following table lists the steps required to set up your Unified CCE system to handle the optional Outbound
Option components.

Table 3: Configure Unified CCE for Outbound Option

SeeTaskStep

Configure the PGConfigure the Unified CCE PG.1

Configure Dialer ComponentConfigure the Dialer component.2

Configure Port MapConfigure the port map.3

Create a Network VRUCreate a Network VRU.4

Configure Media Routing PG (MR PG)Configure the Media Routing PG.5

Configure Skill GroupConfigure a skill group.6

Create Dialed NumberCreate a dialed number.7

Unified CCE DocumentationCreate a translation route to a VRU.8

Configure System OptionsConfigure system options.9

Enable Expanded Call VariablesEnable ECC variables.10
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SeeTaskStep

Packet Capture for TroubleshootingEnable packet capture.11

Configure the PG

Procedure

Step 1 In ICM Configuration Manager, open Tools > Explorer Tools > PG Explorer.
Step 2 Click Retrieve, and then click Add PG.
Step 3 Enter the name (for example, PG1).
Step 4 Select the Client Type, either Call Manager, CUCM, or Generic.
Step 5 Click Add Peripheral.
Step 6 Enter the name (for example, PG1_PIM1).
Step 7 On the Peripheral tab, check Enable post routing.
Step 8 Select the Default Desk Setting from the drop-down list.
Step 9 On the Routing Client tab, enter the routing client name (for example, PIM1_Voice).
Step 10 Click Save.
Step 11 Record the assigned Logical Controller ID for later use: ____________________.
Step 12 Record the assigned Peripheral ID for later use: ____________________.

Configure Dialer Component

Procedure

Step 1 Make sure that all CCE services are running.
Step 2 Open the Unified CCE Configuration Manager.
Step 3 ExpandOutbound Option, and double-click Dialer to display theOutbound Option Dialer configuration

window.
Step 4 Click Retrieve.
Step 5 Click Add to add a new dialer.
Step 6 Enter the following information in the Dialer General Tab fields.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
40

Outbound Option Installation
Configure the PG



Table 4: Dialer General Tab Fields

DescriptionField

The name of the system where the dialer is located. Maximum 32-character
string, including alphanumeric characters, periods (.), and underscores (_).
Alphabetic characters can be uppercase or lowercase. The name must begin
with an alphanumeric character, and cannot contain spaces.

When you install the dialer component, enter the Dialer Name
in the Peripheral Gateway Setup exactly as you enter the name
here. Otherwise, the dialer cannot register with Campaign
Manager.

Note

SIP Dialer Name (required)

This check box enables the dialer for all campaigns.Enable

Select a preconfigured Call Manager PG peripheral name. This field is a
drop-down list and is not editable.

ICM Peripheral Name
(required)

Select SIP (Session Initiation Protocol)Dialer Type

Maximum 255 characters. This description appears only on this tab page.Description

General Telephony Section

When this option is enabled, the dialer uses the area code to reach local
telephone numbers. The default is Disabled.

Include Area Code when
Dialing

Enter any dialing prefix required by your location or by your campaigns. For
example, some locations require the prefix 9 to reach an outside telephone
line.

Dial prefix

Enter the long distance prefix. The dialer checks the local area codes against
the contact number. The dialer appends the prefix for any contact number
in an area code outside the configured local area codes.

For dialers in contact centers outside the United States, either
enter the locally specific long distance prefix in the Long distance
prefix field or leave the field blank.

Note

Long distance prefix

Enter the area/city codes for your location. Enter multiple local area codes
separated by commas; for example, “508,617,978” represents three local
area codes.

Local area code (comma
delimited)

Enter the number of seconds that the dialer waits before reusing a port after
a hangup event. The default is 1 second.

Hangup Delay (1-10)

Themaximum calls-per-second (CPS) rate at which the dialer dials outbound
calls. For example, a port throttle count=5 indicates that no more than 5 calls
are started during a 1 second period. If 5 calls are ready to dial, they are
spaced evenly over that period. The range is 0.5 to 60. The default is 15
CPS for SIP dialer.

Port Throttle
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Step 7 Click Save.

Configure Port Map
Perform the following steps to configure the port map for each dialer.

Procedure

Step 1 In the Unified CCE Configuration Manager Outbound Option Dialer configuration window, select the
Port Map Selection tab to display the port map configuration.

Step 2 To begin adding ports to this dialer, click Add.
Step 3 Configure a set of ports and their associated extensions.

A Dialer can support 1500 ports. The allowed Telephony Port range is from 0 to 1499.

Step 4 Click OK. The port mappings appear on the Port Map Selection tab.
Step 5 Click Save to save all the configuration information.

Create a Network VRU
Create a Type 2 VRU to use during the Media Routing (MR) PIM setup.

Procedure

Step 1 In the Configuration Manager, open the Explorer tools.
Step 2 Open the Network VRU Explorer tool.
Step 3 Click Retrieve
Step 4 Click Add Network VRU
Step 5 In the Network VRU dialog, enter a Name for the VRU.
Step 6 Set the Type drop-down list to Type 2.
Step 7 Record the VRU name: ______________.
Step 8 Click Save.

See the Configuration Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/
en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html for detailed information about the Unified CCE
Configuration Manager tools.

Note
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Configure Media Routing PG (MR PG)
Perform the following steps to configure the MR PG (PG2).

Procedure

Step 1 In Configuration Manager, open the Tools > Explorer Tools > PG Explorer.
Step 2 Click Retrieve, then click Add PG.
Step 3 Enter the Name (for example, PG2_MR).
Step 4 Select a Client Type ofMedia Routing.
Step 5 Click Add Peripheral.
Step 6 Enter the Name (for example, PG2_MR_PIM1).
Step 7 On the Peripheral tab, check Enable post routing.
Step 8 On the Routing Client tab, enter the routing client name (for example, MR_PIM1_Voice).
Step 9 Set the Routing Type dropdown to None.
Step 10 Set the Default call type to None.
Step 11 On theAdvanced tab, select theNetwork VRU from the drop-down list that you created during Unified CCE

configuration for Outbound Option.
Step 12 Click Save.
Step 13 Record the assigned Logical Controller ID displayed on the Logical Controller panel for later use:

____________________.
Step 14 Record the assigned Peripheral ID displayed on the Peripheral tab, for later use: ____________________.

Related Topics
Create a Network VRU, on page 42

Configuration for Send to VRU Campaign
To support a Send to VRU campaign, you must configure an additional Type 2 Network VRU and a Type 10
Network VRU.

Follow these procedures to create and configure the VRUs.

SeeConfiguringNetworkVRUs andVRUScripts in theConfigurationGuide for CiscoUnified ICM/Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-installation-and-configuration-guides-list.html for detailed
information about the Unified CCE Configuration Manager tools.

Note

Configure Network VRU Type 2
Create a Type 2 VRU to use during the Media Routing (MR) PIM setup.
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Procedure

Step 1 In the Configuration Manager, open the Explorer tools.
Step 2 Open the Network VRU Explorer tool.
Step 3 Click Retrieve
Step 4 Click Add Network VRU
Step 5 In the Network VRU dialog, enter a Name for the VRU.
Step 6 Set the Type drop-down list to Type 2.
Step 7 Record the VRU name: ______________.
Step 8 Click Save.

Assign Type 2 Network VRU to MR-PG

Procedure

Step 1 In Configuration Manager, open the Tools > Explorer Tools > PG Explorer.
Step 2 Click Retrieve, then open the MR PG.
Step 3 On the Advanced tab, select the Type 2 Network VRU from the drop-down list .
Step 4 Click Save.

Configure Network VRU Type 10
Create a Type 10 VRU.

Procedure

Step 1 In the Configuration Manager, open the Explorer tools.
Step 2 Open the Network VRU Explorer tool.
Step 3 Click Retrieve
Step 4 Click Add Network VRU
Step 5 In the Network VRU dialog, enter a Name for the VRU.
Step 6 Set the Type drop-down list to Type 10.
Step 7 Record the VRU name: ______________.
Step 8 Click Save.
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See the Configuration Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/
en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html for detailed information about the Unified CCE
Configuration Manager tools.

Note

Assign Type 10 Network VRU to VRU-PG

Procedure

Step 1 In Configuration Manager, open the Tools > Explorer Tools > PG Explorer.
Step 2 Click Retrieve, then click Add PG.
Step 3 Enter the Name (for example, PG_VRU).
Step 4 Select a Client Type of VRU.
Step 5 Click Add Peripheral.
Step 6 Enter the Name (for example, CVP_PIM).
Step 7 On the Peripheral tab, check Enable post routing.
Step 8 On the Routing Client tab, enter the routing client name (for example, CVP_PIM_Voice).
Step 9 Set the Routing Type dropdown to None.
Step 10 Set the Default call type to None.
Step 11 On the Advanced tab, select the Type 10Network VRU from the drop-down list that you created during

Unified CCE configuration for Outbound Option.
Step 12 Click Save.
Step 13 Record the assigned Logical Controller ID displayed on the Logical Controller panel for later use:

____________________.
Step 14 Record the assigned Peripheral ID displayed on the Peripheral tab, for later use: ____________________.

Configure System Options

Procedure

Step 1 In Unified CCE Configuration Manager, expand Outbound Option, and then select System Options.
Step 2 Click theGeneral Options tab and define the dialing time range to use for all your OutboundOption campaigns,

and then click OK.

Remember to select AM or PM for your start and end times.Note
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What to do next

If you have previously configured campaigns, you can update them now. Click the Bulk Update tab page
and define specific dialing time ranges for phone numbers, and then click Update All Campaigns.

Note

Enable Expanded Call Context Variables
Perform the following steps to enable the expanded call context variables.

Procedure

Step 1 In the Configuration Manager, openMiscellaneous Tools > System Information.
Step 2 Check Expanded call context enabled and save your change.
Step 3 In the List tools, open the Expanded Call Variable List tool and click Retrieve.
Step 4 Enable all BAxxxx variables (BAAccountNumber, BABuddyName, BACampaign, BADialedListID,

BAResponse, BAStatus, and BATimezone).
Step 5 Select each variable, and, in the Attributes tab, check Enabled.
Step 6 Click Save.

What to do next

By default, the solution includes the predefined BAxxxx ECC variables in the "Default" ECC payload. You
can also create a custom ECC payload for your Outbound Option call flows. Always remember that you cannot
use an ECC variable unless it exists in one of the ECC payloads that you use for a call flow.

Packet Capture for Troubleshooting
For the SIP Dialer to capture data, ensure that the dialer on the Unified CCE PG machine uses the active
interface from the Ethernet Interface list. You can determine the active interface with a network protocol
analyzer tool such as Wireshark, which you can download from www.wireshark.org. The interface with
network packets is the active interface.

You can change the SIP Dialer packet capture parameters to use the active interface from theWindows Registry
Editor. Change the interface name option (-i) in the CaptureOptions key to the number of the active
interface. For example, to use the third interface, set the value for -i to -i 3.

Capture files are in theHKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customer
instance>\Dialer registry key location.

• From a command prompt window, enter a procmon ba_capture command to specify that the SIP Dialer
uses the active interface. In this command, specify the number of the active interface to use in the /options
-i parameter.

The syntax of the procmon ba_capture command is as follows:
ba_capture [/on] [/off] [/options] [/type]
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where

/on turns on packet capture, /off turns off packet capture. The default is off. Turn it on./on, /off

/options • -i <ifname>: Specifies the interface name on which to capture.

• -w <filename>: Captures directly to a file in pcap format. You can open the file with
Wireshark or another tool.

• -C <file_size>: Specifies the maximum size of a capture file in millions of bytes
(1,000,000 bytes, not 1,048,576 bytes).

• -W <filecount>: Specifies the number of files to create. The capture files are overwritten
from the beginning, thus creating a rotating buffer. The first capture file uses the name
specified with the -w flag. Subsequent capture files append a number to that name,
starting at 1 and continuing upward.

• -tt: Prints an unformatted timestamp on each dump line.

• -s: Snarfssnaplen bytes of data from each packet rather than the default of 68. Setting
snaplen to 0 means use the required length to catch whole packets.

/type 1 captures SIP packets only. /type 2 captures the entire data payload on the dialer
host machine.

/type

For example, the command
capture /on /options -i 2 -tt -C 20 –s 0 -W 20 -w DialerCapture

Captures the network packets on interface 3 with capture files: DialerCapture00 to DialerCapture19. The
maximum number of capture files stored is 20. After 20 files are created, the oldest capture file is overwritten
with the new data. Maximum file size is 20 MB.

Unified Communications Manager and Gateway Configuration
In the next phase of Outbound Option installation, you set up Unified CommunicationsManager and its related
gateway.

The following table lists the steps that comprise Unified CM setup.

Table 5: Unified CM Configuration Steps for Deployments with SIP Dialer

ProcedureTaskStep Number

Disable Ringback During Transfer to Agent for SIP,
on page 47

Disable Ring Tone for Dialer
Transfer

1

Configure SIP Trunks, on page 53Configure SIP Trunks2

Disable Ringback During Transfer to Agent for SIP
The voice gateway generates a ringback tone to the customer. To prevent the gateway from generating a
ringback, apply a SIP normalization script to the Unified Communications Manager SIP trunk.
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Apply this SIP normalization script only to the SIP trunk that handles the inbound call from the voice gateway
for agent transfer.

• If your deployment uses the same gateway for both PSTN calls and the dialer, complete all steps, 1 to
13, to create a dedicated SIP trunk and apply the normalization script.

The trunk for PSTN calls still needs a 180 RINGING SIP message for inbound
calls to trigger the gateway to play ringback to the PSTN.

Note

• If your deployment has a dedicated SIP trunk to handle the agent transfer dialer, complete steps 1 to 2
and 8 to 13 to apply the normalization script to your SIP trunk.

Procedure

Step 1 Navigate to https://<IP_address>:8443 where <IP_address> identifies the Unified
Communications Manager server.

Step 2 Sign in to Unified Communications Manager.
Step 3 To create a SIP trunk security profile in Unified CommunicationsManager, selectCommunicationsManager

GUI > System > Security > SIP Trunk Security Profile > [Add New].
The default port is 5060.
Figure 6: SIP Security Profile

Step 4 Click Save.
Step 5 Create a new SIP trunk and add the new SIP Trunk Security Profile.
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Figure 7: Create a New SIP Trunk

Step 6 Click Save.
Step 7 Click Reset.
Step 8 In Communications Manager GUI > Devices > Device Settings > SIP Normalization Scripts > [Create

New], enter the following SIP normalization script into the content field. All other values remain set to default.
M = {}
function M.outbound_180_INVITE(msg)
msg:setResponseCode(183, "Session in Progress")
end
return M

Figure 8: Add Normalization Script

Step 9 Click Save.
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Step 10 Click Reset.
Step 11 Associate the new normalization script with the SIP trunk.

Figure 9: Associate Script with Trunk

Step 12 Click Save.
Step 13 Click Reset.

Configuration of Voice Gateways
In an Outbound Option deployment that uses the SIP Dialer, you can have these configuration types:

• The SIP Dialer connects to a SIP Proxy, such as Cisco Unified SIP Proxy. The SIP Proxy, in turn, connects
to a voice gateway. A SIP Proxy can connect to more than one voice gateway. A configuration with
multiple voice gateways is known as a server group.

• Alternately, the SIP Dialer connects directly to a voice gateway without a SIP Proxy. The voice gateway
uses a standard dial peer configuration. This setup enables the gateway to know how to direct traffic to
agent extensions or to a VRU.

Specify your configuration when you install the Dialer component.

When you configure the voice gateway, you can keep most of the default configuration values. You do set
some of the configuration values. If you do not know these values, request the information from your voice
network administrator.

• Enable 100rel for Outbound Option. Otherwise, Outbound calls from the SIP Dialer fail. 100rel is enabled
globally on the gateway by default. However, if you also route Unified CVP calls with the gateway, you
cannot have 100rel enabled globally. In this case, disable 100rel globally with the command rel1xx

disable. Then, enable 100rel on the Outbound dial peer with the example dial-peer command:
voice-class sip rel1xx supported "100rel".

• The SIP Dialer does not support signaling forward unconditional under voice service voip. When
configuring a voice gateway for use with the SIP Dialer, specify signaling forward none.

Telecom carriers sometimes send an ISDN alerting message without a progress indicator. This situation causes
the voice gateway to send a SIP 180 Ringing message, instead of a SIP 183 Session In Progress message, to
the SIP dialer. The SIP dialer can process provisional messages such as 180, 181, 182, and 183 with or without
Session Description Protocol (SDP). When the SIP dialer receives these provisional messages without SDP,
the dialer does not perform Call Progress Analysis (CPA) and the Record CPA feature is disabled.

To enable the SIP dialer to perform CPA, add the following configuration to the POTS dial-peer of the voice
gateway: "progress_ind alert enable 8". This code sends a SIP 183 message to the SIP dialer.
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Telecom carriers sometimes send an ISDN alerting message without a progress indicator. This situation causes
the voice gateway to send a SIP 180 Ringing message, instead of a SIP 183 Session In Progress message, to
the SIP dialer. The SIP dialer can process provisional messages such as 180, 181, 182, and 183 with or without
Session Description Protocol (SDP). The SIP Dialer processes the CPA information along with the SDP
information because the SDP information is part of these provisional messages. But if the dialer receives these
provisional messages without SDP, the dialer does not perform Call Progress Analysis (CPA) and the Record
CPA feature is disabled. If the next provisional message changes the SDP information, the dialer processes
the SDP information.

In a SIP Dialer with Unified CVP VRU deployment, dialer-related call flows do not invoke call-survivability
scripts that are enabled on an incoming POTS dial-peer in the Ingress gateway. However, enabling a
call-survivability script on an Inbound POTS dial-peer does not negatively affect dialer-related call flows.

Note

Configure Transcoding Profile for Cisco Unified Border Element

The following example shows the transcoding profile for Cisco UBE.

Transcoding impacts port density.Note

dspfarm profile 4 transcode universal
codec g729r8
codec g711ulaw
codec g711alaw
codec g729ar8
codec g729abr8
maximum sessions 250
associate application CUBE
!

If you use a SIP Proxy, perform the following configuration on the SIP Proxy:

• Enable the SIP Dialer to reach the correct voice gateway for outbound calls.

• Enable the voice gateway to reach all the applicable Unified CM and CVP nodes for calls transferred to
an agent, a VRU, or to CVP.

• If your SIP proxy connects to more than one voice gateway, you can optionally load balance between
the voice gateways.

For detailed instructions on how to perform SIP Proxy configuration, see the Cisco Unified SIP Proxy
documentation website at
https://www.cisco.com/en/US/partner/products/ps10475/products_installation_and_configuration_guides_list.html.

Configure Cisco Unified Border Element
For full details on configuring the Cisco Unified Border Element (Cisco UBE) to support Outbound dialing,
see Cisco Unified Border Element Configuration Guide at https://www.cisco.com/c/en/us/support/
unified-communications/unified-border-element/tsd-products-support-configure.html

When configuring Cisco UBE with Outbound Option, ensure that you:
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• Configure three dial-peers in the Cisco UBE.

The dial-peers are used for:

• Incoming calls from the dialer.

• Outgoing calls to the terminating network from the Cisco UBE.

• Calls to be routed to the Cisco Unified Communications Manager.

• When configuring REFER consumption, issue the following commands in global VoIP configuration
mode:

• no supplementary-service sip refer

• supplementary-service media-renegotiate

Configure Cisco UBE for G.711 A-Law
By default the SIP Dialer always dials out calls using the U-law codec.

For full details on understanding and configuring codec support, see Cisco Unified Border Element
ConfigurationGuide at https://www.cisco.com/c/en/us/support/unified-communications/unified-border-element/
tsd-products-support-configure.html

The Cisco Unified Call Manager enables A-law by default.

You must have DSP cards to support the A-Law protocol.

Note

To enable the G.711 A-law codec, make the following changes in the Cisco UBE/Egress Gateways.

1. Set Transcode to "Universal".

Setting Transcode to "Universal" converts between A-law codec and U-law codec for incoming and
outgoing messages, as needed.

Example:
dspfarm profile 3 transcode universal
codec g729abr8
codec g729ar8
codec g711alaw
codec g711ulaw
codec g729br8
call-progress-analysis
maximum sessions 360
associate application CUBE

2. Set the Outgoing dial peer codec to "g711alaw".

Specifies that the SDP sent out from Cisco UBE to the customer end point should use the g711alaw codec.

Example:

dial-peer voice 2613 voip
destination-pattern 244T
session protocol sipv2
session target ipv4:10.77.58.33
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session transport udp
codec g711alaw
no vad

3. Set the Incoming dial peer codec to "g711ulaw"

Specifies that the SDP sent out from Cisco UBE to the Dialer should use g711ulaw codec.

Example:
dial-peer voice 2614 voip
description sipp_SIP_Incoming_DialPeer_from_dialer
session protocol sipv2
session transport udp
incoming called-number 244T
codec g711ulaw
no vad

Configure SIP Trunks
Unified CM is connected to the voice gateway or the SIP Proxy by SIP Trunks, which you configure on
Unified CM. Set up route patterns for the Dialer which are appropriate for your dial pattern.

Procedure

Step 1 Configure these trunks as follows:
DescriptionOption

Configure two SIP trunks on Unified CM for making the transfer to agents.
Configure one trunk between Unified CM and the SIP Proxy. Specify the IP

If you are using a SIP
Proxy

address of the SIP Proxy in the Destination field. Then, configure a second
trunk from Unified CM to the voice gateways. Specify the IP address of the
voice gateways in the Destination field.

Incoming transport time accepts TCP and UDP. The trunk accepts
traffic from the Gateway in TCP or UDP.

Note

Configure a SIP trunk on Unified CM from Unified CM to the voice gateway.
Specify the IP address of the voice gateway in the Destination field.

If you are not using a SIP
Proxy

Configure a SIP trunk between the Unified CM and Cisco UBE. Specify the IP
address of the Cisco UBE in the Destination field.

If you are using Cisco UBE

Step 2 In Unified CM clusters with more than two nodes, both the voice gateway and Cisco Unified SIP Proxy might
connect to each node. To enable those connections, add the SIP trunk to a device pool that points to the
Communications Manager Publisher. This configuration ensures that calls go to the agent if a subscriber node
fails over. See the following configuration example:

Example:
dial-peer voice 617 voip
description catch all for refer
destination-pattern 617T
session protocol sipv2
session target ipv4:10.86.227.107 (CUCM Publisher)
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codec g711ulaw
!

dial-peer voice 508 voip
description catch all for refer
destination-pattern 508T
session protocol sipv2
session target ipv4:10.86.227.107 (CUCM Publisher)
codec g711ulaw
!

Related Topics
Disable Ringback During Transfer to Agent for SIP, on page 47

Configure E1 R2 Signaling
The Outbound Option Dialer may be configured with systems using the E1 R2 signaling protocol. E1 R2
signaling is a channel associated signaling (CAS) international standard that is used with E1 networks in
Europe, Latin America, Australia, and Asia. For more information, see E1 R2 Signaling Theory

The high-level procedure for configuring an E1 R2 controller for use with the Outbound dialer is summarized
below. For full configuration details, see E1 R2 Signaling Configuration and Troubleshooting.

Procedure

Step 1 Set up an E1 controller connected to the private automatic branch exchange (PBX) or switch. Ensure that the
framing and linecoding of the E1 are properly set for your environment.

Step 2 For E1 framing, choose either CRC or non-CRC.
Step 3 For E1 linecoding, choose either HDB3 or AMI.
Step 4 For the E1 clock source, choose either internal or line. Keep in mind that different PBX's may have different

requirements for their clock source.
Step 5 Configure line signaling.
Step 6 Configure interregister signaling.
Step 7 Customize the configuration with the cas-custom command.

Example E1 R2 Settings

controller E1 0/0/0
framing NO-CRC4
ds0-group 1 timeslots 1-15,17-31 type r2-digital r2-compelled ani
cas-custom 1
country telmex
category 2
answer-signal group-b 1
caller-digits 4
dnis-digits min 4 max 13
dnis-complete
timer interdigit incoming 1000
groupa-callerid-end
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Outbound Option Software Installation Steps
This section discusses the tasks that are associated with installing Outbound Option and related components.
Before proceeding, navigate to the Side A data server and stop all ICM services there. Then perform the steps
in the following sections.

Software Installation and Database Creation
Install the Outbound Option component software and create its database.

Table 6: Software Installation and Database Creation Steps

See the topic that describesTaskStep

How to create an Outbound Option private database.Install the OutboundOption private
database on the Logger platform.

1

How to install the Dialer component on the PG.Install the Dialer component on the
PG platform.

2

How to install the MR PG on the PG platform.Install the MR PG on the PG
platform.

3

Create Outbound Option Private Database
Before you use Outbound Option, estimate the size for the Outbound Option private database. Then, create
the private database on the Logger Side A platform with the ICM ICMDBA utility.

Create the Outbound Option private database on Side A only.Important

Procedure

Step 1 Collect the following information:

• The size, in bytes, of each customer record in the import file. If the size is less than 128 bytes, use 128.
(RecordSize)

• The number of records that are imported. (RecordCount)

• Do the records from new imports replace or append to records that are already in the database?

Step 2 Estimate the contact table size as follows:

• If imports overwrite existing records: Do not change record count.

• If imports append to existing records: RecordCount = total number of rows kept in a customer table at
a time.
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• contact-table-size = RecordSize * RecordCount * 1.18

Step 3 Estimate the dialing list table size as follows:

• If imports overwrite existing records: RecordCount = number of rows imported * 1.5. (50% more rows
are inserted into the dialing list than are imported.)

• If imports append existing records: RecordCount = total number of rows kept in customer table at a time
* 1.5

• dialing-list-table-size = rows in dialing list * 128 bytes * 4.63

Step 4 Calculate the database size using this formula:
(Number of rows in all DL tables * (size of one row + size of index) ) +
(Number of rows in personal call back table * (size of one row + size of index) ) +
(Number of rows in Contact List table * (size of one row + size of index))

Step 5 Start ICMDBA by entering ICMDBA in the Microsoft Windows Run dialog box or command window.
Step 6 Select the Logger. Then, select Database > Create.
Step 7 In the Create Database window, specify the Outbound Option database type.

Enable autogrow on the database.Note

Step 8 Click Add. The Add Device window appears.

Use this window to create a new data device and log device for the Outbound Option database. Specify the
disk drive letter and size in megabytes for each new device.

Step 9 Click OK to create the device.
Step 10 Click Create, and then click Start.
Step 11 Click Close.

If necessary, you can later edit the device to change storage size, or remove a device, using the Database >
Expand option.

You cannot makemanual changes to the contents of the Outbound database. Do not use triggers in the Outbound
database. Do not add or modify triggers for the dialing lists or personal callback list. The Dialer_Detail table
in the logger or HDS contains the information that custom applications require. Extract that information from
the historical database server (HDS) to a separate server where the custom application can process the data
without impacting the HDS.

Caution

Configure the Logger for Outbound Option
Use this procedure to configure the Logger for Outbound Option.
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Procedure

Step 1 Open the Web Setup tool.
Step 2 Choose Component Management > Loggers.
Step 3 Choose the Logger that you want to configure, and click Edit.
Step 4 Click Next twice.
Step 5 On the Additional Options page, click the Enable Outbound Option check box.
Step 6 Select the Syslog box to enable the Syslog event feed process (cw2kfeed.exe).

The event feed is processed and sent to the Syslog collector only if the Syslog collector is configured.
For more information about the Syslog event feed process, see the Serviceability Guide for Cisco
Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html.

Note

Step 7 Click Next.
Step 8 Review the Summary page, and click Finish.

Related Topics
Outbound Option for High Availability: Preliminary Two-Way Replication Requirements
Two-Way Outbound Option Database Replication
Upgrade Outbound Option for High Availability in an Existing Deployment

Upgrade Outbound Option from a Previous Release
If you are upgrading from a previous CCE/CCH release, run the Enhanced Database Migration Tool (EDMT)
to upgrade your Outbound Option database. Otherwise, Campaign Manager does not start, and an alarm for
an incorrect private database version triggers. See the Cisco Unified Contact Center Enterprise Installation
and Upgrade Guide at http://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_installation_guides_
list.html for instructions on running EDMT.

Install Dialer Component on the PG Virtual Machine

Procedure

Step 1 Stop all ICM Services.
Step 2 On both the Side A and Side B PGs, run Peripheral Gateway Setup. Select Start > All Programs > Cisco

Unified CCE Tools > Peripheral Gateway Setup.
Step 3 In the Cisco Unified ICM/Contact Center Enterprise & Hosted Components Setup dialog, select an

instance from the left column under Instances.
Step 4 Click Add in the Instance Components section.

The ICM Component Selection dialog opens.

Step 5 Click Outbound Option Dialer.
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The Outbound Option Dialer Properties dialog opens.

Step 6 Check Production mode and Auto start at system startup, unless your Unified ICM support provider
specifically tells you otherwise. These options set the Dialer Service startup type to Automatic, so the dialer
starts automatically when the machine starts up.

Step 7 For Dialer Type, select the radio button for SIP (Session Initiation Protocol).
Step 8 Click Next.

After you create a dialer, you cannot change the Dialer Type. To switch dialer types, delete the
existing dialer and create a new dialer.

Note

Step 9 An Outbound Option SIP Dialer Properties dialog appears if you selected SIP as your Dialer Type.

Supply the following information on this page:

• In the SIP Dialer Name field, enter the name of the SIP dialer, for example,
Dialer_for_Premium_Calling_List. There is a 32-character limit. The name entered here
must match the name that is configured in Configuration Manager.

• For SIP Server Type, select either Cisco voice gateway or CUSP/CUBE (Cisco Unified SIP Proxy or
Cisco Unified Border Element.

• In the SIP Server field, enter the hostname or IP address of the Cisco voice gateway.

• In the SIP Server Port field, enter the port number of the SIP Server port. Default is 5060.

Click Next.

Step 10 On the Outbound Option Dialer Properties dialog, specify the following information:

• Campaign Manager—The hostname or IP address of the Side A Logger. You must supply a value in
this field.

• CTI server A—The hostname or IP address of the VM with CTI server Side A. This server is typically
the same VM where the PG is located.

• CTI server port A—The port number that the dialer uses to create an interface with CTI server Side A.
Make sure the CTI server port matches with the CG configuration.

• CTI server B—The hostname or IP address of the VM with CTI server Side B. This server is typically
the same VM where the PG is located.

• CTI server port B—The port number that the dialer uses to create an interface with CTI server Side B.

• Heart beat—The interval between dialer checks for the connection to the CTI server, in milliseconds.
The default value is 500.

• Media routing port—The port number that the dialer uses to create an interface with the Media Routing
PIM on the Media Routing PG. The default is 38001. Make sure the Media routing port matches that of
the MR PG configuration. For example, you can access this registry key:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<instance_name>\PG3A\PG\CurrentVersion\PIMS\pim1\MRData\Config\ApplicationTcpServiceName1.

Step 11 Click Next. A Summary screen appears.
Step 12 Click Next to begin the dialer installation.
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Optional - Edit Dialer Registry Value for AutoAnswer

If you enable auto answer in the CallManager with a zip tone, you must disable auto answer in the
Dialer or Dialers, if there are more than one. A zip tone is a tone sent to the agent's phone to signal
that a customer is about to be connected.

To disable auto answer in the Dialer, after the Dialer process runs for the first time, change the value
of the following registry key to 0:

HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<instance_name>\Dialer\AutoAnswerCall

Modification of Local Static Route File
The SIP Dialer installation process installs an empty template file named DNPHost in the
\icm\customerInstanceName\Dialer directory. This file defines the static route mappings of a
dialed number wildcard pattern to the IP address or host name with which an agent phone or CTI Route point
is registered. For each static route you define, add a row in the following format:
wildcard pattern, IP address or host name, description

Examples:
7?????, 10.86.227.144, transferring outbound calls to agent extensions

86! , 10.86.227.186, for CTI Route Points on CUCM node1

4?????, gambino.cisco.com, transfer to IVR campaign

For single gateway deployments, the SIP Dialer reads the static routing info from DNPHost and uses the
information to construct the SIP REFER message. If the SIP Dialer supports a voice gateway, the SIP Dialer
loads DNPHost, validates the routing entries, and sends an alarm if the file does not exist or is invalid.

See the installed DNPHost file template for additional information about its use.

Auto Answer Configuration on Agent Phones
The dialer component is preconfigured during installation to auto answer Outbound Option related calls to
the Outbound Option agent. However, this default configuration does not provide a zip tone to the agent
(which notifies of incoming calls), so agents must monitor the agent application for incoming customer calls.

To enable zip tone, enable auto-answer on the agent’s phone configuration in Unified CM. This solution adds
about a second onto the transfer time. This solution is identical to the solution that is used for Unified CCE.

For Mobile Agents using the nailed connection, the Unified CM auto answer setting does not provide a zip
tone, but contact center enterprise does provide an option for playing a notification tone to the agent using
the agent desk settings.

Enabling auto answer in the agent desk settings or in the dialer component in conjunction with the Unified
CM can be problematic. Therefore, disable the auto answer option in the dialer component, and enable it either
in the agent desk settings or in Unified CM.

Install MR PG
Perform the following steps to install the MR PG on the Side A platform.
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Procedure

Step 1 Run ICM Setup to install a PG that corresponds with PG2, which was configured earlier.
Step 2 In the Peripheral Gateway Properties window, select the PG2 PG Node ID and theMediaRouting Client

Type.
Step 3 Click Next.
Step 4 Add a PIM, PIM1.
Step 5 In the MediaRouting Configuration window, enable the PIM.
Step 6 Enter the peripheral name and the peripheral ID (recorded at the end of the procedure described in Configure

Media Routing PG (MR PG), on page 43) of the MR_PIM.
Step 7 Set the Application Hostname fields:

• For simplex deployments, set both of the Application Hostname fields to the computer name of the
Outbound Option Dialer.

• For duplex Sip Dialers with duplex MR PG deployments,

• Specify the local Dialer HostName in ApplicationHostName1.

• Specify the remote, duplex Dialer HostName in ApplicationHostName2.

Step 8 Set the Application Connection Port to the port number used by the Outbound Option Dialer (usually 38001).
Step 9 Click Next until Setup finishes. When Setup finishes, click Finish.
Step 10 Repeat the preceding steps to install the MR PG on the Side B PG platform.

What to do next

When you add new PG make sure that PG ID is provided in the Router configuration. Provide the number
that is assigned to the PG in the Enable Peripheral Gateway field in Web Setup. See chapter: Installation
in https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-installation-guides-list.html
Related Topics

Configure the PG, on page 40

Verification
This section provides a series of verification steps to determine if the system has been installed properly.
These steps are designed to pinpoint problems that might exist in the setup before actually attempting to deploy
the Dialer. If problems occur while using this product, please see this section before contacting Cisco Technical
Support (TAC).

This section assumes that the Outbound Option application is installed and at least one Dialer has been
configured along with its associated port map. This section also assumes that the Dialer port map has been
exported and configured on Unified CM using the BAT tool.

Note
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Dialer Component Status

Customer Instance Name

The customer instance name shows the dialer’s customer instance, node name, and process name. This can
be used if TAC asks you to interrogate the system while debugging a problem for a case.

Campaign Manager

The Campaign Manager shows the Campaign Manager connectivity status. This status is either A for active
or X for disconnected. If the Campaign Manager connectivity status is X, the dialer is not connected to the
Campaign Manager.

Try pinging from the dialer to the active Campaign Manager by hostname and by IP Address.

• If the ping fails for the IP address, recheck that the IP address is correct and troubleshoot network
connectivity.

Check to verify whether Outbound Option has been enabled, and the Campaign Manager process is
running.

• If the ping is successful for the IP address but not for the DNS hostname, check that the DNS hostname
is correct and that it is properly configured in the system’s DNS server.

• If the ping is successful, then recheck the dialer component setup to see if the dialer component setup
contains the wrong address or port number for the Logger.

• Check to see if the name of the Dialer configured in Configuration Manager matches the name entered
during PG setup.

CTI Server

The third block shows CTI Server connectivity status. This status is eitherA for active or X for disconnected.
If the status is X, then the dialer cannot connect to either CTI Server on side A or side B.

Try pinging from the dialer to the CTI Server/PG machines by hostname and by IP address.

• If the ping fails for the IP address:

• Recheck that the IP address is correct, and troubleshoot network connectivity.

• Check to see whether the CTI Server processes are running.

• If the ping is successful for the IP address but not for the DNS hostname, check that the DNS hostname
is correct and whether it is properly configured in the system’s DNS server.

• If the ping is successful, then recheck the dialer component set up to see if the dialer component set up
contains the wrong address or port number for the CTI Server.

• Check that the PG is online. Check that the PG has been enabled properly in the ICM Router setup.

Ports

The fourth block shows the state of all dialer ports. The first value, C, shows the total number of configured
ports. The second value, R, shows the total number of ready ports. Finally, the third value, B, reports the
number of dialer ports that are blocked. (This is runtime activity; it is unusual for ports to be blocked.)
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If the number of ports Configured is zero, then the dialer is not receiving port configuration from the Campaign
Manager component. Check to verify that ports are configured properly.

If the number of Ready ports is zero, confirm that the PG has been started.

MR PIM

The next block shows connectivity status with the MR PIM. This status is either A for active, X for
disconnected, orNRwhich means connected but not yet able to route. (TheU status is rarely seen and indicates
that a particular connectivity object within the dialer has not been created yet.)

- If the MR Status is X, check the connectivity by verifying the MR PG address and port configured in the
dialer component setup.

If the MR PG status is NR, then the Media Routing connection is established. Check to see if the MR PG is
online by looking at its status window.

SIP Dialer

The final block shows connectivity status with the SIP Proxy or Voice Gateway that is connected to the SIP
dialer. This status is either A for active, X for disconnected, or D for heartbeat disabled.

Verify Critical Configuration Steps
In the Dialer Configuration Component, click the Port Map Selection tab and ensure the Dialer is assigned to
a Unified CM PG.

Verify Database Configuration
For SQL Server 2008 R2, perform the following steps:

Procedure

Step 1 Open the SQL Server Management Studio.
Step 2 Expand the databases.
Step 3 Select the <cust instance_baA> Outbound Option database. Right click and select Properties.
Step 4 Select the Files page.
Step 5 In the database file row, click the button in theAutogrowth column. A Change Autogrowth dialog box appear.
Step 6 Ensure that the Enable Autogrowth box is checked. Click OK.
Step 7 In the log file row, click the button in the Autogrowth column. A Change Autogrowth dialog box appears.
Step 8 Ensure that the Enable Autogrowth box is checked. Click OK.
Step 9 Select the Options page.
Step 10 On the Recovery Model drop-down menu, select Simple.
Step 11 Click OK.
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Verify Router Registry Key
If you are using the Transfer to IVR feature, verify that the following router registry key on Side A and Side
B of the Router has a value of 2.
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customer

instance>\RouterA/B\Router\
CurrentVersion\Configuration\Global\SkillGroupCallsInQTimerInterval = 2
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C H A P T E R 5
Configuration of Campaigns and Imports

• Outbound Option Configuration Process Overview, on page 65
• Configuration Process Task Maps, on page 66
• Configure Skill Group, on page 68
• Create a Call Type, on page 68
• Create Dialed Numbers, on page 69
• Create Dialed Number, on page 70
• Configure Dialed Numbers, on page 70
• Imports, on page 70
• Create Import Rule, on page 73
• Create a Query Rule, on page 74
• Create a Campaign, on page 75
• Notes on Editing a Campaign in Progress, on page 76
• (Optional) Configure Personal Callbacks, on page 76
• Outbound Option Scripting, on page 81
• Set Up Reservation Script, on page 82
• Send to VRU, on page 84
• Configure a Transfer to VRU Script, on page 85
• Set Up an Administrative Script, on page 87
• Sample Administrative Scripts, on page 89
• Map Scripts, Call Types, and Dialed Numbers, on page 90
• Configure Translation Route for Use with SIP Dialer, on page 91
• Multi-Tenant Customer Instances Configuration, on page 91
• SIP Dialer Recording Parameters Configuration, on page 91
• Verification of Dialed Number DN/Script Selector Configuration, on page 92
• Verify Campaign Configuration, on page 92

Outbound Option Configuration Process Overview
The process of configuring Outbound Option involves the following procedures:

• Configuring dialed numbers (DNs) for agent reservation and transferring to IVR

• Creating a skill group and a route for the campaign
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• Creating an import rule to schedule contact and do-not-call imports

• Creating a query rule to filter contact records based on SQL queries and associate those records with an
import

• Create a campaign to define campaign settings, such as the campaign name, description, answering
machine detection, personal callback settings, dial settings, query rule selections, and skill group selections

• Create call types to map the DNs to a reservation or transfer to IVR routing script

• Create reservation, transfer to IVR, and administrative scripts

The following figure provides a high-level overview of this process.

Configuration Process Task Maps
This section contains configuration process task map tables that list the steps for creating an agent campaign
and a transfer to IVR campaign.

Campaign Task List
The following table lists the steps required to create an agent campaign. An agent campaign requires an agent
reservation script. A transfer to VRU campaign does not require agent reservation.
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Table 7: Steps for Creating an Agent Campaign

Where DiscussedTaskStep Number

Create Dialed NumbersCreate a Dialed Number (DN) on the MR
client.

1

Create Dialed NumbersCreate DN for Abandon to VRU on the
MR PG for the SIP Dialer.

2

Create Dialed NumbersCreate DN for AMD to VRU on the MR
PG.

3

Create Import RuleConfigure an Import Rule.4

Create a Query RuleConfigure Query Rules.5

Create a CampaignConfigure a Campaign.6

Create a Call TypeConfigure a Call Type.7

Set Up Reservation ScriptConfigure Reservation Script.8

Configure a Transfer to VRU ScriptConfigure transfer to VRU scripts for
AMD and Abandon to VRU.

9

Map Scripts, Call Types, and Dialed
Numbers

Map Scripts to Call Types and DNs.10

Set Up Administrative ScriptConfigure Administrative Script.11

Transfer to VRU Campaign Tasks
The following table lists the steps required to create a transfer to VRU campaign, in the order that you need
to perform these steps, and the location (in this document or in another Cisco document) of the instructions
for the task.

Where DiscussedTaskStep Number

Configuration for Send to VRUCampaignConfigure Network VRU.1

Create Dialed NumbersCreate aDialedNumber (DN) for Abandon
to VRU on the MR PG.

2

Create Dialed NumbersCreate DN for AMD to VRU on the MR
PG.

3

Create Import RuleConfigure an Import Rule.4

Create a Query RuleConfigure Query Rules.5

Create a CampaignConfigure a Campaign.6

Create a Call TypeConfigure Call Type.7
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Where DiscussedTaskStep Number

Configure a Transfer to VRU ScriptConfigure transfer to VRU script.8

Map Scripts, Call Types, and Dialed
Numbers

Map Scripts to Call Types and DNs.9

Set Up Administrative ScriptConfigure Administrative Script.10

Configure Skill Group
Procedure

Step 1 In ICM Configuration Manager, open the Skill Group Explorer tool.
Step 2 Ensure that the Select filter data section displays the PIM.
Step 3 Click Retrieve.
Step 4 Click Add Skill Group.
Step 5 Set theMedia Routing Domain to Cisco_Voice.
Step 6 Enter a peripheral name and number (record them):____________________. (You can either enter a name

or allow the system to generate the name.)
Step 7 Check ICM picks the agent.
Step 8 Click Add Route.
Step 9 Enter a name for the new route (any name is allowed).
Step 10 Click Save.

Related Topics
Configure the PG, on page 40

Create a Call Type
The dialed numbers and routing scripts that you create reference call types, so you should create them as
needed. For example, you can create one call type for an agent campaign and another for a VRU campaign.
You associate the call types with the dialed numbers you create.

For more information about using call types, see Scripting and Media Routing Guide for Cisco Unified
ICM/Contact Center Enterprise

Perform the following steps to create the call type that the routing scripts you create will reference.

Procedure

Step 1 In ICM Configuration Manager, double-click the Call Type List tool.
Step 2 Click Retrieve.
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Step 3 Click Add.
Step 4 Enter the Name for the call type.
Step 5 Accept the defaults for all other fields.
Step 6 Click Save.

Create Dialed Numbers
Before you configure an Outbound Option campaign, you need to create the dialed numbers to specify for
certain fields on the Campaign Skill Group tab page. The following table lists these fields, the purpose for
the dialed number to be created, and the routing client associated with that dialed number.

Associated Routing ClientPurposeCampaign Skill Group Tab Field
Name

Configure on the MR routing
clients for each Dialer.

Dialed Number to reserve agents.
Not applicable for Transfer to VRU
campaigns.

Dialed Number

Configure on the MR Peripheral
PG.

Dialed Number for Transfer to
VRU.

After AMD and for transfer to
VRU

Configure on the MR Peripheral
PG.

Dialed Number for Transfer to
VRU.

When no agents are available

For agent campaigns, create all three dialed numbers. For transfer to VRU campaigns, create the dialed numbers
for the After AMD and for transfer to VRU field.

Perform the following steps to create these dialed numbers.

Procedure

Step 1 In ICM Configuration Manager, double-click the Dialed Number/Script Selector List tool.
Step 2 In the Routing Client drop-down menu on the left portion of the screen, select the routing client listed in the

preceding table.
Step 3 Click Retrieve.
Step 4 Click Add.
Step 5 On the Attributes tab:

a) For Routing Client, select the routing client listed in the preceding table.
b) For Media Routing Domain, select Cisco_Voice.
c) Enter values in the Dialed Number String/Script Selector and Name fields.

Step 6 Click Save.
Step 7 For Unified CCE configurations that have more than one Dialer component, repeat these steps to create the

dialed number for each media routing client.
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Create Dialed Number
Procedure

Step 1 In ICM Configuration Manager, open the Dialed Number/Script Selector List tool.
Step 2 Click Add, and then enter a dialed number for the MR PG.
Step 3 Select the MR routing client from the drop-down list.
Step 4 Select Cisco_Voice from theMedia Routing Domain drop-down list.
Step 5 Enter the dialed number.
Step 6 On the Dialed Number Mapping tab, click Add.
Step 7 In the Calling Line ID radio set, select All.
Step 8 In the Caller-entered digits radio set, select All.
Step 9 In the Call type drop-down list, select the MR call type.
Step 10 Click OK on the Dialed Number Map Entry dialog box, and then click Save.

The Personal Callback feature requires a second dialed number. This dialed number must have the
PersonalCallback dialed number string. Map all Calling Line IDs and all Caller-entered digits to the call
type for the MR routing client. Multiple dialers require multiple dialed numbers—One for each routing client
for a given skill group.

Note

Configure Dialed Numbers
Configure at least two dialed numbers on the outbound routing client: one for the agent campaign and one
for the VRU campaign. See the Cisco Packaged Contact Center Enterprise Administration and Configuration
Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
products-maintenance-guides-list.html for information about configuring dialed numbers.

Imports
This section provides procedures for creating an import rule file, creating a Do Not Call list, and adding
attributes for a contact list.

Import Procedure
Before you run an import, first create an import rule file that contains the data to be imported. This import
rule file can have a maximum of 1024 characters per row, and can be in one of three formats:

• Comma Delimited - Each column's data is separated by a comma.
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• Fixed Format - Each column has a fixed character width as specified on the Definition tab of the Import
rule tool. The number of characters in the entry for each columnmust exactly match the column definition.
If the data for a field does not fill the specified width of the column, pad the entry with spaces to the
defined character width.

• Pipe Delimited - Each column's data is separated by a pipe.

Then, to run the import, specify information about that import in the Import Rule component:

• On the General tab, specify attributes such as the Import Type (contact list or Do Not Call list), the
directory path of the import file, and the format of the import file.

• On the Definition tab, specify the import file fields that are to appear as columns in the import list. You
can specify these fields only if you are creating a contact list. The Do Not Call list import type has fixed
fields.

• On the Schedule tab, specify the time that you want the import to start and how often you want the import
to run.

When the import runs, the data is read and the import file is renamed or deleted so that it is not reimported.
This allows you to read and review the import file (if necessary) to troubleshoot problems.

Create Do Not Call List
When creating a Do_Not_Call list file, format it correctly using the following instructions.

Procedure

Step 1 Using a text editor, create a text file that contains all the do-not-call phone numbers.
Step 2 Enter a phone number for each Do Not Call entry on a new line.
Step 3 Observe the following characteristics for each Do Not Call entry:

• Each phone number can be a maximum of 20 characters long.

• The Do Not Call table can support up to 60 million entries, but note that the information is stored in
memory in the Campaign Manager process.

• Each Do Not Call entry uses 16 bytes of memory. So, 60 million entries requires approximately 1 GB
of memory on the Logger Side A platform.

Step 4 Save the text file to the local server.

The following is an example of a Do_Not_Call list:

2225554444

2225556666

2225559999

To add a customer to this list, import a Do Not Call list.
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The Campaign Manager reads from the Do_Not_Call table. Dialing List entries are marked as Do Not Call
entries only when the Campaign Manager fetches the Dialing List entry and only when there is an exact,
digit-for-digit match. This allows Do Not Call imports to happen while a Campaign is running without
rebuilding the Dialing List.

If the Dialing List includes a base number plus extension, this entry must match a Do Not Call entry for that
same base number and same extension. The dialer will not dial the extension.

Note

When the Campaign Manager starts it automatically imports from the DoNotCall.restore file that is stored in
the<drive>\icm\<instance>\la\bin directory.When reading DoNot Call import files, the CampaignManager
appends the data to the DoNotCall.restore file. This restore file allows recovery of Do Not Call records after
the CampaignManager stops unexpectedly or for plannedmaintenance, such as a Service Release installation.

The restore file can grow to approximately 1 GB if 60 million DNC records are imported, each having ten-digit
numbers plus five-digit extensions. Sufficient disk space must be available on LoggerA to store the
DoNotCall.restore file.

To clear the Do Not Call list, import a blank file with the Overwrite table option enabled.Note

Create Contact Import File
When creating a contact import file, observe the format you designed according to the database rules set up
in Import Rule Definition Tab Page.

The following example assumes that you have contact informationwithAccountNumber, FirstName, LastName,
and Phone column types.

Procedure

Step 1 Using a text editor, create a text file that contains the information for these fields.
Step 2 Enter an account number, first name, last name, and phone number for each entry on a new line.

Use either Comma Delimited, Pipe Delimited, or Fixed Format, as defined on the Import Rule General Tab
Page.

Step 3 Save the text file to the local server.

Example

The following is an example of a contact import file in the comma-delimited format:

6782,Henry,Martin,2225554444

3456,Michele,Smith,2225559999

4569,Walker,Evans,2225552000

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
72

Configuration of Campaigns and Imports
Create Contact Import File



The following is the same example in Fixed Format with the following column definitions:

• Custom - VARCHAR(4)

• FirstName - VARCHAR(10)

• LastName - VARCHAR(20)

• Phone - VARCHAR(20)

6782Henry Martin 2225554444

3456Michele Smith 2225559999

4569Walker Evans 2225552000

Add Attributes to a Contact List
To add attributes to the import, perform the following steps.

Procedure

Step 1 In ICM Configuration Manager, double-click the Outbound Option Import Rule component.
Step 2 Enter the attributes in the fields on the Import Rule Definition tab page.
Step 3 Add custom attributes using the custom selections.

These custom attributes are only useful for filtering out customer contacts into different dialing lists based on
your business needs; for example, you could define a custom entry called “Amount Owed” and add the
customer contacts that owe more into a different dialing list that can be dialed at a higher priority.

These custom attributes are not forwarded to the agent desktop.Note

Step 4 Click Save.

Create Import Rule
The Import Rule defines how Outbound Option:

• Locates the imported file and defines the name of the contact table into which the import process places
the contact information.

• Recognizes and defines the contact list data in the imported file. The Import Rule defines the import
format of the user contact list (fixed length, comma-delimited, or pipe delimited fields), and the information
to be found in the fields of the file, such as the first and last names of contacts.

• Schedules updates for your calling lists imports.

There are two types of import rules in Outbound Option:

• Contact - An import rule that you create for a specific campaign. It is possible to have a single import
rule with many contacts, and use query rules to separate those contacts into different campaigns.
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• Do Not Call - An import rule, created once and applicable to all campaigns, that provides do-not-call
information to all campaigns.

Before you create an import rule, decide where you want Outbound Option to look for the import list.

When you modify an existing import rule to add or modify a custom field in the table, change the target table
name. If you retain the same target table name, the custom field modification is not saved to the table.

Changing the target table name creates a new table, but does not remove the old table. The old table remains
in the database, but the system does not use it.

Note

When you import records, take note of the following:

• The dialing rate/CPS is affected.

• The “record fetch query performance” is also affected if you are importing huge number of records. The
performance of the query impacts the call rate. Purge the contact list manually to maintain and ensure
effective query performance.

Perform the following steps to create an import rule.

Procedure

Step 1 In Unified CCE Configuration Manager, expand the Outbound Option menu, then double-click the Outbound
Option Import Rule component.

Step 2 Click Retrieve.
Step 3 Click Add at the bottom of the list box area of the window. Then fill out the information that is required on

the following tab pages:
a) Import Rule General tab
b) Import Rule Definition tab
c) Import Rule Schedule tab

Step 4 Click Save.

If you edit an import rule, the changes that you make to that import rule take effect on the next import.Note

Create a Query Rule
The Query Rule component defines the SQL rule that the Outbound Option Import process uses to build the
dialing list for a particular campaign. Based on SQL queries to the database, the rule defines how the contact
records from the Outbound Option database are selected to be inserted in the dialing list.

Perform the following steps to create a query rule.
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Procedure

Step 1 In Unified CCEConfigurationManager, expand the Outbound Options menu, then open the Outbound Option
Query Rule component.

Step 2 Click Retrieve.
Step 3 Click Add at the bottom of the list box area of the window.
Step 4 Fill in the appropriate information on the Query Rule General tab page. See the online help for details of the

fields on this tab.
Step 5 Click Save.

Create a Campaign
Use the Outbound Option Campaign tool to define or modify the settings that apply to a campaign. You can
also add or delete a campaign through this tool.

You can define two types of campaigns: agent-based, and transfer to VRU. However, only one campaign type
can be configured per campaign.

Before you create a campaign, first configure the following information:

• A dialed number for accessing the agent reservation script

• A dialed number for transferring the call to the VRU for AMD

• A dialed number for transferring the call to the VRU for abandon treatment when no agents are available.

Perform the following steps to create a campaign.

Procedure

Step 1 In Unified CCE Configuration Manager, expand the Outbound Option menu, then open the Outbound Option
Campaign component.

Step 2 Click Retrieve.
Step 3 Click Add at the bottom of the list box area of the window.
Step 4 Fill in the fields described on the following tabs. See the online help for detailed descriptions of the fields:

a) Campaign General tab.
b) Campaign Purpose tab.
c) Query Rule Selection tab.
d) Skill Group Selection tab.
e) Call Target tab.

Step 5 Click Save.
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Modification of Maximum Number of Attempts in a Campaign
You can recall customers who were previously not reached without having to import their phone numbers
again by increasing themaximumnumber of attempts amount in theMaximumattempts field on the Campaign
General tab page This option is useful if the campaign import is an append type instead of an overwrite type.

Do not update theMaximum attempts field while the campaign is in progress. Modifying this option in the
campaign configuration results in an update of all customer records that were not successfully contacted. The
Campaign Manager can update only about 20 records per second, and no new customer records are delivered
to the dialer for this campaign while this update is in progress.

Note

You can view how many records have been closed and how many were successfully reached by using the
Call Summary Count per Campaign Real Time report. See Reports, on page 101 for more information.

Notes on Editing a Campaign in Progress
You can edit most campaign configuration settings while a campaign is running. The changes take effect with
new calls after the setting has been changed. However, do not edit the following settings while a campaign
is in progress:

• Do not modify theMaxAttempts value. Modifying this value while a campaign is in progress can cause
a long delay in record retrieval and longer agent idle times.

• Do not delete a skill group while a campaign is in progress.

(Optional) Configure Personal Callbacks
Personal Callback is an optional feature in Outbound Option. Personal Callback enables an agent to schedule
a callback to a customer for a specific date and time. A personal callback connects the agent who originally
spoke to the customer back to the customer at the customer-requested time.

This section describes how to configure your system to handle personal callbacks.When you create campaigns,
you enable the callback feature individually for each campaign.

All personal callbacks occur in Preview mode. Only one dialer on a particular peripheral is assigned personal
callback records.

Note

You configure some personal callback options through the registry. If a personal callback record is not
associated with a campaign, the record follows the rules configured within the registry.

Procedure

Step 1 In the Unified CCE Configuration Manager, select Outbound Option.
Step 2 In the Campaign tool, select the Campaign General tab.
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Step 3 Open a predefined campaign.
Step 4 Check personal callback.

Personal callback is now enabled. Next, you configure the personal callback registry entries.

Step 5 Configure a call type for personal callback.

For information about creating call types, see the administration documentation.

Step 6 Create a dialed number with the name PersonalCallback on the outbound routing client.

For information about configuring dialed numbers, see the administration documentation.

Step 7 Open regedit on the data server (DS).
Step 8 Open HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance

name>\LoggerA\BlendedAgent\CurrentVersion in the Outbound Option registry.
Step 9 Configure the personal callback registry entries listed in the following table. (Enter the values in decimal

format.)

Outbound Option enforces at runtime the minimum and maximum values in the table. The registry
does not validate the values.

Note

DescriptionDefault
Value
(integers)

Name

Calculates the callback time range, in minutes, for each
personal callback. OutboundOption queries the Personal
Callback List for callback records, where the
CallbackDateTime value is between the current time
and the CallbackTimeLimit.

15CallbackTimeLimit

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying a personal callback
to a busy number. The valid range is from 1 to 10.

1PersonalCallbackTimeToRetryBusy

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying an unanswered
personal callback. The valid range is from 5 to 60.

20PersonalCallbackTimeToRetryNoAnswer

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying to reserve an
unavailable agent. The valid range is from 1 to 10.

5PersonalCallbackTimeToRetryReservation

Sets the maximum number of times a personal callback
is attempted. The valid range is from 1 to 10. When the
maximum attempts reach 0, the record is not tried again
and the status is set to “M” (maxed out).

5PersonalCallbackMaxAttemptsDefault

The interval time, in minutes, at which the Outbound
Option Dialer checks the Campaign Manager for
personal callback records. The valid range is from 1 to
30.

5PersonalCallbackTimeToCheckForRecords
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DescriptionDefault
Value
(integers)

Name

The number of days after the personal callback was
scheduled (CallbackDateTime) to keep the record before
purging it. The valid range is from 1 to 30.

5PersonalCallbackDaysToPurgeOldRecords

The number of personal callback records to send to the
Outbound Option Dialer at one time. The valid range
is from 5 to 200.

20PersonalCallbackRecordsToCache

Indicates whether personal callbacks are allowed on
Saturdays:

• 0: Personal callbacks are not allowed on Saturdays
and are rescheduled for the next allowable day.

• 1: Personal callbacks are allowed on Saturdays.

0PersonalCallbackSaturdayAllowed

Indicates whether personal callbacks are allowed on
Sundays:

• 0: Personal callbacks are not allowed on Sundays
and are rescheduled for the next allowable day.

• 1: Personal callbacks are allowed on Sundays.

0PersonalCallbackSundayAllowed

If needed, create this registry entry.

String containing the call status types to consider when
purging old personal callback records. For example, if
the string contains “C,M,F,L,I,” all calls with these call
statuses are purged from the database. (If the registry
entry is missing, the default is assumed.)

The call status values can optionally be
delimited using a comma, a hyphen, a
semicolon, or a colon. For more information
about call status values, see the Database
SchemaHandbook for CiscoUnified Contact
Center Enterprise at https://www.cisco.com/
en/US/products/sw/custcosw/ps1844/prod_
technical_reference_list.html.

Note

C, MPersonalCallbackCallStatusToPurge

If needed, create this registry entry.

The number of times a customer phone rings before
classifying the call as an unanswered. The valid range
is from 2 to 10.

4PersonalCallbackNoAnswerRingLimit

Step 10 Create an enterprise skill group and an enterprise route.
Step 11 In Script Editor, create a routing script that sets up the Personal Callback reservation.

Include the following nodes:
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• Add a queue-to-agent node.

• Add a Wait node after the Queue to Agent node. Use a value that is less than the
TimeToWaitForMRIResponse Dialer registry setting. The default value is 600 seconds.

• End the script in a Release Node, instead of an End Node, to limit “NoDefault Label” errors in the Router
Log Viewer.

Figure 10: Personal Callback Reservation Script

Step 12 Configure the Queue to Agent node.

Related Topics
Create an Enterprise Skill Group, on page 79
Create an Enterprise Route, on page 80
Configure Queue to Agent Node, on page 80

Create an Enterprise Skill Group
To use the Personal Callback feature, create the enterprise skill group for the agent using the Enterprise Skill
Group List tool.

Procedure

Step 1 In the List tools, open the Enterprise Skill Group List tool.
Step 2 Create an enterprise skill group:

a) In the Add Name field, type the enterprise name.
b) Click Add.
c) Select the skill group, and then click Save.
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Step 3 In the Attributes tab, click Add to add the skill group or groups.
Step 4 Click Save.

Create an Enterprise Route
After you create the enterprise skill group for the agent, create an enterprise route. This route targets the
enterprise skill group.

Procedure

Step 1 In the List tools, open the Enterprise Route List tool.
Step 2 Create an enterprise route:

a) In the Name field, type the enterprise route.
b) Click Add.
c) Select the route, and click Save.

Step 3 In the Attributes tab, add the route.
Step 4 Click Save.

Configure Queue to Agent Node

Procedure

Step 1 In Script Editor, double-click the Queue to Agent node.
Step 2 Press Change in the Queue to agent type section.
Step 3 Click Lookup agent reference by expression, then click OK.
Step 4 In the Agent Expression column, enter Call.PreferredAgentID.
Step 5 Select the enterprise skill group.
Step 6 Select the enterprise route.
Step 7 Confirm that the Peripheral column is left blank.
Step 8 Click OK to save the Queue to Agent node.
Step 9 Save and then schedule the script. When scheduling the script, use the call type that is configured for personal

callback.

Related Topics
Create an Enterprise Route, on page 80
Create an Enterprise Skill Group, on page 79
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Outbound Option Scripting
Outbound Option uses Unified CCE scripting configured on the Administrative Workstation to manage
campaigns.

There are two types of scripts:

• Administrative Scripts

• Agent Reservation Routing Scripts

Administrative Scripts for Outbound Option
Outbound Option administrative scripts enable, disable, or throttle campaign skill groups for outbound
campaigns. The scripts can also automatically close out a skill group for a specific campaign. The administrative
scripts can use time or any other conditional factor that the script can access to close a skill group. You can
perform this scripting at the skill group level to provide more flexibility for managing larger campaigns with
multiple skill groups.

Enable a campaign skill group by setting the campaign mode to one of the available modes: Preview, Direct
Preview, Progressive, or Predictive. Schedule an administrative script to run at regular intervals. Disable the
campaign skill group in the administrative script by creating a script node to change the campaign mode to
inbound for that skill group.

An administrative script controls a campaign skill group. You can only map a campaign skill group to one
campaign at a time. Multiple administrative scripts controlling the same skill group can result in conflicting
campaign mode requests.

Both the Outbound API and administrative scripts can set the dialing mode for a campaign. The value set by
the administrative script takes precedence over the value set by the API.

Note

You can also use administrative scripts to control the percentage of agents that a campaign skill group can
use. A script can also set whether to use a skill group for other campaigns or inbound calls.

To allow the outbound control and percent configured values from Campaign Skill group (set by either the
ConfigurationManager Campaign Skill Group tab or the Campaign API) to apply without restarting the router.
If you use an administrative script to set the outbound control and percent variables in operation and if you
want to employ these configured value on the Campaign Skillgroup, set the outbound control and percent
variable to -1 in the administrative script accordingly.

Note

Related Topics
Dialing Modes, on page 5
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Routing Scripts for Outbound Option
Two types of routing scripts are described later in this document. One is for Agent Campaign and one is for
VRU Campaign.

The Dialer uses Reservation scripts to reserve agents for specific outbound campaigns and personal callbacks.
With this type of script, the Dialer makes a route request through its Media Routing Client using the configured
dialed number for the campaign skill group. Each campaign has its own dialed number and reservation scripting.
If an agent is not available, the default behavior is for the script to end the call and the Dialer receives an error.
The Dialer retries the reservation request when it sees available agents in the skill group statistics as described
in the Dialer description earlier in this chapter. You can queue reservation calls which have scripts that
distribute agents across campaigns when those agents are skilled for multiple, active campaigns.

A call can be transferred to a VRU as part of a transfer to VRU campaign, or transferred to non-VRU campaigns
for answering machine or abandons. A transfer to VRU campaign places a route request call to a CTI Route
Point dialed number on the Agent PG. This enables the campaign to transfer the call context of the customer
call to the VRU. You can add incoming call context to the call while the VRU treats the call.

Set Up Reservation Script
Use the Script Editor application to create a reservation script that uses the dialed number for the Outbound
Routing Type and routes through one of the following methods:

• Using a Select node to the previously configured skill group.

• Using Dynamic Route Target by ID in the Skill Group node.

Script for Agent Campaign
The following steps and accompanying diagrams provide an example of how to create a script for an agent
campaign.

Procedure

Using the Call Type Manager in Script Editor, associate the MR (and Personal Callback, if used) dialed
numbers with the configured call type and newly created reservation script.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
82

Configuration of Campaigns and Imports
Routing Scripts for Outbound Option



Figure 11: Sample Script for Agent Campaign Without Personal Callback (Using Select Node)

Figure 12: Sample Script for Agent Campaign Without Personal Callback (Using Dynamic Route Target by ID)

Related Topics
(Optional) Configure Personal Callbacks, on page 76
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Send to VRU
You can use the Send to VRU node in a routing script for a VRU campaign. The following example illustrates
creating a script for a VRU campaign for a Type 10 .

Procedure

Step 1 Use the Dialed Number tool to associate the MR dialed numbers with the configured call type.
Step 2 Use the Script Editor Call TypeManager to associate the call type with the newly created reservation script.

See the Script Editor online help for information about using the Script Editor application.Note
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Configure a Transfer to VRU Script

You must have a translation route configured before you start this procedure. See the Cisco Unified Contact
Center Enterprise Installation and Upgrade Guide for instructions.

Note

Perform the following steps to configure a Transfer to VRU script for Outbound Option campaigns.

Procedure

Step 1 Use the Script Editor to create a Transfer to VRU script that includes Translation Route to VRU, Queue to
Skill Group, Run Ext. Script, and Set Variable nodes. The following diagram illustrates an example.
Figure 13: Sample CVP Routing Script
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• The Transfer to VRU feature requires that a translation route to a skill group must be specified
in a Transfer to VRU script. It also requires that the translation route must point at a Queue to
Skill node.

• See the Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise
for task-based information about using Script Editor. See the Script Editor online help for
detailed information about the Script Editor options.

Note

Step 2 To implement answering machine detection as part of this transfer to VRU script, include an IF node that
evaluates the value of the BAResponse variable and prescribes a call treatment depending on the CPA result
of the call (whether the call detected voice or an answering machine).

The following is an example of such an If node.
Figure 14: BAResponse If Node

Step 3 Create a VRU script. (Be aware that this script is different from a reservation script.) The VRU script contains
a list of commands that tell the VRU what type of information to play to the customer, such as a prerecorded
message using a .wav file. The VRU script can also collect survey information by requesting the customer
press specific numbers. Consult your Unified CVP, IP/IVR, or documentation for your other third-party VRU
for more information.
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Step 4 Associate the reservation script with the call type and dialed number configured for the campaign.

Set Up an Administrative Script
Use the Script Editor application to create an administrative script for each skill group to set the
OutboundControl variable and the skill group reservation percentage. The Outbound Option Dialer uses the
value of this variable to determine which mode each skill group uses.

• If the script does not set the OutboundControl variable, the skill group defaults to inbound.

• Make sure that the routing client for the translation route labels is Unified CM, whichmakes the outgoing
call.

Note

Perform the following steps to create the administrative script:

Procedure

Step 1 Open the Script Editor application.
Step 2 Select File > New > Administrative Script.
Step 3 Create an administrative script.

You can use one script to control all Outbound Option skill groups or multiple scripts to control multiple
Outbound Option skill groups. If you want to control skill groups at different times of the day, you need
multiple administrative scripts. But, if you are going to initialize the groups all in the same way, you need
only one script with multiple Set nodes.

Step 4 Set up the script with the following required nodes: Start, Set Variable, and End.

The following diagram displays a simple administrative script that sets both the OutboundControl variable
and the outbound percentage for a skill group. A script in a production call center is typically more complex,
perhaps changing these variables due to time of day or service level.
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Figure 15: Sample Administrative Script

A transfer to VRU requires an IF node in the administrative script to disable it if the VRU is not
available. Also, to ensure timely responses to VRU outages, set the administrative script to run
every minute. When using the System PG, use this node to ensure that the trunks are not set to idle;
for example, “NetworkTrunkGroup.IPCC_Component_Interface_PG_NTG.TrunksIdle>0.”

Note

Step 5 Set the OutboundControl variable. Setting this variable enables contact center managers to control the agent
mode. Set this variable to one of the values listed in the following table.

Table 8: OutboundControl Variable Values

DescriptionValue String

Agents take inbound calls only. The skill group cannot do Outbound
Option dialing.

INBOUND

Agents in the skill group only take outbound Predictive calls.PREDICTIVE_ONLY

Agents in the skill group only take outbound Preview calls.PREVIEW_ONLY

Agents in the skill group only take outbound Progressive calls.PROGRESSIVE_ONLY

Agents only place outbound calls and hear ringtones, such as phone
ringing or busy signal.

PREVIEW_DIRECT_ONLY
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DescriptionValue String

Agents in the skill group can take inbound calls and also take calls for
a predictive campaign.

PREDICTIVE_BLENDED

Agents in the skill group can take inbound calls and also take calls for
a preview campaign.

PREVIEW_BLENDED

Agents in the skill group can take inbound calls and also take calls for
a progressive campaign.

PROGRESSIVE_BLENDED

Agents in the skill group can take inbound calls and also take calls for
a preview direct campaign.

PREVIEW_DIRECT_BLENDED

If you remove a Set node from the administrative script, the OutboundControl variable maintains
the value from the last time that the script executed. However, when the Central Controller restarts,
the value resets to INBOUND.

Note

Step 6 Set the OutboundPercent variable in the same administrative script. Select the OutboundPercent variable in
the Set Properties window and enter the agent percentage in the Value field. This variable controls the
percentage of active agents in the skill group to use for Outbound Option dialing. For example, for an
OutboundPercent of 50%with 100 active agents in the skill group, the system allocates 50 agents for Outbound
Option dialing. You can use the rest of the agents for inbound or other active campaigns.

• The OutboundPercent variable also applies to Transfer To VRU campaigns, by controlling the
percentage of VRU Ports that are considered for the campaign skill group.

• This variable does not allocate specific agents for Outbound Option dialing, just a total
percentage. The default is 0%.

Note

Step 7 Schedule the script.
a) Select Script > Administrative Manager. An Administrative Manager dialog box appears.
b) Click Add.
c) On the Script tab, select the administrative script.
d) On the Period tab, specify the run frequency of the script. (Guideline for frequency is every minute of

every day.)
e) Optionally, enter a description on the Description tab.
f) Click OK to close the Add Administrative Schedule dialog box.
g) Click OK to close the Administrative Manager.

Sample Administrative Scripts
The following section describes a sample administrative script.
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Administrative Script: TimeBasedControl
The following figure is a simple example of setting skill group modes for maximizing the resource utilization
in a call center based on time of day.
Figure 16: TimeBasedControl Script

This script divides the day into three parts:

• Peak Inbound Traffic Period (8:00 AM to 12:00 PM): During this time, the skill group variable is set
to INBOUND only, because more agents are required to handle inbound calls.

• Off-Peak Traffic Period (2:00PM to 4:00PM): During this time, the skill group variable is set to
PREVIEW_BLENDED, so that when an agent is not on an inbound call, Outbound Option presents the
agent with Preview calls. While the agent is reviewing the calls and when the agent is on a Preview
outbound call, Unified ICM software does not route an inbound call to that agent. As soon as the agent
is finished with the Preview call, Unified ICM software routes an inbound call to the agent. If there are
no inbound calls, Outbound Option reserves the agent for another outbound call.

• All Other Periods: For the rest of the day, the skill group variable is set to PREDICTIVE_ONLY so
that if any agents are logged-in, Outbound Option immediately reserves the agents for outbound calls.

Map Scripts, Call Types, and Dialed Numbers
After you create a reservation script, associate that script with the call type and dialed number configured for
the campaign. To make the association, perform the following steps.
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Procedure

Step 1 In Script Editor, open the script.
Step 2 Select Script > Call Type Manager. A Call Type Manager dialog opens.
Step 3 On the Schedules tab, select the call type from the Call Type drop-down list.
Step 4 Click Add. A Call Type Schedule dialog opens.
Step 5 Select the script and click OK.
Step 6 Click OK to save your changes and close the Call Type Manager.

Configure Translation Route for Use with SIP Dialer
Configure the translation route for the transfer-to-IVR campaign or the agent campaign to transfer a connected
outbound call with ECC call variables from the SIP Dialer to a VRU Peripheral.

You need configure the network VRU as Type 2 for IP IVR, or as Type 10 for CVP.

For more information about configuring the translation routes, see the Translation Route Wizard online help
and Configuration Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/
us/support/customer-collaboration/unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html.

Multi-Tenant Customer Instances Configuration
Outbound Option Multi-Tenant is no longer supported beginning with Release 9.0(1).

SIP Dialer Recording Parameters Configuration
When recording is enabled in a campaign on the SIP dialer, the number of recording files that result can be
large. The following table lists registry settings that you can adjust to regulate the number of recording sessions
and the maximum recording file size.

DescriptionDefault SettingRegistry Setting

The maximum recording file size (in bytes) of all
recording files. per SIP Dialer.

500,000,000MaxAllRecordFiles

The maximum number of media termination sessions
per SIP Dialer if recording is enabled in the Campaign
configuration.

200MaxMediaTerminationSessions

The maximum recording file size (in bytes) that the
SIP Dialer deletes when the total recording file size,
MaxAllRecordFiles, is reached.

100,000,000MaxPurgeRecordFiles
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DescriptionDefault SettingRegistry Setting

The maximum number of recording sessions per SIP
Dialer if recording is enabled in the Campaign
configuration.

100MaxRecordingSessions

Recording files are in the HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<customer instance>\Dialer directory.

Only the G.711 codec is supported for recording. To record outbound calls, configure the G.711 on the voice
gateway.

Note

Verification ofDialedNumberDN/Script Selector Configuration
Outbound Option places agents in the Reserved state before using them for an outbound call. The dialer uses
the dialed number to route to an agent. The following procedure describes how to verify that this mechanism
works properly.

Verify DN/Script Selector Configuration
When anOutboundOption Dialer is installed in a Unified CCE environment, the dialer uses the dialed number
to make routing requests through the Media Routing (MR) Peripheral Gateway. The following verification
steps assume that you have completed all the applicable configuration and reservation script generation.

Procedure

Step 1 Log in an agent to a skill group participating in an outbound campaign, and make the agent available. (Note
the dialed number, which was configured in the Skill Group Selection tab in the Campaign component.) If a
different dialed number is used for predictive and preview calls, make sure to verify both dialed numbers.

Step 2 Run the Script Editor application and select the Call Tracer utility from the Script > Call Tracer menu.
Select the routing client that is associated with the MR PG and select the Dialed Number.

Step 3 Press Send Call to simulate a route request and note the results. If a label was returned for the agent who was
logged in above, the reservation script is working properly and the dialer can reserve agents through this script.

Verify Campaign Configuration
As a final step to verify that you configured your Outbound Option campaign correctly, create a small campaign
of one or two entries that dial work phones or your mobile phone.
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C H A P T E R 6
Administrative and Supervisory Tasks

• Agent Management, on page 93
• Campaign Management, on page 94
• SIP Dialer Voice Gateway Over-capacity Errors, on page 99
• Update the North American Numbering Plan Data , on page 100
• Reports, on page 101

Agent Management
In addition to reviewing the following sections, note that the following table lists agent tasks and their
documentation references.

Where Discussed/NotesTask

Cisco Unified Contact Center Enterprise Installation and Upgrade GuideAdding agents

Cisco Unified Contact Center Enterprise Installation and Upgrade Guide;
assign the agent only to campaign skill groups

Dedicating agent to Outbound
Option campaigns

CCE Web Administration Application Online HelpRe-skilling agents

Agent Addition
You assign agents to skill groups to map them to campaigns and to skill the agents for multiple active
campaigns.

An agent can be assigned to multiple campaigns.Note

Related Topics
Agents Skilled for Multiple Active Campaigns, on page 16
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Agents Dedicated to Only Outbound Option Campaigns
There is no setting to restrict a particular agent to only Outbound Option campaigns. If you want to dedicate
a particular agent, associate the agent only with Outbound Option campaign skill groups.

Agent Re-skilling
The Unified CCE Web Administration application allows supervisors to sign-in and change the skill groups
for agents they manage. CCE Web Administration is a browser-based application for use by call-center
supervisors. You can change the skill group designations of agents on your team and quickly view skill group
members and details about individual agents. Changes you make to an agent’s skill group membership take
place immediately without the need for the agent to exit and re-enter the system.

See the CCE Web Administration Application online help for information about using the agent re-skilling
feature.

See the Administration Guide for Cisco Unified Contact Center Enterprise for detailed instructions on how
to re-skill agents.

Campaign Management
To manage your campaigns most efficiently, use multiple query rules instead of using multiple campaigns.

Single Campaign Versus Multiple Campaigns
You might choose to run multiple campaigns because of different calling policies (for example, time rules)
or to run different outbound modes simultaneously.

From the perspective of dialer port allocation, running fewer campaigns with a larger agent pool is more
efficient. Dialer ports are allocated based on the number of agents assigned and the current number of lines
per agent to dial. The more campaigns you have that are active, the more the ports are distributed across the
campaigns, which affects overall efficiency.

Use query rules to break down a campaign into smaller requirements. These rules can be enabled based on
penetration or scheduled times. Campaign reports are available on a query rule level.

In multiple campaigns, the skill groups of agents handling the calls must be the same as those of a single
campaign.

Note

Results from Individual Customers
After running a campaign, you can generate a list of customers who were reached, not reached, or have invalid
phone numbers.

The following are options for how to receive this information from the Outbound Option solution.
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Interpret Information from Dialer_Detail Table
The Dialer_Detail table is a single table that contains the customer call results for all campaigns. When you
view the Dialer_Detail table, note that each attempted Outbound Option call is recorded as an entry in the
table. Each entry lists the number called and which numbers are invalid.

For more information, see the appendix on the Dialer Detail Table.

Dialing List
You can also review the Dialing List in the Campaign Manager’s private database on the Logger Side A for
customer call information. However, using this source has several drawbacks when compared to the
Dialer_Detail table:

• You must avoid querying this table while campaigns are in progress. Excessive activity on this table
slows the performance of the real-time processes running on Logger Side A, particularly the Campaign
Manager. This can lead to interruptions in dialing and long idle times for agents.

• There is a different dialing list table for every campaign query rule. You must look in multiple locations
as opposed to looking in the one Dialer_Detail table.

Use the Dialer_Detail table for customer call information whenever possible.

Management of Campaign Manager Database Tables
The CampaignManager tables, Dialing_List and Personal_Callback_List can grow to be large. If the database
size grows too large, CampaignManager performance can significantly slow. To limit the size of the Outbound
Option database, a stored procedure is run daily at midnight to purge records that are no longer needed.

By default, records are removed from the Personal_Callback_List table when the record's CallStatus is C or
M, and the CallbackDateTime for the record is more than 5 days old. In the Dialing_List table, records are
removed by default when CallStatusZone1 has a value of C or M, and ImportRuleDate is more than 5 days
old.

You can change the status and age of the records to be removed, by modifying Campaign Manager registry
values on the Logger machine. The registry settings are located in
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\LoggerA\BlendedAgent\CurrentVersion in the Outbound Option registry.

• To specify the records to remove from the Personal_Callback_List table, set
PersonalCallbackCallStatusToPurge and PersonalCallbackDaysToPurgeOldRecords.

PersonalCallbackCallStatusToPurge is not added by default. To change the
call status of the records to remove, create this registry setting manually.

Note

• To specify the records to remove from the Dialing_List table, set DialingListCallStatusToPurge and
DialingListDaysToPurgeOldRecords.

DialingListCallStatusToPurgeis not added by default. To change the call status
of the records to remove, create this registry setting manually.

Note
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To specify the age of the records to be removed, set PersonalCallbackDaysToPurgeOldRecords or
DialingListDaysToPurgeOldRecords to the number of days to keep the record before it is removed. For the
Personal Callback list, this value is the number of days after the personal callback is scheduled
(CallbackDateTime). For the Dialing List, this value is the number of days after the record is imported
(ImportRuleDate). The default is 5. The valid range is 1 to 30. If the value is not set or set to 0, the automated
purge is disabled.

To set the call status of the records to be removed, set PersonalCallbackCallStatusToPurge or
DialingListCallStatusToPurge to a string containing the call status types to apply when purging personal
callback or dialing list records. For example, if the string contains “C,M,F,L,I,” all records with these call
statuses, that are also older than the number of days specified by PersonalCallbackDaysToPurgeOldRecords
or DialingListDaysToPurgeOldRecords, are removed from the database.

You can specify the following call status values:

DescriptionValue

UnknownU

FaxF

Invalid NumberI

OperatorO

Not AllocatedL

Agent Not AvailableX

ClosedC

Max CallsM

Management of Predictive Campaigns
The following sections provide guidelines to follow when working with predictive campaigns.

Initial Values for Lines per Agent
Determining the initial value for the number of lines per agent is not as simple as inverting the hit rate. If a
campaign has a 20% hit rate, you cannot assume that five lines per agent is the applicable initial value for the
campaign if you are targeting a 3% abandon rate. The opportunity for abandoned calls increases geometrically
as the lines per agent increases; therefore, set the initial value conservatively in the campaign configuration.

If the reports show that the abandon rate is below target and does not come back in line very quickly, modify
the initial value in the campaign configuration to immediately correct the lines per agent being dialed.

End-of-Day Calculation for Abandon Rate
It is not unusual for a campaign to be over the abandon rate target for any given 30 minute period. The dialer
examines the end-of-day rate when managing the abandon rate. If the overall abandon rate is over target for
the day, the system targets a lower abandon rate for remaining calls until the average abandon rate falls into
line. This end-of-day calculation cannot work until after the campaign has been running for one hour. Small
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sample sizes due to short campaigns or campaigns with fewer agents might not give the dialer enough time
to recover from an initial value that is too high.

Similarly, if the campaign is significantly under the target abandon rate, it might begin dialingmore frequently
with an abandon rate over target for a while to compensate in the abandon rate.

Transfer of Answering Machine Detection Calls to Agents
When enabling the Transfer AMD (Answering Machine Detection) to agent option for an agent campaign or
enabling the Transfer AMD to IVR option for an IVR campaign, consider the increase in calls to the target
resources (agents or IVR) when determining the initial value. If the expectation is that the AMD rate and the
live voice rate are over 50%, perhaps start out with an initial value of 1.1 or even one line per agent to stay
under a 3% abandon rate.

Parameter Tuning
The Voice Calls Per Adjustment and Gain parameters are settings in the Advanced Users configuration tab
used to control the way the predictive dialing behaves. Do not modify the default values unless you understand
the parameters and the possible risks incurred when changing the pacing.

• The Voice Calls Per Adjustment parameter is a count of the number of live voice connections that are
required to trigger a correction. (The default value is 70 voice calls.) If the abandon rate exceeds the
target by a significant margin, the dialer can make corrections before collecting 70 calls.

• The Gain parameter controls the size of the Lines per agent corrections.

Setting the Voice Calls Per Adjustment parameter to a smaller setting leads to larger fluctuations in the
measured Abandon Rate because the sample size is less significant. This results in less change in the Lines
per agent value over time.

Be careful when modifying both parameters (Gain and Voice Calls Per Adjustment) at the same time. For
example, increasing the Gain while decreasing the Voice Calls Per Adjustment results in larger changes in
the “Lines per agent correction rate,” which might overcorrect changes in measured values.

Decreasing the Gain while increasing the Voice Calls Per Adjustment can similarly cause too slow of a change
to underlying changes in the hit-and-abandon-rates. A campaign that is reaching more than 20 live voice
customers every minute (600 per half hour) might benefit from reducing the Gain, but a lower Gain becomes
less effective as the number of agents in the campaign dwindles or the hit rate changes rapidly.

Caution

Management of Agent Idle Time
One of the key reporting metrics for administrators managing campaigns is the amount of time agents spend
idle between calls.

There are many possible reasons for longer idle times, such as a combination of one or more of the following:

• A dialing list with a low hit rate. The solution is to create an improved list.

• A small agent pool results in fewer calls, resulting in slower adjustments. One solution is to add more
agents to the pool.

• Shorter average handle times means agents become available more frequently. A shorter handle time
means that the agent idle time percentage will climb.
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• Not enough dialer ports deployed or too many agents. Deploy more ports or use fewer agents.

• A large number of retry attempts at the beginning of a day when running with append imports resulting
in lower hit rates. Prioritize pending over retries.

• Modifying the maximum number of attempts up or down in an active campaign. This activity can interrupt
the Campaign Manager’s processing of dialer requests for records, as mentioned earlier in this chapter.
One solution is to perform the activity during off hours.

• Running out of records to dial. Import new records.

Sources of Higher Idle Times in Reports
The following Outbound Option reports provide information regarding sources of higher idle times:

• Campaign Consolidated Reports: These reports provide a very useful overview of a campaign by
combining campaign and agent skill group statistics into a single report. They provide average idle time,
campaign hit rate, the number of agents working on the campaign, as well as their Average Handle Time
per call. Low hit rates and low average handle times result in more work for the dialer to keep those
agents busy.

• Dialer Capacity Reports: These reports show how busy the dialers are and how much time was spent at
full capacity when the dialer was out of ports. They also provide the average reservation call time as well
as the average time each dialer port spent contacting customers.

Dialer Saturation
If both Dialers have relatively low idle times and high all ports busy times, then it is likely the Dialers have
been oversubscribed. The combination of number of agents, Dialing List hit rate, and average handle time are
likely more than the deployed number of ports the Dialer can handle.

To solve this problem, perform one of the following actions:

• Reduce the number of agents working on the campaign.

• Move a campaign to a skill group on another agent PG.

• Add more Dialer ports to the solution, possibly on another agent PG.

Few Available Records
Call Summary Count reports show howmany records in the aggregate campaign dialing lists have been closed
and how many are still available to dial.

Retry Records in Append Campaigns
Running campaigns with an append import and maximum number of attempts greater than one can result in
a large number of retries at the beginning of the next day. As a general rule, retries usually have a lower hit
rate than pending records. Longer idle times for agents might result until the first group of retries are called
because retry records normally have priority over pending records by default. The number of records increase
as you increase the retry time.

There are a few ways to manage this situation:

• Shorten the retry times to reduce the number of retries that are scheduled at the end of the day.
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• Change the Campaign Manager priority scheme so all numbers and records are tried once before any
retries are attempted. Set the PendingOverRetryEnabled registry key to 1 in the Campaign Manager.

See the appendix on Registry settings for detailed information about the
PendingOverRetryEnabled registry setting.

Note

• Modify the campaign import to use theOverwrite option instead of the Append option and import new
records daily.

SIP Dialer Voice Gateway Over-capacity Errors
Your network monitoring tool might receive an alarm from the SIP dialer about being over capacity. You can
ignore the alarm unless it becomes an ongoing issue. This section describes the source of the alarm and
remedial actions.

If the Voice Gateway in a SIP dialer implementation is over dialed or over capacity, the SIP Dialer receives
one of the following messages: .

• SIP 503 messages if the SIP Dialer is deployed with Voice Gateway only

• SIP 502 messages if the SIP Dialer is deployed with SIP Proxy

The SIP dialer raises an alarmwhen the percentage of SIP 502 or SIP 503messages reaches 1% of all messages.

If Voice Gateway capacity becomes an ongoing issue, use one of the following measures to attempt to remedy
the problem:

• Check the Voice Gateway configuration. If there are errors, fix them and reset Port Throttle to its original
value. Port Throttle, the calls-per-second rate at which the dialer dials outbound calls, is set on the Dialer
General tab in the Configuration Manager.

• Check the sizing information. Adjust the value of Port Throttle according to the documented guidelines.

• Enable the auto-throttle mechanism by setting the Dialer registry setting EnableThrottleDown to 1.

To set EnableThrottleDown, open the Registry Editor (regedit.exe) on the PG machine and navigate
to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customerinstance>\Dialer .

When the auto-throttle mechanism is enabled, the SIP dialer performs an automatic throttle down when the
percentage of SIP 502 or SIP 503 messages reaches 2% of all messages,. This throttle down means that the
SIP dialer decreases the configured value of Port Throttle by approximately 10%.

If one throttle down does not correct the problem, the SIP dialer performs additional throttle downs until either
the problem is corrected or the value of Port Throttle is throttled down to 50% of the originally configured
value.

For each automatic throttle down, alarm and trace messages clearly provide detailed information about the
adjusted port throttle value, the configured port throttle value, and time duration.
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Update the North American Numbering Plan Data
The Regional Prefix Update Tool (RPUT) is used to update the Unified CCE database to the latest North
American Local Exchange NPA NXX Database (NALENND).

• If Unified CCE ICM is using the North American Numbering Plan.

• On an Administration & Data Server that includes Real-time Data Server as part of its role.

The RPUT is composed of the following two files (installed in the ICM\bin directory on the data server):

• region_prefix_data.txt (or the <DatafileName>)

Contains the data this tool uses to update the region prefix table in the Unified CCE database. Note that
you should change paths to the ICM\bin directory.

• regionfix.exe

This executable reads the region_prefix_data.txt data file and updates the region prefix table.

The RPUT is run from the command line as described in the following procedure.

Procedure

Step 1 Open a command prompt (Select Start > Run, and enter cmd, then click OK).
Step 2 Change the path to ICM\bin.
Step 3 Enter the following at the prompt: regionfix.exe <DatafileName> (where <DatafileName> is the name of

the data file).

The Regional Prefix Update Tool then shows the version of the input data file and asks if you want to proceed.
If you proceed, the tool connects to the Unified CCE database. The number of records that are to be updated,
deleted, and inserted appear. These records are put into three different files:

• region_prefix_update.txt (which includes preserved Custom Region Prefixes)

• region_prefix_new.txt

• region_prefix_delete.txt

Step 4 You can either delete or retain the entries present in the region_prefix_delete.txt file while performing the
insertions and updates. To retain the entries, type No when the tool prompts you to delete the entries. Type
Yes to delete the entries.

Step 5 Check the contents of the files before proceeding.
Step 6 Answer Yes to proceed with the update.

When the update is complete, the tool displays the following message:

Your region prefix table has been successfully updated.
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Reports
This section provides an overview of the Outbound Option reports available in the Cisco Unified Intelligence
Center.

For complete information about using Unified Intelligence Center, how to download and import report bundles,
and detailed descriptions of the templates for the reports mentioned here, see Cisco Unified Contact Center
Enterprise Reporting User Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-user-guide-list.html.

Outbound Option Reports
This section describes the Outbound Option reports, created using the Unified Intelligence Center.

• Outbound Historical Reports Bundle, on page 101

• Outbound Realtime Reports Bundle, on page 102

• Agent Reports, on page 103

• Campaign and Dialer Reports, on page 104

• Skill Group Reports, on page 106

• Import Rule Reports, on page 106

• Dialer Reports, on page 105

All Outbound Option reports are voice-only reports and can be used in Unified CCE environments.Note

The Outbound Option reports are distributed in two report bundles: Realtime Outbound and Historical
Outbound. The report bundles are available as downloads fromCisco.com https://software.cisco.com/download/
type.html?mdfid=282163829&catid=null. Click the Intelligence Center Reports link to view the available
report bundles. Depending on how it was deployed, your installation of Unified Intelligence Center may
include all or a subset of these reports.

Additionally, sample custom report templates are available from the Cisco Developer Network
(https://developer.cisco.com/web/ccr/documentation.)

For information on importing report bundles or custom reports to the Cisco Unified Intelligence Center, see
Cisco Unified Contact Center Enterprise Installation and Upgrade Guide .

Call Type reporting can be used on Outbound Option reservation calls and transfer to VRU calls. Call Type
reporting is not applicable for outbound customer calls because a routing script is not used.

Note

Outbound Historical Reports Bundle
The Outbound Options Historical reports receive data from the historical data source. Reports are populated
with interval data that has a default refresh rate of 15 minutes.
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Half-hour/Daily: Provides statistics for each half-hour period. Many of the half-hour reports are also available
in a daily report format.

The Outbound Historical bundle contains the following reports:

DescriptionReport

Shows the status (summary and percentage) of each
campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Attempts per Campaign Daily

Shows the daily activity and performance of the
selected campaigns and their skill groups for the
selected time period and provides analysis of the
actual customer calls (outbound calls which reached
live voice, inbound calls, or calls transferred to the
campaign's skill group) for the selected campaigns
and their skill groups for the selected time period.

Campaign Consolidated Daily

Shows the list of Consolidated Calls and Agent
Statistics per Campaign by Half Hour and Breakdown
of completed calls.

Campaign Consolidated Half Hour

Shows the status for all campaigns for the selected
time period, the status (summary and percentage) of
each campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Campaign Half Hour Summary

Shows the status of each dialer for the selected time
period.

Dialer Call Result Summary Half Hour

Dialer Capacity Daily

Dialer Capacity Half Hour

Shows the status of imported records for the selected
time period.

Import Rule

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period and the
status (summary and percentage) of each campaign
for the selected time period.

Query Rule Within Campaign Daily

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period, the status
(summary and percentage) of each campaign for the
selected time period and the status for each Query rule
within a campaign for the selected time interval.

Query Rule Within Campaign Half Hour

Outbound Realtime Reports Bundle
The Outbound Option Real Time reports display current information about a system entity; for example, the
number of tasks an agent is currently working on or the number of agents currently logged in to a skill group.

Outbound Option Guide for Unified Contact Center Enterprise, Release 11.5(1)
102

Administrative and Supervisory Tasks
Outbound Realtime Reports Bundle



By default, the reports automatically query the Admin Workstation database on the distributor every 15
seconds. The data is written to the database by the Router almost every 10 seconds.

The Outbound Real Time Reports Bundle contains the following reports:

DescriptionReport

Shows the status of each query rule within a campaign,
status of all campaign records, and the currently valid
campaign dialing times.

Call Summary Count per Campaign Real Time

Shows the status of each dialer, including the number
of contacts dialed today and the result of each attempt.

Dialer Real Time

Shows the status of Outbound Option import records.Import Status Real Time

Shows the status of all campaign records, dialing
times, and query rule within a campaign.

Query Rule Within Campaign Real Time

Agent Reports
In addition to the reports contained in the Outbound Reports bundles, other Agent reports also provide
information about Outbound activities:

Outbound Option FieldsReport

The Direction field indicates the direction of the call
that the agent is currently working on including Other
Out/Outbound Direct Preview, Outbound Reserve,
Outbound Preview, or Outbound
Predictive/Progressive.

The Destination field indicates the type of outbound
task on which the agent is currently working.

Agent Queue Real Time

Agent Real Time

Agent Skill Group Real Time

Agent Team Real Time

The Active Out field shows the number of agents
currently working on outbound tasks.

Agent Team State Counts

For agents handling Outbound Option calls, theHold
state indicates that the agent has been reserved for a
call. TheOutboundDialer puts the agent on hold while
connecting the call.

Agent State Real Time Graph

Interpreting agent data for Outbound Option tasks, requires understanding how Outbound Option reserves
agents, reports calls that are connected to agents, and handles calls dropped by customers before the calls are
connected.

Outbound Option is automatically enabled at setup. It provides automatic outbound dialing capability.

The Outbound Option Dialer assigns and connects calls differently than regular contact center enterprise
routing. Report data for agents handling Outbound Option calls therefore differs from data for agents handling
typical voice calls and multichannel tasks.

When the Outbound Dialer calls a customer, it reserves the agent to handle the call. The Dialer places a
reservation call to the agent and changes the agent's state to Hold. This reservation call is reported as a Direct
In call to the agent.
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For typical calls, the agent is placed into Reserved state when the contact center reserves the agent to handle
a call. For Outbound Option calls, reports show the agent in Hold state when reserved for a call and the time
that agent spends reserved is reported as Hold Time.

When the customer answers the call, the Outbound Option Dialer transfers the call to an agent. The call is
now reported as a Transfer In call to the agent. When the customer call is transferred to the agent, the Dialer
drops the reservation call and classifies it as Abandon on Hold.

The abandoned call wait time, set in the Campaign Configuration screen, determines how calls are reported
if the caller hangs up. Calls are counted in the Customer Abandon field in both Real Time and Historical
campaign query templates only if the customer hangs up before the abandoned call wait time is reached.

For agent reporting per campaign, Outbound Option provides reports that accurately represent the Outbound
Option agent activity for a contact center, including information grouped by skill group.

The following list describes the data presented in the agent reports.

• A real-time table that shows Outbound Option agent activity related to Outbound Option calls.

• A historical table that shows agent daily performance for Outbound Option predictive calls, by skill
group.

• A historical table that shows agent daily performance for Outbound Option preview calls, by skill group.

• A historical table that shows agent daily performance for Outbound Option reservation calls, by skill
group.

Campaign and Dialer Reports
Outbound Option provides a campaign report template that describes the effectiveness of a campaign and the
dialer. This list can be used for Agent and VRU campaigns.

Observe the following guidelines when using the campaign reports:

• Campaign Real Time reports describe how many records are left in the campaign dialing list.

• Both Campaign and Dialer Half Hour reports provide the call result counts.

• Dialer utilization fields in the Dialer Half Hour report are unaffected, although the Half Hour record
might be missing if the CampaignManager was inactive during the half-hour boundary. When the Dialer
restarts, only the Dialer Utilization fields are affected; therefore, the Dialer Utilization only captures port
status since the Dialer restarted during that half hour. Some records might be left in an active state for a
short period of time after the Dialer or Campaign Manager restarts, but the Campaign Manager has a
mechanism to reclaim those records.

Campaign Real Time reports capture call results since the last CampaignManager restart only. If the Campaign
Manager restarts, data collected before the restart is lost.

Note
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When the active CampaignManager fails over, partial campaign interval reports are generated for the relevant
interval based on the data that was available after failover. Some of the campaign statistics collected prior to
failover will be missing.

The campaign interval tables used in Reporting are impacted due to this scenario.

Note

The following list describes the data that is presented in the campaign reports.

• A summary of call results for query rules within a campaign since the beginning of the day.

• A summary of call results for a campaign since the beginning of the day. It includes a summary of all
query rules within the campaign.

• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaigns.
The times are relative to the customer’s time zone.

• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaign
query rules. The zone times are relative to the customer’s time zone. The query rule start and stop times
are relative to the Central Controller time.

• How many records for selected query rules have been dialed to completion, and how many records
remain.

• Howmany records for selected campaigns have been dialed to completion, and howmany records remain.

• A summary of call results for selected campaign query rules for selected half-hour intervals.

• A summary of call results for all query rules for selected campaigns for selected half-hour intervals.

• A historical table by half-hour/daily report that shows the status (summary and percentage) of each
campaign for the selected time period.

• A historical table by breakdown of attempts (in percentage) of each campaign for the selected time period.

• A historical table by half-hour/daily report that shows the status (summary and percentage) per query
rule of each campaign for the selected time period.

• A historical table by breakdown of attempts (in percentage) per query rule of each campaign for the
selected time period.

• A summary half-hour/daily report that shows activity and performance of the selected campaigns and
their skill group for the selected time period, including abandon rate, hit rate, and agent idle times.

• A historical table by breakdown of actual customer calls (outbound calls which reached live voice,
inbound calls, or calls transferred to the campaign skill group) for the selected campaigns and their skill
groups for the selected time period.

Dialer Reports

The Outbound Option Dialer reports provide information about the dialer. These reports include information
about performance andresource usage. The templates also enable you to determine whether you need more
dialer ports to support more outbound calls.

The following list describes the data presented in the Outbound Option Dialer reports:
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• A real-time table that shows contact, busy, voice, answering machine, and special information tone (SIT)
detection for each dialer. A SIT consists of three rising tones indicating a call has failed.

• An historical table that records contact, busy, voice, answering machine, and SIT Tone detection for
each dialer by half-hour intervals.

• Displays information about the amount of time the dialer was idle or had all ports busy.

• Displays Dialer status on a port-by-port basis used for troubleshooting. If this report does not display
any records, then the data feed is disabled by default. It is only enabled for troubleshooting purposes.

Skill Group Reports
For skill group reporting per campaign, Outbound Option provides reports that represent the skill group activity
for a contact center.

The following list describes the data presented in the skill group reports:

• A real-time table that shows all skill groups and their associated Outbound Option status.

• A historical table that records Outbound Option counts for the agent states signed on, handle, talk, and
hold by half-hour intervals.

Import Rule Reports
Outbound Option reports also enable you to view the success of record imports. Using the Import Rule
templates, you can monitor whether records are being added successfully (good records) or are failing (bad
records), and how long it takes to import the records.

The same import rule reports are used for Do Not Call and Contact List imports. The reports display a historical
view of when the imports were done, the number of records imported, and the number of records that were
considered invalid because of length constraints or improper formatting.

For contact list imports, the reports also provide insight into the number of contacts that were assigned with
the default time zone information for the campaign, as well as the number of contacts that were imported into
the dialing list after the query rule and format validation was performed.

The following information is available in the Import Rule reports:

• Number of successful, unsuccessful, and total records imported by time range

• Current import status

• A real-time table that shows the number of successful, unsuccessful, and total records imported or to be
imported.

• A historical table that shows the number of successful, unsuccessful, and total records imported by time
range. The Total Records column indicates the total number of records available in the import file.

Import Rule reporting data is not populated for Outbound API-based imports. However, you can get this data
directly from the API.

Note
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A P P E N D I X A
Registry Settings

• Campaign Manager Registry Settings, on page 107
• Dialer Registry Settings, on page 111

Campaign Manager Registry Settings
The following registry settings modify the behavior of the Campaign Manager:

DescriptionDefault SettingRegistry Setting

Calculates the callback time range for each personal and regular
callback in minutes. The Campaign Manager queries the Personal
or Regular Callback List for callback records, where the
CallbackDateTime database column value is between the current
time and current timeminus the CallbackTimeLimit. For example,
if the current time is 3:00 PM and the CallbackTimeLimit is 15
minutes, the query to retrieve Personal Callback records is “where
CallbackDateTime >= 2:45 PM and CallbackDateTime <= 3:00
PM.” This column is also used to control how long a Personal or
Regular Callback is retried after it is sent to a dialer. If the
CallbackTimeLimit is set to 15 minutes, the Dialer keeps reserving
the agent and calling the customer for 15 minutes before giving
up for that day. For Personal Callbacks, the Dialer re-reserves the
agent based on the PersonalCallbackTimeToRetryReservation
registry entry.

15 minutesCallbackTimeLimit (Campaign
Manager only)

Describes howmany dialer detail records should be buffered before
sending to the Central Controller database.

20DialerDetailBufferSize

Describes how long to wait before sending dialer detail records to
the Central Controller database when the DialerDetailBufferSize
is not reached.

5DialerDetailBufferTimeout

When set to 0, dialer detail records are not sent from campaign
manager. All Dialer Detail records are disabled.

TRUEDialerDetailEnabled
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DescriptionDefault SettingRegistry Setting

A string containing the call status types of records in the
Dialing_list table to be included in the automated purge. The types
specified are compared with the value of CallStatusZone1. For
example, if the string contains “C,M,F,L,I,” any calls with these
call statuses are purged from the database.

This registry setting is not added by default; it must be added
manually.

To be purged, records must also be older than the number of days
set in DialingListDaysToPurgeOldRecords.

The call status values can optionally be delimited using
a comma, a hyphen, a semi-colon, or a colon.

Note

If the registry entry is
missing, the default
values are C,M.

DialingListCallStatusToPurge

A string containing the call status types of records in the
Dialing_list table to be included in the automated purge. The types
specified are compared with the value of CallStatusZone1. For
example, if the string contains “C,M,F,L,I,” any calls with these
call statuses are purged from the database.

This registry setting is not added by default; it must be added
manually.

To be purged, records must also be older than the number of days
set in DialingListDaysToPurgeOldRecords.

The call status values can optionally be delimited using
a comma, a hyphen, a semi-colon, or a colon.

Note

If the registry entry is
missing, the default
values are C,M,D.

DialingListCallStatusToPurge

The number of days after the record is imported before it is
included in the automated purge of the Dialing_list table. This
value is compared with ImportRuleDate.

To be purged, records must also have a call status that is set in
DialingListCallStatusToPurge.

Minimum value is 1;
maximum value is 30;
default is 5 days

DialingListDaysToPurgeOldRecords

The interval time, in seconds, at which the active Campaign
Manager sends the failover message to the router if the Dialer or
BAImport do not connect with the Campaign Manager.

Set this registry value. If it is not set, the default value of 60
seconds is used.

Default value: 60
seconds

EMTClientTimeoutToFailover

Outbound Option Import sends a heartbeat message to Campaign
Manager every n milliseconds to indicate that it is still alive.

500 millisecondsEMTHeartBeat (Outbound Option
Import only)
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DescriptionDefault SettingRegistry Setting

When set to 0, this setting performs standard region_prefix
matching. When set to 1, the GMT time zones are always set to
the local time zone of the ICM Logger.

If there is a prefix match, the GMT time zones for each customer
record are retrieved from the Region_Prefix table.

Time zones are selected based on the data in the
Region_Prefix database. When contacts are imported,
the phone number is assigned a time zone based on the
information in the region prefix table. Each prefix has
settings for the time zone and daylight savings
observation. If the prefix of the contact number does
not match any of the prefixes listed in the region prefix
table, then the contact number is assigned the time zone
listed in the campaign configuration tool Call Target
Tab.

Note

If this registry setting changes, the ICM Logger must
be restarted before the new values take effect.
Alternatively, restart the Outbound Option Import
process by closing its console window.

Note

0, enabledImportAreaCodeProcDisable
(Outbound Option Import only)

The number of digits in a phone number must be greater than this
registry entry to perform a search of the region_prefix table.

If this registry setting changes, the ICM Logger must
be restarted before the new values take effect.
Alternatively, restart the Outbound Option Import
process by closing its console window.

Note

7 digitsImportRegLocalNumberSize
(Outbound Option Import only)

Specifies the minimum number of calls that have to be attempted
before the hit-rate percentage calculation begins for a campaign
query rule.

30 callsMinimumCallsForHitRate (Campaign
Manager only)

When set to 1, pending records get priority over retry records for
all campaigns.

0PendingOverRetryEnabled

The number of times a customer phone rings before being classified
as an unanswered call.

Minimum value is 2;
maximum value is 10;
default is 4 rings

PersonalCallbackNoAnswerRingLimit
(Campaign Manager only)

A string containing the call status types of records in the
Personal_Callback_List table to be included in the automated
purge. For example, if the string contains “C,M,F,L,I,” all calls
with these call statuses are purged from the database.

This registry setting is not added by default; it must be added
manually.

The call status values can optionally be delimited using
a comma, a hyphen, a semi-colon, or a colon.

Note

If the registry entry is
missing, the default
values are C,M

PersonalCallbackCallStatusToPurge
(Campaign Manager only)
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DescriptionDefault SettingRegistry Setting

The number of days after the personal callback has been scheduled
to keep the record before it is purged.

Minimum value is 1;
maximum value is 30;
default is 5 days

PersonalCallbackDaysToPurgeOldRecords
(Campaign Manager only)

This registry key determines if the Callback has to be enabled if
the query rule is disabled.

0PersonalCallbackDisableViaQueryRule
(Campaign Manager only)

Sets themaximumnumber of times a personal callback is attempted
(minimum value is 1; maximum value is 20). When the number
of maximum attempts reaches 0, the record is not tried again and
the status is set to M (maxed out).

5PersonalCallbackMaxAttemptsDefault
(Campaign Manager only)

Not used.1PersonalCallbackMode

The number of personal callback records to send to the Outbound
Option Dialer at one time.

Minimum value is 5;
maximum value is 200;
default is 20

PersonalCallbackRecordsToCache
(Campaign Manager only)

Indicates whether personal callbacks are allowed on Saturdays.

• 0: Personal callbacks are not allowed on Saturdays and are
scheduled for the next allowable day. For example, a personal
callback which fails to reach the customer on a Friday is
rescheduled for the following Monday.

• 1: Personal callbacks are allowed on Saturdays.

0PersonalCallbackSaturdayAllowed
(Campaign Manager only)

Indicates whether personal callbacks are allowed on Sundays.

• 0: Personal callbacks are not allowed on Sundays and are
scheduled for the next allowable day. For example, a personal
callback which fails to reach the customer on a Friday or
Saturday is rescheduled for the following Monday.

• 1: Personal callbacks are allowed on Sundays.

0PersonalCallbackSundayAllowed
(Campaign Manager only)

The interval time, in minutes, at which the Outbound Option Dialer
checks the Campaign Manager for personal callback records.

Minimum value is 1;
maximum value is 30;
default is 1 minute

PersonalCallbackTimeToCheckForRecords
(Campaign Manager only)

Sets the amount of time, in minutes, that the Outbound Option
Dialer waits before retrying a personal callback when the
customer’s phone is busy.

Minimum value is 1;
maximum value is 10;
default is 1 minute

PersonalCallbackTimeToRetryBusy
(Campaign Manager only)

Sets the amount of time, in minutes, that the Outbound Option
Dialer waits before retrying a personal callback when the customer
does not answer the phone.

Minimum value is 5;
maximum value is 60;
default is 20 minutes

PersonalCallbackTimeToRetryNoAnswer
(Campaign Manager only)

Sets the amount of time, in minutes, that the Outbound Option
Dialer waits before retrying to reserve an agent if the agent is not
available.

Minimum value is 1;
maximum value is 10;
default is 1 minute

PersonalCallbackTimeToRetryReservation
(Campaign Manager only)
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DescriptionDefault SettingRegistry Setting

Boolean value. Controls how to handle contacts that were requested
to be called back at a particular time, but were unreachable then
for whatever reason.

• 0: Unreachable records are not rescheduled or purged.

• 1: Unreachable records are scheduled for retry at the next
valid time.

1RescheduleCallbacks (Campaign
Manager only)

Not used.nullSQLServer (Campaign Manager and
Outbound Option Import)

Not used.""TCD_DBComputerName_A

Not used.""TCD_DBComputerName_B

Not used.""TCD_DBDatabaseName_A

Not used.""TCD_DBDatabaseName_B

Not used.0TCDCopyPendingEnabled

Not used.0TCDEnabled

Not used.30TCDKeepDays

Specifies the time of day (in 24-hour format: hh:mm) when the
real-time statistics for DialerRealTime and
CampaignQueryRealTime are reset.

30 minutes after
midnight (“00:30”)

TimeToResetDailyStats (Campaign
Manager only)

The interval time, in minutes, at which the Campaign Manager
resets the contact records in Unknown status to Pending status
(available for reuse).

Contact records are marked Unknown if they are in the
Active state when the Campaign Manager is initialized
or if the Outbound Option Dialer dialing those (Active)
records disconnects from the Campaign Manager due
to network or Outbound Option Dialer failure.

Note

60 minutesUnknownCallStatusResetTime
(Campaign Manager only)

Dialer Registry Settings
The following registry settings modify the behavior of the Outbound Option Dialer. To specify the exact path,
modify the registry path for the dialer to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<instance name>\Dialer instead ofHKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\\Dialer.
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DescriptionDefault SettingRegistry Setting

When enabled (1), dialer automatically answers customer calls
transferred to agent phones.

1AnswerTransferUsingAgentPhone

This registry key is not created until the process starts up. It
controls whether the Dialer auto-answers the call or not. The
guideline is to disable this and use the auto-answer in Unified
CM if you want zip tone.

1AutoAnswerCall

Amount of silence before no ringback is returned, in seconds.
If ringback is not detected within this time limit, the call is
dropped.

Changes made to this setting take effect after the
Outbound Option Dialer is cycled.

Note

20 secondsCa_cnosig

Controls behavior when started call attempts can be canceled
once all agents are occupied and abandon to IVR is not
configured. Setting to 0 never cancels calls after they have been
started. Setting to 1 always cancels calls after they have been
started once no agents are available. A value of 100 cancels all
ringing calls that are less than 100 milliseconds after the dialing
was started (that is, line went off hook.

Note 1. When CancelDialingCalls = 0, it cancels calls
not confirmed to reach customer (which means
SIP progress messages of 180, 181, 182, or 183
not yet received). The abandon to IVR
configuration is ignored for canceling in this case.

2. When CancelDialingCalls > 0, and abandon to
IVR configuration is enabled, the only calls that
have not yet been started while waiting in the
Port Throttle queue, are canceled.

0CancelDialingCalls

When set to 0, packet capturing is disabled; when set to 1, packet
capturing is enabled.

0CaptureEnabled
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DescriptionDefault SettingRegistry Setting

Options associated with packet capture:

• -i <ifname>: Interface name to capture on

• -tt : Print an unformatted time stamp on each dump line.

• -w <filename>: Capture directly to file in pcap format, file
can be opened with Wireshark.

• -C <file_size>: The maximum size of a capture file. The
units of file_size are millions of bytes (1,000,000 bytes,
not 1,048,576 bytes).

• -W <filecount>: The number of files created. The capture
files are overwritten from the beginning, thus creating a
rotating buffer. Capture files after the first capture file have
the name specified with the -w flag, with a number after
it, starting at 1 and continuing upward.

• -s : Snarf snaplen bytes of data from each packet rather
than the default of 68. Setting snaplen to 0 means use the
required length to catch whole packets.

-i 2 -tt -C 20 -s 0 -W 20 -w
DialerCapture

CaptureOptions

When set to 1, capture SIP packets only. When set to 2, capture
the entire data payload on the Dialer host machine.

1CaptureType

Not used.0CCMTransferDelay

Not used.3ConsecutiveNoDialToneEvents

Signal must exceed CPAActiveThreshold*noiseThreshold to
be considered active. For example, 32 is 10 * log(32) = 15 dB.

32CPAActiveThreshold

Maximum amount of time (from the moment the system first
detects speech) that analysis is performed on the input audio.

2500CPAAnalysisPeriod

The jitter buffer delay (in mS).150CPAJitterBufferDelay

Amount of time that the signal must be silent after speech
detection to declare a live voice (in mS).

375CPAMinSilencePeriod

Maximum Noise floor possible. Used to restrict noise floor
measurement.

10000CPAMaxNoiseFloor

Minimum Noise floor possible. Used to restrict noise floor
measurement.

1000CPAMinNoiseFloor

The amount of time to wait for the beep of an answeringmachine
before the dialer connects the agent with the machine to leave
a message.

15000CPAMaxTermToneAnalysis

The amount of time to wait when the dialer has difficulty
determining voice or answering machine.

3000CPAMaxTimeAnalysis
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DescriptionDefault SettingRegistry Setting

Standard deviation of zero crossing rate per block. Values lower
than this and CPAMaxEnergySTDev are considered tones.

0.600000CPAMaxToneSTDEV

The amount of time to wait for initial voice. The
CPAAnalysisPeriod starts once the system detects speech.

100msCPANoiseThresholdPeriod

Setting this entry to 1 enables recording of the CPA period to
assist in troubleshooting. The key must be added to be enabled.

0 (off)CPARecordWaveFile

The machine name where CTI Server-Side A resides.""CTIServerA

The machine name where CTI Server-Side B resides.""CTIServerB

The TCP port number where CTI Server-Side A listens.""CTIServerPortA

The TCP port number where CTI Server-Side B listens.""CTIServerPortB

Describes the polling interval when the campaign is enabled,
agents are available, and the Dialer needs more records from
the CampaignManager. The first request is sent when the Dialer
notices that it is low on records. Subsequent requests are sent
after the TimeToWaitForRecord times out, based on this polling
interval until more records are received.

30 secondsCustRecReadyRequestToServer

Not used.0DirectAgentDial

Disables call progress analysis for this Dialer.0DisableIPCPA

Dialer sends a heartbeat message to the Campaign Manager
every n millisecond to indicate that it is still alive.

500 millisecondsEMTHeartBeat

Normally, an agent must respond to the Preview dialog when a
reservation call is placed. With the implementation of the Auto
Accept feature, the Outbound Option Dialer implements the
Auto-Accept functionality. It causes the Dialer to Auto-ACCEPT
the preview call in n seconds (instead of skipping) if the agent
fails to respond to the preview dialog. The same applies to
Personal Callback calls.

This feature is disabled by default and the registry key must be
set to one (1) to enable the feature.

The PreviewReservationTimeout registry key is used to
configure the auto-accept timer value.

0EnableAutoAcceptFeature
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DescriptionDefault SettingRegistry Setting

EnableHeartbeat registry is used to enable heartbeats on the
dialer. When this flag is enabled, the dialer sends heartbeats
(SIP OPTIONS request message) to the SIP server - Proxy or
Gateway.

If there is no response from the SIP server, the dialer marks itself
as not ready and inform the same to the campaign manager.

If this registry is disabled, there is no indication if the SIP server
goes down.

1 (enabled)EnableHeartbeat

The time between heartbeats.5 secondsHBInterval

The number of times a timeout occurs before the SIP Dialer
identifies the SIP Gateway or SIP Proxy as down.

1HBNumTries

Not used.“1”LongDistancePrefix

The maximum recording file size (in bytes) per SIP Dialer.500,000,000MaxAllRecordFiles

The maximum number of media termination sessions per SIP
Dialer if recording is enabled in the Campaign configuration.

200MaxMediaTerminationSessions

The number of failed attempts to reserve a port before the Dialer
logs a warning. The message states that the Dialer has reached
maximum port capacity. The counter resets to 0 after logging
the message.

30MaxPortCapacityReachedCount

The maximum recording file size (in bytes) that the SIP Dialer
deletes when the total recording file size, MaxAllRecordFiles,
is reached.

100,000,000MaxPurgeRecordFiles

The maximum number of recording sessions per SIP Dialer if
recording is enabled in the Campaign configuration.

100MaxRecordingSessions

The connection port for the MR PIM.38001MRPort

This registry entry is reserved for future use. Leave the value of
this parameter at 0.

0OptimizeAgentAvailability

Not used.0OverrideNetworkTones

Contains a script name that the MR PIM receives as a dialed
number when personal callback calls require to reserve agents.

“PersonalCallback”PersonalCallbackDN
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DescriptionDefault SettingRegistry Setting

Number of seconds to wait before canceling a preview agent’s
reservation call. This key is automatically created when the
Dialer starts. If a preview agent does not accept/reject/skip a
call within this time period, the agent’s reservation call is
dropped and the record is marked as rejected.

This registry setting also works with Direct Preview
mode, and applies to the regular callback calls in both
Preview mode and Direct Preview mode.

Note

600PreviewReservationTimeout

Not used.0ReclassifyTransferFailures

When set, real-time dialer port messages are disabled for this
dialer. Enabling the Real-Time Port Feed by setting to 0 causes
the dialpr01 report to populate, but this can cause impacts to the
Outbound Campaign in delays in getting records.

1RTPortFeedDisable

The machine name of the Campaign Manager.""Server

When set to 1, the Outbound Option Dialer automatically sets
manual IN agents to the Ready state, if the reservation call is
dropped due to any reason other than transfer of a live customer
call.

If this value is set to 0, then manual IN agents assume the After
Call Work (ACW) state at the end of each reservation call and
manually become ready to receive another call.

SetAgentsReadyOnResvDrop is applicable only for
TDM dialer.

Note

1SetAgentsReadyOnResvDrop

This key specifies the port number used by the dialer to
communicate with the SIP server. This registry is created by
default when the dialer machine is installed.

58800SIPDialerPortBaseNumber

The IP address or DNS hostname of the SIP Proxy or SIP
Gateway that this Dialer connects to, as specified during setup.

NULLSIPServerAddress

The port number that the SIP Dialer uses to communicate with
the server.

5060SIPServerPortNumber

The transport type used to communicate with the gateway/CUSP.

A setting of 1 indicates that the transport type is UDP, and a
setting of 2 indicates that the transport type is TCP. Currently,
only UDP is supported.

Incoming transport time accepts TCP and UDP. The
trunk accepts traffic from the Gateway in TCP or
UDP.

Note

1SIPServerTransportType

The amount of time, in seconds, to wait between CTI Server
skill group query requests.

1 secondSkillGroupQueryDelay
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DescriptionDefault SettingRegistry Setting

Dialing prefix prepended to every phone number; for example,
this entry could be used to dial an outside line access number,
such as 9.

""SwitchPrefix

The amount of time an average customer call takes. (Seed value
for talk time, which is adjusted as a moving average as the
system is used.)

60 secondsTalkTimeAvg

Maximum length for test phone numbers. Test phone numbers
do not receive any prefixes added by the Dialer.

5TestNumberMaxDigits

The name of the Unified CMTFTP server. This server is usually
located on the Publisher Unified CM.

""TFTPServer

The amount of time, in seconds, to wait for the CTI begin call
event before canceling call.

7 secondsTimeToCTIBeginCall

The amount of time, in seconds, before a customer call is
declared stuck and dropped.

7200 seconds, which is 2
hours

TimeToFreeStuckCall

The amount of time, in seconds, to wait before releasing a stuck
port.

7200 seconds, which is 2
hours

TimeToFreeStuckPort

The amount of time, in seconds, to wait before abandoning a
customer call due to lack of agents. If abandon to IVR is enabled
for campaigns, this value should be set to 0 to reduce transfer
delays.

1 secondTimeToHoldCustomer

The amount of time, in seconds, to wait before dropping a
reservation call.

10 secondsTimeToReserve

The amount of time, in seconds, to wait before retrying a close
customer record request to the Campaign Manager.

When the Outbound Option Dialer finishes with a customer
record, it sends a close customer record request message to the
Campaign Manager. If this message is not sent, the Outbound
Option Dialer retries the call based on the configured timeout.

30 secondsTimeToRetryCustomerRequest

The amount of time, in seconds, each customer ring takes. For
example, if this entry is set to 8 and the no-answer configuration
in the campaign is set to 3 rings, then the Dialer classifies the
call as no-answer within 3*8 (24) seconds.

8 secondsTimeToRingCustomer

The amount of time, in seconds, to wait before dropping a call
being transferred.

7 secondsTimeToTransfer

The amount of time, in seconds, to wait for the CTI Server to
respond to a request before dropping the call.

3 secondsTimeToWaitForCTIResp

The amount of time, in seconds, to wait for the Unified CM dial
tone.

4 secondsTimeToWaitForIPDialTone
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DescriptionDefault SettingRegistry Setting

The amount of time, in seconds, to wait for the MR PIM to
respond to a new task request before canceling the request.

600 seconds (10 minutes)TimeToWaitForMRIResponse

The amount of time, in seconds, to wait for customer records
from the Campaign Manager before declaring the skill group
disabled.

Once a skill group has been disabled, the Dialer begins polling
theCampaignManager every <CustRecReadyRequestToServer>
second for additional records.

5 secondsTimeToWaitForRecord
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A P P E N D I X B
Long Distance Digit Prefix Logic

• Transformation of Imported Numbers, on page 119
• Dialer Configuration Fields and Registry Settings, on page 120

Transformation of Imported Numbers
The following example displays an Outbound Option call route that provides information about how imported
numbers are transformed for the Outbound Option call.
Figure 17: How Imported Numbers Are Transformed

DescriptionOutbound Option
Configuration Field

Call Item

Final dialing number transferred to either the ACD
or Unified CM (used for debugging/lab purposes
only)

ImportedNumber <=
TestNumberMaxDigits Registry
setting
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DescriptionOutbound Option
Configuration Field

Call Item

Area/city code used at your location, which is
configured in theDialer ConfigurationComponent

Local area codeArea Code match beginning of
ImportedNumber

Includes the area code for a long distance call or
removes the area code for a local call

Local area codeIncludeAreaCodeWhenDialing

Includes the pre-pended value for a long distance
call, which is configured in the Dialer
Configuration Component

Long distance prefixPrePend “LongDistancePrefix”

Include the dialing prefix required by your
location or by your campaign, which is configured
in the Dialer Configuration Component

Dial prefixPrePend “Dial Prefix” Digits

Dialer Configuration Fields and Registry Settings
The following example displays the Dialer configuration fields and Registry settings from the Dumpconf
Procmon command that are used in an outbound call.
C:\>procmon ipccd dialer badialer >>>>dumpconf Dialer Config

------------- DialerID : [5006] PeripheralID : [5000] ActiveDialers : [1] LocalAreaCode
: [978]

<--- area code DialToneDetectEnabled : [0] HangupTime : [1] TenDigitDialEnabled : [0]
<--- Include area code when dialing PrefixDigits : [] <--- Dial prefix digits
LongDistancePrefix : [1] <---- "Long distance prefix" Callback config has not been

received
yet ----------------------------------------- Configured Skill Groups

-----------------------
--------- SkillGroupID : [11988] VDN : [11988] PeripheralNumber : [890]

SkillGroupEnableStatus:
[0] CampaignName : [DialAgents] ModeName : [N] TypeName : [I] Customer Count : [0]

Customer
Count (idle) : [0] RecordsToCache : [20] PredictiveExt : [890] PreviewExt : [890]
*PortsPerAgent : [1.500000] AgentPercentage : [100] AgentsLoggedIn : [0] AgentsAvailable

: [0]
AgentsTalking : [0] *PortsAllocated : [0] AgentsReadyIn8Secs : [0] TalkTimeAverage :

[60]
*AgentsToReserveDelta : [0] *PortsUsedToDialDelta : [0] OverflowAgents : [0]
AutoAnswerReservation : [0] AbandonRate : [2] MaximumLinesPerAgent : [2.000000]
NoAnswerRingLimit : [4] MinimumCallDuration : [1] PreReservedRecordCount: [0]

IVRPortCount :
[0] TransferToIVREnabled : [N] TransferAnsMachine : [Y] IVRExt : [] ---------

SkillGroupID :
[-1] VDN : [-1] PeripheralNumber : [0] SkillGroupEnableStatus: [0] CampaignName :

[Callback]
ModeName : [A] TypeName : [O] Customer Count : [0] Customer Count (idle) : [0]

RecordsToCache :
[0] PredictiveExt : [] PreviewExt : [] *PortsPerAgent : [1.500000] AgentPercentage :

[100]
AgentsLoggedIn : [0] AgentsAvailable : [0] AgentsTalking : [0] *PortsAllocated : [0]
AgentsReadyIn8Secs : [0] TalkTimeAverage : [0] *AgentsToReserveDelta : [0]
*PortsUsedToDialDelta : [0] OverflowAgents : [0] AutoAnswerReservation : [1] AbandonRate

: [1]
MaximumLinesPerAgent : [3.000000] NoAnswerRingLimit : [3] MinimumCallDuration : [0]
PreReservedRecordCount: [0] IVRPortCount : [0] TransferToIVREnabled : [N]
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TransferAnsMachine :
[N] IVRExt : [] --------- SkillGroupID : [11965] VDN : [11965] PeripheralNumber : [889]

SkillGroupEnableStatus: [0] CampaignName : [TT_ISN] ModeName : [R] TypeName : [O]
Customer

Count : [0] Customer Count (idle) : [0] RecordsToCache : [20] PredictiveExt : [12345]
PreviewExt : [12345] *PortsPerAgent : [1.500000] AgentPercentage : [100] AgentsLoggedIn

: [60]
AgentsAvailable : [60] AgentsTalking : [0] *PortsAllocated : [0] AgentsReadyIn8Secs :

[0]
TalkTimeAverage : [60] *AgentsToReserveDelta : [0] *PortsUsedToDialDelta : [0]

OverflowAgents :
[0] AutoAnswerReservation : [0] AbandonRate : [3] MaximumLinesPerAgent : [2.500000]
NoAnswerRingLimit : [4] MinimumCallDuration : [1] PreReservedRecordCount: [0]

IVRPortCount :
[60] TransferToIVREnabled : [Y] TransferAnsMachine : [Y] IVRExt : [90001] Port Map

Config
--------------- Port: [000], Station: [30100] Port: [015], Station: [30115] Port:

[081],
Station: [30181] Port: [082], Station: [30182] Port: [083], Station: [30183] Port:

[016],
Station: [30116] Port: [031], Station: [30131] Port: [087], Station: [30187] Port:

[023],
Station: [30123] Port: [071], Station: [30171] Port: [095], Station: [30195] Port:

[063],
Station: [30163] Port: [055], Station: [30155] Port: [047], Station: [30147] Port:

[039],
Station: [30139] Port: [008], Station: [30108] Port: [032], Station: [30132] Port:

[024],
Station: [30124] Port: [088], Station: [30188] Port: [072], Station: [30172] Port:

[064],
Station: [30164] Port: [048], Station: [30148] Port: [040], Station: [30140] Port:

[001],
Station: [30101] Port: [009], Station: [30109] Port: [033], Station: [30133] Port:

[017],
Station: [30117] Port: [025], Station: [30125] Port: [089], Station: [30189] Port:

[065],
Station: [30165] Port: [073], Station: [30173] Port: [049], Station: [30149] Port:

[041],
Station: [30141] Port: [002], Station: [30102] Port: [018], Station: [30118] Port:

[026],
Station: [30126] Port: [090], Station: [30190] Port: [066], Station: [30166] Port:

[074],
Station: [30174] Port: [050], Station: [30150] Port: [042], Station: [30142] Port:

[003],
Station: [30103] Port: [027], Station: [30127] Port: [019], Station: [30119] Port:

[091],
Station: [30191] Port: [075], Station: [30175] Port: [067], Station: [30167] Port:

[059],
Station: [30159] Port: [051], Station: [30151] Port: [043], Station: [30143] Port:

[004],
Station: [30104] Port: [020], Station: [30120] Port: [028], Station: [30128] Port:

[092],
Station: [30192] Port: [084], Station: [30184] Port: [076], Station: [30176] Port:

[060],
Station: [30160] Port: [068], Station: [30168] Port: [052], Station: [30152] Port:

[036],
Station: [30136] Port: [021], Station: [30121] Port: [044], Station: [30144] Port:

[093],
Station: [30193] Port: [005], Station: [30105] Port: [029], Station: [30129] Port:

[085],
Station: [30185] Port: [069], Station: [30169] Port: [077], Station: [30177] Port:

[061],
Station: [30161] Port: [053], Station: [30153] Port: [037], Station: [30137] Port:
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[045],
Station: [30145] Port: [014], Station: [30114] Port: [038], Station: [30138] Port:

[079],
Station: [30179] Port: [010], Station: [30110] Port: [056], Station: [30156] Port:

[034],
Station: [30134] Port: [080], Station: [30180] Port: [057], Station: [30157] Port:

[058],
Station: [30158] Port: [022], Station: [30122] Port: [006], Station: [30106] Port:

[030],
Station: [30130] Port: [011], Station: [30111] Port: [035], Station: [30135] Port:

[012],
Station: [30112] Port: [013], Station: [30113] Port: [086], Station: [30186] Port:

[070],
Station: [30170] Port: [094], Station: [30194] Port: [078], Station: [30178] Port:

[062],
Station: [30162] Port: [046], Station: [30146] Port: [054], Station: [30154] Port:

[007],
Station: [30107] Registry Config Values ---------------------- TimeToCTIBeginCall :

[7]
TimeToRingCustomer : [8] TimeToHoldCustomer : [1] TimeToReserve : [10] TimeToTransfer

: [7]
TimeToFreeStuckPort : [7200] TimeToFreeStuckCall : [7200] SwitchPrefix : []
TimeToRetryCustomerRequest : [30] TimeToWaitForRecord : [5] TimeToWaitForCTIResp : [3]

TalkTimeAvg : [60] CustRecReadyRequestToServer: [30] TestNumberMaxDigits : [5] <-----
"Test

Number Max digits" ca_cnosig : [20] PortThrottleTime : [2] PortThrottleCount : [20]
OptimizeAgentAvailability : [0] RTPortFeedDisable : [1] SkillGroupQueryDelay : [1]
ReclassifyTransferFailures : [0] SetAgentsReadyOnResvDrop : [1] DirectAgentDial : [0]
OverrideNetworkTones : [0] AnswrTrnsfrUsingAgentPhone : [1] </end>>>>>
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A P P E N D I X C
Dialer Detail Table

• About the Dialer_Detail Table, on page 123
• Dialer_Detail Table Database Fields and Descriptions, on page 124

About the Dialer_Detail Table
The Dialer_Detail table is a historical table that is present in the Unified CCE/CCH database in Releases
7.2(2) and later. Its purpose is to allow detailed dialer records to be written to the Logger databases and
replicated to each HDS database.

This table can become very large. Running custom reporting queries against it while it is on the HDS can
degrade performance. To optimize performance, extract the data from the HDS into your own custom database
on a separate server (one that is not used for other CCE components). Use only DBDateTime (date and time
of the record that was written to the HDSdatabase) to perform the extraction. The table on the custom database
can be indexed according to the custom reporting needs.

Advantages
Data stored in this table helps in managing the system and generating custom reports.

For example, the table stores the following information:

• The Account Number for the contact and the Call Result, so that the last termination code can be obtained
for each contact.

• An identifier for the Agent so that skipped records and callbacks scheduled by each agent can be
determined.

• Additional data for troubleshooting of Outbound Dialer attempts, such as the CallID that was used to
place the call.

Data Flow
1. After making an attempt to contact a customer, the Dialer sends the results to the Campaign Manager in

a CloseCustomerRecord message.
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The CloseCustomerRecord message is also sent if the Agent chooses to skip a call in preview mode.
Results for Personal Callback attempts are sent to the Campaign Manager using a
ClosePersonalCallbackRecord message.

2. Campaign Manager then sends a Dialer Detail record to the Router.

At this point, the message flow is identical to all other historical data in the system.

3. The Router passes the historical data information to the Historical Logger process.

4. The Historical Logger process commits the data to the Logger database.

5. The Replication process on the Logger passes the historical data to the Replication process on the Historical
Data Server (HDS).

6. The Replication process on the HDS commits the data to the HDS database.

Fault Tolerance
When the Router is down or the CampaignManager loses the connection to the Router, the CampaignManager
stores Dialer_Detail records in a file on the server where CampaignManager is running. All the Dialer_Detail
records in the cached file are sent to the Router when the connection is restored.

Dialer_Detail Table Database Fields and Descriptions
For a full description of the database fields for the Dialer_Detail table, see the Database Schema Handbook
for Cisco Unified Contact Center Enterprise.

CallResult Codes and Values
The CallResult field can be populated with the following values:

Table 9: CallResult Codes and Values

DescriptionValue

Dialer has not yet attempted to contact that customer record0

Error condition while dialing2

Number reported not in service by network3

No ringback from network when dial attempted4

Operator intercept returned from network when dial attempted5

No dial tone when dialer port went off hook6

Number reported as invalid by the network7

Customer phone did not answer8

Customer phone was busy9
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DescriptionValue

Customer answered and was connected to agent10

Fax machine detected11

Answering machine detected12

Dialer stopped dialing customer due to lack of agents or network stopped dialing
before it was complete

13

Customer requested callback14

Answering machine requested callback15

Call was abandoned by the dialer due to lack of agents16

Failed to reserve agent for personal callback.17

Agent has skipped or rejected a preview call or personal callback call.18

Agent has skipped or rejected a preview call with the close option19

Customer has been abandoned to an IVR20

Customer dropped call within configured abandoned time21

Mostly used with TDM switches - network answering machine, such as a network
voicemail

22

Number successfully contacted but wrong number23

Number successfully contacted but reached the wrong person24

Dialer has flushed this record due to a change in the skillgroup or the campaign25

The number was on the do not call list26

Call disconnected by the carrier or the network while ringing27

Dead air or low voice volume call28

SIP message received from dialer is not supported by voice gateway.29

SIP message received from dialer is not authorized by voice gateway.30

Invalid sip message sent by dialer to voice gateway.31

CallStatusZone Values
The CallStatusZone1 and CallStatusZone2 fields can be populated with the following values that show the
current status of the customer record for the zone.

The values are:
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Table 10: CallStatusZone Values

DescriptionValue

Active: Stored in CallStatusZoneX (1 or 2). A zone is set to active when it has been
sent to a dialer for dialing.

A

A callback was requested. Stored in CallStatusZone1 and CallStatusZone2 field when
a regular callback (non personal callback) has been scheduled. The Callback time
itself is stored in both the CallbackDateTimeZone1 and CallbackDateTimeZone2
columns since the callback overrides the individual zones.

B

Closed: Record has been closed for that particular zone, so the record will not be
retried again for that zone (zone1 or zone2).

C

Agent rejected (closed out the record)J

The maximum number of attempts has been reached. Stored in both CallStatusZone1
and CallStatusZone2. A record is set to “M” when it has dialed the maximum times
as specified in the campaign and will not be retried again. Both zones are set to “M”
to indicate no further calling in either zone.

M

Pending. Stored in CallStatusZoneX (1 or 2). This is the initial state of a record before
any dialing has taken place. The record remains in the pending state for a particular
zone until all of the numbers specified for that zone are dialed. A pending contact
which has already dialed at least one dialer from its sequence will have at least one
CallBackDateTimeXX column filled in with a retry time.

P

Retry. Stored in CallStatusZoneX (1 or 2) for the zone where the Retry is scheduled.
The retry time itself is stored in the CallbackDateTimeZoneX (1 or 2) as well as in
the individual number column CallbackDateTimeXX, where XX is the number to be
retried (01 - 10). Call can be retried for a variety of reasons, including receiving a
busy or no answer result.

R

A personal callback was requested. Stored in both CallStatusZone1 and
CallStatusZone2. A record is set to “S” when it has been scheduled for a personal
callback. Both zones are set to “S” to indicate that the record has been moved to the
personal callback list.

S

Unknown: Stored in CallStatusZone1 andCallStatusZone2. A record is set to Unknown
if its status was Active when the Campaign Manager started or the Dialer re-started.
The record will stay in the Unknown state until it gets an update. If the Campaign
Manager fails to get an update within sixty minutes, it will return the record to Pending.

U

For a personal callback, the agent is not available, and the reschedule mode is
Abandon. (This value is used for CallStatusZone1 only.)

X

DialingMode Values
The DialingMode field can be populated with the following values that show the campaign mode for the call.
This field is NULL for Do Not Call entries.

Values are shown in the following table.
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Table 11: DialingMode Values

DescriptionValue

Predictive only1

Predictive blended2

Preview only3

Preview blended4

Progressive only5

Progressive blended6

Direct preview only7

Direct preview blended8

CallResults Table
The following CallResults table maps the call result to the campaign call report.

Table 12: CallResults Table

Retry ActionDetected
Live Voice?

Counted as
Attempt?

Reporting ColumnDescriptionCall Result

Regular outbound calls
are not retried and are
returned to the closed
state.

Callback calls are retried
as Dialer Abandoned.

NoNoNoneError condition
while dialing

2

NoneNoYesNoneNumber reported
not in service by
network

3

No answerNoYesNoRingBackNo ringback from
network when dial
attempted

4

NoneNoYesSITToneOperator intercept
returned from
network when dial
attempted

5

No answerNoYesNoDialToneNo dial tone when
dialer port went off
hook

6
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Retry ActionDetected
Live Voice?

Counted as
Attempt?

Reporting ColumnDescriptionCall Result

NoneNoYesSITToneNumber reported as
invalid by the
network

7

No answerNoYesNoAnswerCustomer phone did
not answer

8

BusyNoYesBusyCustomer phone
was busy

9

NoneYesYesVoiceCustomer answered
and was connected
to agent

10

NoneNoYesFaxFax machine
detected

11

Answering Machine, if
needed

No, but
transfer to
agent
possible

YesAnsweringMachineAnsweringmachine
detected

12

Dialer AbandonedNoYesCancelledDialer stopped
dialing customer
due to lack of agents

13

NoneYesYesCallback &
PersonalCallback

Customer requested
callback

14

NoneNoYesCallback &
PersonalCallback

Answeringmachine
requested callback

15

Dialer AbandonedYesYesAbandonCall was abandoned
by the dialer due to
lack of agents

16

No Answer.NoNoNoneFailed to reserve
agent for personal
callback

17

For Preview calls: No
Answer.

For Personal Callback
calls: None.

NoNoAgentRejectedAgent has skipped
or rejected a
preview call or
personal callback
call

18

NoneNoNoAgentClosedAgent has skipped
or rejected a
preview call with
the close option

19
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Retry ActionDetected
Live Voice?

Counted as
Attempt?

Reporting ColumnDescriptionCall Result

Dialer Abandoned, if
needed

YesYesAbandonToIVRCustomer has been
abandoned to an
IVR

20

Customer AbandonedYesYesCustomerAbandonCustomer dropped
call within
configured
abandoned time

21

Answering Machine, if
needed

NoYesNetworkAnsMachineMostly used with
TDM switches -
network answering
machine, such as a
network voicemail

22

NoneYesYesWrongNumberNumber
successfully
contacted but wrong
number

23

Customer not homeYesYesCustomerNotHomeNumber
successfully
contacted but
reached the wrong
person

24

None, but returned to the
pending state

NoNoNoneDialer has flushed
this record due to a
change in the
skillgroup, the
campaign, or some
other parameter

25

NoneNoNoNoneThe number was on
the do not call list

26

No answerNoYesNoRingbackNetwork
disconnected while
alerting

27

No answerNoYesNoRingbackLow Energy or
Dead Air call
detected by CPA

28

SIP message
received from dialer
is not supported by
voice gateway.

29
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Retry ActionDetected
Live Voice?

Counted as
Attempt?

Reporting ColumnDescriptionCall Result

SIP message
received from dialer
is not authorized by
voice gateway.

30

Invalid sip message
sent by dialer to
voice gateway.

31

Outbound dialer call result for combinations of PSTN and status code
The following dialer call results corresponds to the combinations of PSTN cause code and Status code specified
in the Dialer_ Detail table.

Status code: Status code is a 3-digit integer result code that indicates the outcome of an attempt to understand
and satisfy a SIP request.

PSTN cause code: In signaling context, PSTN cause codes are used to indicate certain events or conditions
in the network.

CheckCallState: Indicates whether the call is active or not . TRUE value implies that the call is active.

CallState: Indicates the intermediate call state. When a call is active, it can have any one of the following
values - CS_INITIATED, CS_ALERTED, and CS_CONNECTED.

DialerCallResult: Indicates the SIP Dialer call result for the respective SIP status code and PSTN cause code.

Table 13: Outbound Dialer Call Result for PSTN and status code combinations

System
Type Values
(from Dialer
detail:
CallResult)

DialerCallResultCallStateCheckCallStatePSTNCauseCodeStatusCode

31INVALID_NETWORK_MSGCS_NONEFALSE41400

30NOT_AUTHORIZEDCS_NONEFALSE57401

3NOT_IN_SERVICECS_NONEFALSE57403

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE0404

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE1404

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE31404

3NOT_IN_SERVICECS_NONEFALSE20404

3NOT_IN_SERVICECS_NONEFALSE63405

29NOT_SUPPORTEDCS_NONEFALSE88406

30NOT_AUTHORIZEDCS_NONEFALSE57407
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System
Type Values
(from Dialer
detail:
CallResult)

DialerCallResultCallStateCheckCallStatePSTNCauseCodeStatusCode

6NO_DIALTONECS_NONEFALSE120408

29NOT_SUPPORTEDCS_NONEFALSE47409

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE22410

29NOT_SUPPORTEDCS_NONEFALSE47411

30NOT_AUTHORIZEDCS_NONEFALSE38412

29NOT_SUPPORTEDCS_NONEFALSE127413

29NOT_SUPPORTEDCS_NONEFALSE47415

29NOT_SUPPORTEDCS_NONEFALSE47417

31INVALID_NETWORK_MSGCS_NONEFALSE95420

29NOT_SUPPORTEDCS_NONEFALSE95421

29NOT_SUPPORTEDCS_NONEFALSE100422

13STOPPEDCS_NONEFALSE100422

13STOPPEDCS_CONNECTEDTRUE100422

29NOT_SUPPORTEDCS_NONEFALSE47423

31INVALID_NETWORK_MSGCS_NONEFALSE41424

29NOT_SUPPORTEDCS_NONEFALSE41428

29NOT_SUPPORTEDCS_NONEFALSE41429

31INVALID_NETWORK_MSGCS_NONEFALSE127430

29NOT_SUPPORTEDCS_NONEFALSE57433

29NOT_SUPPORTEDCS_NONEFALSE41436

29NOT_SUPPORTEDCS_NONEFALSE41437

31INVALID_NETWORK_MSGCS_NONEFALSE41438

29NOT_SUPPORTEDCS_NONEFALSE88439

30NOT_AUTHORIZEDCS_NONEFALSE41470

4NO_RINGBACKCS_INITIATEDTRUE18480

8NO_ANSWERCS_ALERTEDTRUE18480

8NO_ANSWERCS_NONEFALSE19480

4NO_RINGBACKCS_INITIATEDTRUE20480

4NO_RINGBACKCS_ALERTEDTRUE20480

21CUSTOMER_ABANDONEDCS_CONNECTEDTRUE20480
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System
Type Values
(from Dialer
detail:
CallResult)

DialerCallResultCallStateCheckCallStatePSTNCauseCodeStatusCode

4NO_RINGBACKCS_NONETRUE20480

21CUSTOMER_ABANDONEDCS_NONEFALSE127481

13STOPPEDCS_NONEFALSE25482

13STOPPEDCS_INITIATEDTRUE25482

13STOPPEDCS_ALERTEDTRUE25482

13STOPPEDCS_CONNECTEDTRUE25482

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE28484

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE1485

9BUSYCS_NONEFALSE0486

9BUSYCS_NONEFALSE17486

6NO_DIALTONECS_NONETRUE127487

4NO_RINGBACKCS_INITIATEDTRUE127487

8NO_ANSWERCS_ALERTEDTRUE127487

29NOT_SUPPORTEDCS_NONEFALSE47488

29NOT_SUPPORTEDCS_NONEFALSE41489

16ABANDONCS_NONEFALSE31491

16ABANDONCS_CONNECTEDTRUE31491

29NOT_SUPPORTEDCS_NONEFALSE97493

30NOT_AUTHORIZEDCS_NONEFALSE57494

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE4500

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE5500

6NO_DIALTONECS_NONEFALSE6500

6NO_DIALTONECS_NONEFALSE44500

4NO_RINGBACKCS_INITIATEDTRUE8500

4NO_RINGBACKCS_INITIATEDTRUE9500

4NO_RINGBACKCS_INITIATEDTRUE39500

4NO_RINGBACKCS_INITIATEDTRUE16500

8NO_ANSWERCS_ALERTEDTRUE16500

21CUSTOMER_ABANDONEDCS_CONNECTEDTRUE16500

6NO_DIALTONECS_NONEFALSE44500
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System
Type Values
(from Dialer
detail:
CallResult)

DialerCallResultCallStateCheckCallStatePSTNCauseCodeStatusCode

9BUSYCS_NONEFALSE46500

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE63500

21CUSTOMER_ABANDONEDCS_NONEFALSE86500

29NOT_SUPPORTEDCS_NONEFALSE79501

6NO_DIALTONECS_NONEFALSE38502

6NO_DIALTONECS_NONEFALSE0502

6NO_DIALTONECS_NONEFALSE0503

6NO_DIALTONECS_NONEFALSE34503

6NO_DIALTONECS_NONEFALSE41503

6NO_DIALTONECS_NONEFALSE42503

6NO_DIALTONECS_NONEFALSE47503

6NO_DIALTONECS_NONEFALSE87503

29NOT_SUPPORTEDCS_NONEFALSE102504

29NOT_SUPPORTEDCS_NONEFALSE127505

29NOT_SUPPORTEDCS_NONEFALSE100513

6NO_DIALTONECS_NONEFALSE47580

7NUMBER_NOT_ALLOCATEDCS_NONEFALSE1604

9BUSYCS_NONEFALSE17600
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A P P E N D I X D
Termination Call Detail Table

• Peripheral call types, on page 135
• TCD Column Descriptions, on page 136
• Transfer to VRU TCD Records, on page 139

Peripheral call types

Map Release 8.x to Release 6.0(0) and Earlier Peripheral Call Types
This section maps the Release 8.x peripheral call types to Release 6.0(0) and earlier peripheral call types.

Table 14: Mapping of Release 8.x Peripheral Call Types to Release 6.0(0) and Earlier Peripheral Call Types

DescriptionPeripheral Call Type

CALLTYPE_OO_RESERVATION_PREVIEW = 27

CALLTYPE_OO_RESERVATION_PREVIEWDIRECT = 28

CALLTYPE_OO_RESERVATION_PREDICTIVE = 29

CALLTYPE_OO_RESERVATION_CALLBACK = 30

CALLTYPE_OO_RESERVATION_PERSONALCALLBACK =
31

CALLTYPE_RESERVATION

CALLTYPE_OO_CUSTOMER_PREDICTIVE = 34

CALLTYPE_OO_CUSTOMER_IVR = 37

CALLTYPE_AUTO_OUT

CALLTYPE_OO_CUSTOMER_PREVIEW = 32

CALLTYPE_OO_CUSTOMER_CALLBACK = 35

CALLTYPE_OO_CUSTOMER_PREVIEWDIRECT = 33

CALLTYPE_OO_CUSTOMER_PERSONALCALLBACK = 36

CALLTYPE_OO_CUSTOMER_PREDICTIVE = 34

CALLTYPE_OO_CUSTOMER_IVR = 37

CALLTYPE_PREVIEW
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Call Disposition Values Used in Termination_Call_Detail Table
The following CallDisposition values can be interpreted as Outbound Option Result Codes:

• 01. ABAND_NETWORK - Customer phone number not in service

• 02. ABAND_LOCAL_QUEUE - An Outbound Option call was abandoned either by the customer or
dialer

• 08. BUSY - Outbound Option call resulted in a busy signal

• 19. RING_NO_ANSWER - Outbound Option call was not answered in the allotted time

• 20. INTERCEPT_REORDER - Dialer did not receive a ring back from the ACD on network

• 21. INTERCEPT_DENIAL - Customer call was intercepted by the operator

• 22. TIME_OUT - Dialer unable to detect dial tone

• 23. VOICE_ENERGY - Outbound Option call was answered by a person

OnUnified CCE, this result might also represent a call answered by an answering
machine.

Note

• 24. NONCLASSIFIED_ENERGY_DETECT - Outbound Option call reached a FAX machine

• 26. UABORT - Outbound Option call was disconnected before customer answered

• 33. ANSWERING_MACHINE - Outbound Option call was answered by answering machine

CED (Caller-Entered Digits) Column Values
The CED (Caller-Entered Digits) column values for Outbound Option are as follows:

“Callback” = Personal callback customer call

“Regular_Callback” = Regular callback customer call

“ICM_BA_Reservation_Call” = Reservation call

TCD Column Descriptions
The following types of records are generated when the Outbound Option Dialer makes agent reservation calls
and customer calls.

Reservation Calls
Reservation calls generate two TCD records and one RCD record:

• IPCC reservation call (TCD) as described below.

• MR PIM reservation entry “not a real call” (TCD) as described below.
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• MR PIM route request (RCD) as described on the next page.

This record is a route request sent from the Dialer via the MR PIM.Note

IPCC Reservation Call
PeripheralCallType = 18 (Reserve)

CallDisposition = 6 (agent abandon)

DialedNumber =Number dialed to run routing script

CED = ICM_BA_Reservation_Call

DNIS = Agent phone number (also InstrumentPortNumber)

HoldTime =Most of reserve time is kept under this bucket

TalkTime = Prior to reservation call being placed on hold the talking bucket is incremented

Duration = Total reservation time

AgentPeripheralNumber = Agent Sign-in ID

PeripheralCallKey = Unique peripheral call ID

ANI = Customer phone number (only available for Preview reservation calls)

RouterCallKeyDay/RouterCallKey = Maps reservation call to MR reservation request and associates it with
route_call_detail record

MR PIM Reservation Entry Not a Real Call (TCD)
PeripheralID = MR PIM Peripheral ID (not Unified CM Peripheral ID)

PeripheralCallType = 1 (ACD IN; all MR calls are this type)

CallDisposition = 14 (call handled by Dialer)

RouterCallKeyDay/RouterCallKey = Maps MR reservation request to actual reservation call and associates
it with MR reservation route_call_detail record

MR PIM Route Request (RCD - route_call_detail)
RouterCallKeyDay/RouterCallKey = Maps MR reservation route to actual reservation call and associates it
with MR reservation route_call_detail record

RequestType = 6 (Post-Routing)

RoutingClientID = MR PIM used by Dialer

ScriptID = Script used to service agent reservation request

RouterErrorCode = 0 (no error)

Label = Agent phone extension

DialedNumberString = Dialed number used to choose script
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Customer Calls
Customer calls generate up to two TCD records:

• Initial customer call transferred to agent (TCD) as described in Table D-2.

• Customer speaking with agent (TCD) as described in Table D-3.

Table 15: Initial Customer Call Transferred to Agent (TCD)

DescriptionColumn Name

One of the following:

• 32 (preview)

• 33 (preview direct)

• 34 (predictive)

• 35 (callback)

• 36 (personal callback)

• 37 (IVR)

PeripheralCallType

Customer phone numberDigitsDialed

29 (announced transfer, call was transferred to agent)CallDisposition

Number of seconds agent was reserved for an
outbound call including amount of time it took to
reserve the agent

Duration

Number of seconds agent was reservedHoldTime

Unique key for TCD recordICRCallKey

Call key identifying the transferred customer callICRCallKeyChild

Unique peripheral call ID (same as transferred call)PeripheralCallKey

Customer phone numberANI

Table 16: Customer Speaking with Agent (TCD)

DescriptionColumn Name

ICM agent IDAgentSkillTargetID

ICM skill group IDSkillGroupSkillTargetID
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DescriptionColumn Name

One of the following:

• 32 (preview)

• 33 (preview direct)

• 34 (predictive)

• 35 (callback)

• 36 (personal callback)

• 37 (IVR)

PeripheralCallType

Agent phone extensionDigitsDialed

13 (disconnect/drop handled, call was handled by
agent)

CallDisposition

Total customer handle time (including talk and
wrap-up)

Duration

Agent talk timeTalkTime

Unique key for TCD recordICRCallKey

Call key identifying the original customer call prior
to the transfer

ICRCallKeyChild

Unique peripheral call ID (same as original customer
call prior to transfer)

PeripheralCallKey

Customer phone numberANI

Transfer to VRU TCD Records
With the SIP dialer, the Transferred Customer Calls have a PeripheralCallType of 1.

No TCD records are cut for the outbound calls that do not hit the Unified CCE peripheral for either CVP
(VRU) or Agent-based campaigns.

Initial Customer Call on PIM Transferred to Route Point
• PeripheralCallType - one of the following:

• 32 (preview)

• 33 (preview direct)

• 34 (predictive)

• 35 (callback)
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• 36 (personal callback)

• 37 (IVR)

• DigitsDialed - Customer phone number

• CallDisposition - 29 (announced transfer, call was transferred to route point)

• Duration - Number of seconds it took the Dialer to dial the customer phone number and have the customer
pick up the phone

• ICRCallKey - Unique key for TCD record

• ICRCallKeyChild - Call key identifying the transferred customer call

• PeripheralCallKey- Unique peripheral call ID (same as transferred call)

• ANI - Customer phone number

Transferred Customer Call on Unified CM PIM Redirected to IVR
• PeripheralCallType - one of the following:

• 32 (preview)

• 33 (preview direct)

• 34 (predictive)

• 35 (callback)

• 36 (personal callback)

• 37 (IVR)

• DigitsDialed - Customer phone number

• CallDisposition - 15 (redirect)

• Duration - Number of seconds it took the Dialer to redirect the call

• ICRCallKey - Unique key for TCD record

• ICRCallKeyParent - Call key identifying the initial customer call

• PeripheralCallKey - Unique peripheral call ID (same as transferred call)

• ANI - Customer phone number

IVR Plays a Message on VRU PIM to a Customer
• PeripheralCallType - 1 (ACD in, call comes into IVR)

• DigitsDialed - Digits dialed to reach the route point, which executes the translation route

• CallDisposition - 13 (disconnect/drop handled, call was handled by IVR) or 6 (abandon; customer hangs
up the phone before the IVR message ends)
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• LocalQTime - Total customer handle time at the IVR

• ICRCallKey - Unique key for TCD record

• PeripheralCallKey - Unique peripheral call ID (same as original customer call prior to transfer)

• ANI - Customer phone number
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A P P E N D I X E
Dialing List Table

• Dialing_List Table Columns, on page 143

Dialing_List Table Columns
The following table displays the Dialing_List table column names and their description.

Table 17: Dialing_List Table Columns for Release 7.0(0)

DescriptionTypeColumn Name

The phone number imported into Phone01
through Phone 10 standard column.

VARCHAR20Phone01 through Phone10

The phone number extensions imported into
PhoneExt01 through PhoneExt10 standard
column.

Although the phone number
extensions are imported into the
table, they are currently not used
for any dialing operations.

Note

VARCHAR8PhoneExt01 through
PhoneExt10

Phone number to be used for a regular
callback it can be supplied by the agent.

VARCHAR20CallbackNumber

The call result from the last call placed for
this record (see Call Result definitions).

SMALLINTCallResult

The call result from the last time
Phone01through Phone10 was called (see
Call Result definitions). CallResult01
captures the results of all requested regular
callback calls for Phone01 to Phone10.

SMALLINTCallResult01 through
CallResult10

The last zone that was dialed (0 indicates
zone1, 1 indicates zone2).

SMALLINTLastZoneDialed
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DescriptionTypeColumn Name

The last number dialed in zone1 (1 for
phone01, 2 for phone02, and so on)

SMALLINTLastNumberDialedZone1

The last number dialed in zone2 (1 for
phone01, 2 for phone02, and so on)

SMALLINTLastNumberDialedZone2

The number of calls made to numbers in
zone 1

For a call which an Outbound
Option Agent has scheduled a
callback, the CallResult resets to
0.

Note

SMALLINTCallsMadeToZone1

The number of calls made to numbers in
zone 2

For a call which an Outbound
Option Agent has scheduled a
callback, the CallResult resets to
0.

Note

SMALLINTCallsMadeToZone2

The date or time when the next call to this
zone will occur.

DATETIMECallbackDateTimeZone1

The number of calls made to numbers in
zone 2.

DATETIMECallbackDateTimeZone2

The date or time when the next call to this
phone number will occur.

DATETIMECallbackDateTime01
through
CallbackDateTime010

The time zone where this phone number is
located.

SMALLINTGMTPhone01 through
GMTPhone10

Is DST observed at this phone number
(boolean).

SMALLINTDSTPhone01 through
DSTPhone10

The call status (pending, retry, callback, and
so forth) for this zone.

CHAR(1)CallStatusZone1 and
CallStatusZone2

The account number of the customer.VARCHAR25AccountNumber

The last name of the customer.VARCHAR50LastName

The first name of the customer.VARCHAR50FirstName

The date or time when the record was
imported.

DATETIMEImportRuleDate
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A P P E N D I X F
Personal Callback List Table

• Personal_Callback_List Table, on page 145

Personal_Callback_List Table
The following table documents all the columns in the personal callback table.

Table 18: Personal Callback Table Columns

DescriptionTypeColumn Name

Unique identifier for each record in this table.AUTO-INTPersonalCallbackListID

Cross-references a record that has beenmoved from
the contact_list to this table.

INTDialingListID

Campaign ID (if the record was originally dialed as
part of a campaign).

INTCampaignID

Peripheral ID for the peripheral where the agent
would be available.

INTPeripheralID

Agent to which the call has to be connected.INTAgentID

Dialed number (DN) to use (if the original agent is
unavailable).

VARCHARCampaignDN

GMT of the customer number (if NULL, the local
GMT zone is assumed). If this value is provided, it
must always be a positive value from 0 to 23.
Convert all negative GMT values using the
following formula: 24 + (negative GMT value). For
example, the US eastern time zone is –5, so the
value stored in this column is 24 + (-5) = 19.

This column is not currently being used. It is
reserved for future use.

SMALLINTGMTZone

Phone number to call back.VARCHARPhone
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DescriptionTypeColumn Name

Customer account number.VARCHARAccountNumber

Maximum number of times a call is attempted
(decrements at each attempt). An “attempt” is
defined as the Outbound Option Dialer’s attempt to
reserve the agent andmake the customer call. Since
the Outbound Option Dialer places multiple
customer call attempts (busy, no answer), the actual
individual call attempts are not tracked here; only
the result at the end of the callback time range.

Once this column is set to 0, no more
attempts are made.

Note

INTMaxAttempts

Time to attempt customer callback is normalized to
the logger GMT zone; for example, if the Campaign
Manager is in Boston and the customer is in
California and wished to be contacted at 3:00 PM,
the time in this column would be 6:00 PM.

DATETIMECallbackDateTime

Current status of the callback record, such as 'P' for
pending or 'C' for closed.

New records must be set to 'P.'Note

CHARCallStatus

Telephony call result (busy, no answer, and so on)
or agent reservation attempt result (Agent Rejected
Call, Unable to reserve, and so on).

SMALLINTCallResult

Last name of the customer.VARCHARLastName

First name of the customer.VARCHARFirstName

The date and time that the personal callback record
was inserted into the database.

The Campaign Manager sets this value
when an agent schedules a personal
callback. Customers, partners, or
3rd-party applications that insert new
records into this table must populate the
InsertedIntoDBDateTime column with
the current date and time.

Note

DATETIMEInsertedIntoDBDateTime

The date and time that the personal callback record
was sent to the dialer and inserted into the dialer
cache for processing.

This date and time is set by the
Campaign Manager. Do not modify this
value.

Note

DATETIMESentToDialerDateTime
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A P P E N D I X G
CTIOS OO ECC Variable Settings

• ECC Variables for Outbound Call Centers Example, on page 147
• ECC Variables in Mixed Inbound and Outbound Call Centers Example, on page 148

ECC Variables for Outbound Call Centers Example

This sample registry file (.REG) must be run on the CTI OS server.Note

REGEDIT4 [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All

Desktops\Grid\CallAppearance]
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns] [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number] [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,

Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\1] "Type"="CallID"
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\2] "Type"="CallStatus"
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\3] "Type"="DNIS"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\4] "Type"="ANI"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\5] "Type"="CED"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\6] "Type"="DialedNumber"
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\7] "Type"="CallType"
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\8] "Type"="WrapUp" "maxchars"="39"
"editable"="true" [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
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Desktops\Grid\CallAppearance\Columns\Number\9] "Type"="ECC" "Name"="BAResponse"
"Header"="BAResponse" "Maxchars"="24" "ReadOnly"="false"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\10] "Type"="ECC" "Name"="BAStatus"
"Header"="BAStatus" "Maxchars"="3" "ReadOnly"="true" [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco

Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\11] "Type"="ECC" "Name"="BAAccountNumber"
"Header"="BAAccountNumber" "Maxchars"="33" "ReadOnly"="true"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\12] "Type"="ECC" "Name"="BATimeZone"
"Header"="BATimeZone" "Maxchars"="7" "ReadOnly"="true" [HKEY_LOCAL_MACHINE\SOFTWARE\Cisco

Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\13] "Type"="ECC" "Name"="BACampaign"
"Header"="BACampaign" "Maxchars"="33" "ReadOnly"="true"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\14] "Type"="ECC" "Name"="BADialedListID"
"Header"="BADialedListID" "Maxchars"="33" "ReadOnly"="false"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\15] "Type"="QueryRuleID"
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CTIOS\InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\16] "Type"="CampaignID" "Maxchars"="39"
"editable"="false"

ECC Variables in Mixed Inbound and Outbound Call Centers
Example

The preceding example registry settings (also found in CTIOS_bin\blendedagent_addecc.reg) overwrites
existing peripheral call variables for inbound traffic.

There is another file in the CTIOS_bin directory called callappearance.default.reg.txt that restores the variables
to their default setting.

In mixed inbound and outbound call centers, you can create a new registry file using examples from both
callappearance.default.reg.txt and blendedagent_addecc.reg to create a set of variables that meet your mixed
call center’s needs.

For example, in the following code, the third line ends in 9. The 9 indicates the column number. Therefore,
column 9 displays Var1, since the type in line 4 of the following example is set to Var1.
[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,

Inc.\CTIOS\CTIOS_InstanceName\ctios1\EnterpriseDesktopSettings\All
Desktops\Grid\CallAppearance\Columns\Number\9] "Type"="Var1" "maxchars"="39"
"editable"="true"

Select the columns and applicable display type required. Cut and paste from the two files into a new registry
file, editing as needed, and then import the new file into the registry.

The registry files are provided as examples. You can also manually edit the registry to achieve the same results.Note
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